Harmonized Health Facility Assessment (HHFA)

Data manager guide
Harmonized Health Facility Assessment (HHFA)

Data manager guide
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acknowledgements</td>
<td>vi</td>
</tr>
<tr>
<td>Abbreviations</td>
<td>vii</td>
</tr>
<tr>
<td>1. Overview</td>
<td>1</td>
</tr>
<tr>
<td>1.1 HHFA overview</td>
<td>1</td>
</tr>
<tr>
<td>1.2 Overview of data manager responsibilities</td>
<td>2</td>
</tr>
<tr>
<td>2. Introduction to Census and Survey Processing System (CSPro) for the HHFA</td>
<td>5</td>
</tr>
<tr>
<td>2.1 CSPro for the HHFA</td>
<td>6</td>
</tr>
<tr>
<td><strong>PART 1: PREPARATION OF CSPro APPLICATION AND TABLETS</strong></td>
<td>7</td>
</tr>
<tr>
<td>3. Installing CSPro</td>
<td>7</td>
</tr>
<tr>
<td>3.1 Hardware and software requirements</td>
<td>7</td>
</tr>
<tr>
<td>3.2 Software installation</td>
<td>7</td>
</tr>
<tr>
<td>4. The HHFA CSPro application</td>
<td>10</td>
</tr>
<tr>
<td>4.1 Download the HHFA CSPro application</td>
<td>10</td>
</tr>
<tr>
<td>4.2 Basics of a CSPro data entry application</td>
<td>10</td>
</tr>
<tr>
<td>4.3 HHFA CSPro folder structure</td>
<td>11</td>
</tr>
<tr>
<td>5. Set up synchronization method</td>
<td>14</td>
</tr>
<tr>
<td>5.1 Set up Dropbox synchronization</td>
<td>15</td>
</tr>
<tr>
<td>5.2 Set up CSWeb synchronization</td>
<td>16</td>
</tr>
<tr>
<td>5.3 Configure CSWeb server</td>
<td>17</td>
</tr>
<tr>
<td>6. Configuring the HHFA CSPro application</td>
<td>24</td>
</tr>
<tr>
<td>6.1 Create staff lookup file</td>
<td>24</td>
</tr>
<tr>
<td>6.2 Create facility lookup file</td>
<td>27</td>
</tr>
<tr>
<td>6.3 Configure the HHFA setup menu</td>
<td>34</td>
</tr>
<tr>
<td>7. Getting to know the HHFA CSPro application</td>
<td>43</td>
</tr>
<tr>
<td>7.1 Start CSPro and open HHFA application</td>
<td>43</td>
</tr>
<tr>
<td>7.2 Explore the HHFA application</td>
<td>44</td>
</tr>
<tr>
<td>8. Modifying the HHFA application</td>
<td>47</td>
</tr>
<tr>
<td>8.1 Add a new question</td>
<td>48</td>
</tr>
<tr>
<td>8.2 Edit an existing question</td>
<td>67</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>8.3</td>
<td>Add language and translations</td>
</tr>
<tr>
<td>8.4</td>
<td>Delete a question</td>
</tr>
<tr>
<td>8.5</td>
<td>Reorder questions</td>
</tr>
<tr>
<td>8.6</td>
<td>Add a new record</td>
</tr>
<tr>
<td>9.</td>
<td>Preparing and deploying the HHFA application</td>
</tr>
<tr>
<td>9.1</td>
<td>Prepare to deploy the HHFA application</td>
</tr>
<tr>
<td>9.2</td>
<td>Deploy the HHFA application</td>
</tr>
<tr>
<td>10.</td>
<td>Configuring tablets</td>
</tr>
<tr>
<td>10.1</td>
<td>Configure tablets</td>
</tr>
<tr>
<td>10.2</td>
<td>Install the HHFA CSPro application</td>
</tr>
<tr>
<td>10.3</td>
<td>Configure handheld GPS devices (if in use)</td>
</tr>
<tr>
<td>11.</td>
<td>Preparing for training</td>
</tr>
<tr>
<td>11.1</td>
<td>Training of Trainers course on CSPro</td>
</tr>
<tr>
<td>11.2</td>
<td>Review and adapt training materials</td>
</tr>
<tr>
<td>11.3</td>
<td>Manage distribution of tablets</td>
</tr>
<tr>
<td>11.4</td>
<td>Deploy HHFA application for training and pilot test</td>
</tr>
<tr>
<td>12.</td>
<td>Facilitating training of data collectors, team leaders and supervisors</td>
</tr>
<tr>
<td>12.1</td>
<td>CSEntry basics</td>
</tr>
<tr>
<td>12.2</td>
<td>HHFA CSPro application user roles</td>
</tr>
<tr>
<td>12.3</td>
<td>HHFA CSPro data collection process</td>
</tr>
<tr>
<td>12.4</td>
<td>HHFA CSPro for supervisors</td>
</tr>
<tr>
<td>13.</td>
<td>Preparing for data collection</td>
</tr>
<tr>
<td>13.1</td>
<td>Clear data after training/pilot</td>
</tr>
<tr>
<td>13.2</td>
<td>Make final updates to the HHFA CSPro application</td>
</tr>
<tr>
<td>13.3</td>
<td>Deploy HHFA CSPro application for data collection</td>
</tr>
<tr>
<td>14.</td>
<td>Reviewing data during data collection</td>
</tr>
<tr>
<td>14.1</td>
<td>Review data during data collection</td>
</tr>
<tr>
<td>14.2</td>
<td>Track progress towards survey completion</td>
</tr>
<tr>
<td>15. Reviewing and editing data</td>
<td>128</td>
</tr>
<tr>
<td>--------------------------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>15.1 Track progress towards survey completion</td>
<td>128</td>
</tr>
<tr>
<td>15.2 Review data for completeness</td>
<td>132</td>
</tr>
<tr>
<td>15.3 Validate combined data set from individual questionnaire data</td>
<td>136</td>
</tr>
<tr>
<td>15.4 Identify and resolve duplicates</td>
<td>137</td>
</tr>
<tr>
<td>15.5 Compare supervisor validations</td>
<td>140</td>
</tr>
<tr>
<td>15.6 Review key variables</td>
<td>144</td>
</tr>
<tr>
<td>15.7 Calculate sample weights</td>
<td>147</td>
</tr>
<tr>
<td>15.8 Edit data and create final data set</td>
<td>148</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>16. Exporting data for analysis</th>
<th>150</th>
</tr>
</thead>
<tbody>
<tr>
<td>16.1 Export data for the HHFA data analysis platform</td>
<td>150</td>
</tr>
<tr>
<td>16.2 Export HHFA data to open with Excel</td>
<td>152</td>
</tr>
<tr>
<td>16.3 Export HHFA data to other file formats</td>
<td>155</td>
</tr>
<tr>
<td>16.4 Alternative approach to exporting data</td>
<td>155</td>
</tr>
</tbody>
</table>

Annex: CSWeb synchronization: server and domain name configuration example 157
Acknowledgements

The HHFA Data manager guide was developed by Ashley Sheffel (Johns Hopkins Bloomberg School of Public Health) and Boniface Muganda (independent consultant). Technical contributions were provided by Benito Koubemba and Davy Liboko Gnekabassa (WHO Regional Office for Africa), Wendy Venter (WHO Division of Data, Analytics and Delivery for Impact) and the following independent consultants: Fern Greenwell, Geoff Greenwell, Geoffrey Lutwama, Dumitru Slonovschi and Yolanda Barbera.

The document was produced with the support of grants from Bloomberg Philanthropies Data for Health Initiative; Gavi, the Vaccine Alliance; The Global Fund to Fight AIDS, Tuberculosis and Malaria; the Susan T. Buffett Foundation; the Kingdom of Saudi Arabia; the Norwegian Agency for Development Cooperation; and the Canada Department of Foreign Affairs, Trade and Development.
## Abbreviations

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>API</td>
<td>application programming interface</td>
</tr>
<tr>
<td>ARV</td>
<td>antiretroviral</td>
</tr>
<tr>
<td>CAPI</td>
<td>computer-assisted personal interviewing</td>
</tr>
<tr>
<td>CSPro</td>
<td>Census and Survey Processing System</td>
</tr>
<tr>
<td>DBMS</td>
<td>database management system</td>
</tr>
<tr>
<td>GPS</td>
<td>Global Positioning System</td>
</tr>
<tr>
<td>HHFA</td>
<td>Harmonized Health Facility Assessment</td>
</tr>
<tr>
<td>ISO</td>
<td>International Organization for Standardization</td>
</tr>
<tr>
<td>MFL</td>
<td>Master Facility List</td>
</tr>
<tr>
<td>QA</td>
<td>quality assurance</td>
</tr>
<tr>
<td>SDI</td>
<td>Service Delivery Indicators</td>
</tr>
<tr>
<td>SPA</td>
<td>Service Provision Assessment</td>
</tr>
<tr>
<td>UN</td>
<td>United Nations</td>
</tr>
<tr>
<td>WHO</td>
<td>World Health Organization</td>
</tr>
</tbody>
</table>
1. Overview

1.1 HHFA overview

The Harmonized Health Facility Assessment (HHFA) is a comprehensive, standardized health facility survey that provides objective information on the availability of health facility services and the systems that facilities have in place to deliver the services at required standards of quality.

Availability and quality of health services are integral to achieving universal health coverage and contribute to attaining the health-related Sustainable Development Goals. HHFA data support health sector reviews and evidence-based decision-making for strengthening country health services. Developed through multistakeholder collaboration, the HHFA is based on global service standards and draws upon existing global facility survey instruments. The HHFA uses standardized indicators, questionnaires, data collection methodologies and data analysis tools. Standardization promotes alignment of facility survey approaches, enables comparability of results over time and across geographic areas, and can support capacity building through consistent application of global standards.

HHFA modules

The HHFA includes four modules: service availability; service readiness; quality of care; and management and finance.

A module represents a set of questions (in questionnaire format) related to a defined set of indicators in a specific disease, programme or service management area. The modular approach, with core and additional questions, enables countries to adapt the survey to their needs. HHFA questionnaires are provided in two formats: “stand-alone” and “combined”. Each HHFA module includes a set of stand-alone questionnaires that may be designated Core, Core+Additional and/or Supplementary. The Combined questionnaire contains questions from multiple modules, integrated and organized by service site or respondent to facilitate data collection at facility level.

Fig. 1. HHFA modules and questionnaires

<table>
<thead>
<tr>
<th>Service availability</th>
<th>Service readiness</th>
<th>Quality of care</th>
<th>Management and finance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Facility infrastructure</td>
<td>Guidelines</td>
<td>Adherence to standards in patient care processes</td>
<td>Management systems</td>
</tr>
<tr>
<td>Staff</td>
<td>Trained staff</td>
<td></td>
<td>Finance systems</td>
</tr>
<tr>
<td>Beds</td>
<td>Equipment</td>
<td></td>
<td>Health information systems</td>
</tr>
<tr>
<td>Specific services</td>
<td>Diagnostics</td>
<td></td>
<td>Quality assurance systems</td>
</tr>
<tr>
<td>Building structure</td>
<td>Medicines and commodities</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Stand-alone questionnaires</th>
<th>Stand-alone questionnaires</th>
<th>Stand-alone questionnaires</th>
<th>Stand-alone questionnaires</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability: Core</td>
<td>Readiness: Core</td>
<td>Quality of care: Additional/ Supplementary Record review</td>
<td>Management and finance: Core</td>
</tr>
<tr>
<td>Availability: Core+Additional</td>
<td></td>
<td></td>
<td>Management and finance: Core+Additional</td>
</tr>
<tr>
<td>Availability: Additional/ Supplementary Building structure</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
HHFA resource package

The HHFA resource package is a comprehensive set of downloadable tools to support countries in adapting, planning and implementing an HHFA. The package includes:

- **HHFA Quick guide**: This describes the HHFA background and introduces the HHFA concepts, tools and methodologies and survey planning and implementation processes.

- **HHFA Comprehensive guide**: This guide provides an expanded description of the HHFA background concepts and tools, as well as detailed step-by-step guidance for survey planning, preparation, implementation, data analysis, interpretation and dissemination of results.

- **Indicator inventory**: An online platform displays all the HHFA indicators, including the survey questions and codes needed to calculate each indicator. Core indicators represent the minimum recommended indicator set. Additional indicators can be included based on country priorities. An indicator tabulation plan can be generated from the indicator platform.

- **Questionnaires**: Questionnaires are available in “combined” and “stand-alone” formats. The “combined” questionnaire includes questions from multiple HHFA modules, integrated to facilitate data collection. “Stand-alone” questionnaires are also available for each module. The questionnaires are further termed Core, Core+Additional or Supplementary, based on the types of questions they contain.

- **Census and Survey Processing System (CSPro) electronic data collection tool**: This tool is a CSPro application containing all the HHFA questionnaires and can be used on handheld devices such as tablets. The tool allows countries to select the questionnaires they want to implement and adapt to their context.

- **HHFA Data manager guide**: The guide defines the data manager’s responsibilities in an HHFA and explains how to adapt and use the CSPro tool.

- **Data analysis platform**: HHFA data are uploaded to the analysis platform, which then calculates the HHFA indicators and produces tables and charts in a standard report format. The data analysis platform can also be configured according to country needs.

- **Training resources**: Various training resources support the training of HHFA data collectors, supervisors and data managers, as well as the training of teams conducting data analysis, report writing and results dissemination.

### 1.2 Overview of data manager responsibilities

Data managers play a critical role in preparing and conducting an HHFA. The responsibilities of the data manager are summarized in **Table 1** along with the relevant reference chapter in this manual. The aim of the **HHFA Data manager guide** is to provide step-by-step technical guidance for completing the data manager’s responsibilities.

**Table 1. Data manager responsibilities in the HHFA**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preparation of CSPro application and tablets</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Install CSPro and download the HHFA CSPro application</td>
<td>Before training of data collectors</td>
<td>3 &amp; 4</td>
</tr>
<tr>
<td>2</td>
<td>Set up synchronization method – Dropbox or CSWeb</td>
<td>Before training of data collectors</td>
<td>5</td>
</tr>
<tr>
<td>-----</td>
<td>------------------------------------------------</td>
<td>------------------------------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>3</td>
<td>Configure the HHFA CSPro application</td>
<td>Before training of data collectors (after questionnaire adaptation)</td>
<td>6</td>
</tr>
<tr>
<td>4</td>
<td>Modify HHFA CSPro application (if required)</td>
<td>Before training of data collectors (after questionnaire adaptation)</td>
<td>8</td>
</tr>
<tr>
<td>5</td>
<td>Deploy the HHFA CSPro application</td>
<td>Before training of data collectors</td>
<td>9</td>
</tr>
<tr>
<td>6</td>
<td>Configure tablets and install the HHFA CSPro application</td>
<td>Before training of data collectors</td>
<td>10</td>
</tr>
<tr>
<td>7</td>
<td>Configure handheld GPS devices (if in use)</td>
<td>Before training of data collectors</td>
<td>10</td>
</tr>
</tbody>
</table>

**Training**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Adapt training materials for data collectors and supervisors</td>
<td>Before training of data collectors</td>
<td>11</td>
</tr>
<tr>
<td>9</td>
<td>Manage distribution of tablets</td>
<td>During training of data collectors and field work</td>
<td>11</td>
</tr>
<tr>
<td>10</td>
<td>Facilitate training of data collectors on GPS, tablets and CSPro</td>
<td>During training of data collectors</td>
<td>12</td>
</tr>
<tr>
<td>11</td>
<td>Facilitate training of supervisors on CSPro for data validation</td>
<td>During training of supervisors</td>
<td>12</td>
</tr>
<tr>
<td>12</td>
<td>Clear data from tablets and server after training/pilot</td>
<td>After training of data collectors</td>
<td>13</td>
</tr>
<tr>
<td>13</td>
<td>Make final updates to the HHFA CSPro application</td>
<td>After training of data collectors</td>
<td>13</td>
</tr>
</tbody>
</table>

**Data collection**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>14</td>
<td>Review data during data collection</td>
<td>During field work</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>Track progress towards survey completion</td>
<td>During and after field work</td>
<td>14</td>
</tr>
</tbody>
</table>

**Data processing**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>16</td>
<td>Review data for completeness</td>
<td>During data processing (after field work is completed)</td>
<td>15</td>
</tr>
<tr>
<td>17</td>
<td>Identify and resolve duplicates</td>
<td>During data processing (after field work is completed)</td>
<td>15</td>
</tr>
<tr>
<td>18</td>
<td>Compare supervisor validations</td>
<td>During data processing (after field work is completed)</td>
<td>15</td>
</tr>
<tr>
<td>19</td>
<td>Review key variables</td>
<td>During data processing (after field work is completed)</td>
<td>15</td>
</tr>
<tr>
<td>20</td>
<td>Calculate sample weights</td>
<td>During data processing (after field work is completed)</td>
<td>15</td>
</tr>
<tr>
<td>21</td>
<td>Edit data and create final data set</td>
<td>During data processing (after field work is completed)</td>
<td>15</td>
</tr>
<tr>
<td>22</td>
<td>Export data for analysis and archiving</td>
<td>During data processing (after field work is completed)</td>
<td>16</td>
</tr>
</tbody>
</table>
While the *HHFA Data manger guide* provides substantial detailed information, it is expected that the data manager will have the appropriate qualifications in order to fully grasp the complexity of data management and to successfully operationalize the instructions provided in the *HHFA Data manager guide*. The ideal data manager will have proven experience as a data manager with a strong understanding of data administration and management functions including data collection, data processing and data analysis. Successful data managers often possess the following key skills:

- knowledge of CSPro software (intermediate level knowledge preferred);
- demonstrated data management experience conducting and supporting surveys using CSPro for electronic data collection in similar contexts;
- demonstrated training and facilitation experience;
- excellent communication and interpersonal skills;
- strong teamwork predisposition and the capacity to work collaboratively with partners;
- ability to interpret, analyse and resolve problems; and
- tech-savvy with excellent troubleshooting skills.
2. Introduction to CSPro for the HHFA

Electronic data collection facilitates the collection of more accurate and reliable data in a more efficient, timely manner than when using paper questionnaires. Handheld data collection devices offer solutions for data collection errors and disorganization. These electronic tools are available in various forms, the most commonly used devices being handheld computers (i.e. tablets) or smartphones. Global Positioning System (GPS) devices are handheld electronic devices often used in conjunction with handheld computers to determine precise locations using geographic coordinates.

Electronic data collection devices have gradually increased in popularity for field surveys due to decreasing costs and increasing computation and functional capacity. Not only does electronic data collection offer an efficient and accurate means of data collection and dissemination, but workers are often eager to use modern technology for practical purposes. Furthermore, the time needed to train staff in the use of electronic data collection devices can be as little as a day.

The advantages of electronic data collection are clear. In order to facilitate the collection of accurate and reliable data, a number of data validation procedures can be programmed into an electronic data collection device, including: skip patterns, range controls, standardized responses and mandatory question responses. Automatic progression of the questionnaire and standardized responses make it easy for data collectors to administer the survey. Also, time is not wasted in scrutinizing the progression of the questionnaire or writing lengthy responses.

As the size and scope of a survey increases, so do the benefits of electronic data collection. Large volumes of data are subject to the risk of more data collection errors, and the time saved in data collection, data entry, data cleaning and data dissemination is substantial. With electronic data collection, information can be in the hands of decision-makers the same day as the data are collected.

For the HHFA, electronic data collection is carried out through the use of the CSPro software. CSPro is a software package for entry, editing, tabulation and dissemination of census and survey data. CSPro allows the user to create, modify and run data entry, batch editing, and tabulation applications from a single, integrated development environment. The data are stored in files described by data dictionaries. CSPro was developed by the United States Census Bureau, Macro International and Serpro, SA, with major funding from the United States Agency for International Development.

CSPro is not intended to provide database management capabilities; however, the data generated and/or manipulated by a CSPro application may be imported into a database system. While CSPro provides some tabulation capabilities, it is not intended to replace more sophisticated statistical analysis software such as SAS, SPSS, Stata, R, etc. In addition, even though CSPro includes a module for generating thematic maps, it cannot be considered a geographical information system, as the maps cannot show the multiple layers available in a true geographical information system.

CSPro is in the public domain. It is available at no cost and may be freely distributed. It is available for download at [https://www.census.gov/data/software/cspro.Download.html](https://www.census.gov/data/software/cspro.Download.html). More detailed information about the capabilities of CSPro is available from the United States Census Bureau website.
2.1 CSPro for the HHFA

As CSPro has been chosen for the implementation of the HHFA, a standard HHFA CSPro application has been developed. This document provides instructions on how to adapt the standard HHFA CSPro application at country level, as well as how to implement the CSPro application for data entry and data processing.

There are a multitude of resources available to support CSPro users including the following useful links:

- CSPro User Guide:
  - [https://www.census.gov/data/software/cspro/documentation.html](https://www.census.gov/data/software/cspro/documentation.html)
  - [https://www.csprousers.org/help/CSPro/](https://www.csprousers.org/help/CSPro/)
- mailing list for CSPro questions: cspro@lists.census.gov
- CSPro Users website: [http://www.csprousers.org](http://www.csprousers.org)
- CSPro on Twitter: [http://twitter.com/cspro](http://twitter.com/cspro)

The *HHFA Data manager guide* does not intend to be a comprehensive guide for how to use CSPro. Instead, it draws on the comprehensive resources listed above to provide specific instructions for making adaptations to the CSPro application that has been developed for the HHFA. Please utilize the above resources for additional information about CSPro and troubleshooting CSPro, as needed.
PART 1: PREPARATION OF CSPro
APPLICATION AND TABLETS

3. Installing CSPro

3.1 Hardware and software requirements

The following requirements are necessary in order to use CSPro for data collection.

Computer hardware and software specifications

CSPro 7.7 runs under Windows Vista, 7, 8, 10 and 11. It does not run under Windows 8 RT. The Android data entry module requires Android version 4.0 or higher.

Recommended configuration for questionnaire development

- desktop or laptop computer
- Pentium processor
- 512 MB of RAM
- Super Video Graphics Array (SVGA) monitor
- mouse or touchscreen
- 100 MB of free hard drive space
- Microsoft Windows Vista, 7, 8, 10 or 11. (Note: CSPro does not run on Windows 8 RT.)

Configuration for data collectors’ application

- Android tablet with operating system 4.0 (Ice Cream Sandwich) or higher.

3.2 Software installation

Install CSPro on a computer/laptop

The following is based on a Windows 10 setup. Your steps may vary if using a different operating system.

1. Download the CSPro application from: https://www.census.gov/data/software/cspro.Download.html
2. Install CSPro 7.7 to your computer by double clicking on cspro77.exe (the last digit of the version number might change as new releases are published). This will start the installation wizard.
3. Read and accept the United States Census Bureau's license agreement.
4. CSPro allows you to select which components of the system you want to install. During the installation you will see the following component screen:
You have the following choices:

- CSPro Suite
- examples.

**For the HHFA, all components of the CSPro suite must be installed**, even on tablets to use in the field, as there are tools in the full application that are required for the program to run properly. For the remaining default settings for the installation, click “next” until finished.

**Updating to CSPro 7.7 from CSPro 7.6 or earlier**

If you have an older version of CSPro installed on your computer, you can install CSPro 7.7 without affecting the previous version, and both versions can be run in parallel. Please note, however, that version 7.7 is now the default program to open existing applications, and these are automatically converted to 7.7 format. Due to internal changes within CSPro 7.7, once files have been loaded in CSPro 7.7, you may no longer be able to load them in previous versions of CSPro. You also have the option to remove older versions of CSPro from your computer if you are no longer using them as this will simplify opening CSPro applications.

**Install CSEntry for Android devices**

The app is called “CSEntry CSPro Data Entry” and can be found and installed from Google Play store (search for “CSPro”).

**Install CSPro on a tablet PC (Windows 8)**

- Reactions to the user interface of Windows 8 have mostly been negative, and, in combination with CSPro, it is a rather messy experience. Each CSPro component becomes one tile in the home screen, resulting in 15 to 20 new tiles on the start screen. If other programs are also installed, the user soon loses track amongst all the tiles. Hence, we recommend installing a tool called Classic Shell to get back the start menu and the general feel of Windows 7 or 10. Once the Classic Shell is installed, the installation of CSPro 7.7 is the same as for installing on a Windows 10 computer as explained above.

- The Classic Shell can be downloaded from: [http://www.classicshell.net/downloads/](http://www.classicshell.net/downloads/)

- Double click on the installation file and follow the instructions to install.
Uninstall CSPro

There are two ways to uninstall CSPro. The uninstaller will remove all registry entries and CSPro system files. It will not remove any applications or other files that you have created.

You can uninstall the program using the Windows Control Panel:

1. Using the Windows search functionality (Windows Key+S), type Add or remove programs.
2. Select CSPro from the list of programs.
3. Follow the prompts to uninstall the program.

Alternatively, you can:

1. Use Windows Explorer to browse to the CSPro application folder, which will likely be: C:\ProgramFiles (x86)\CSPro 7.7.
2. Run the program uninstall.exe.
3. Follow the prompts to uninstall the program.
4. The HHFA CSPro application

4.1 Download the HHFA CSPro application

The HHFA questionnaires have been programmed into CSPro and the HHFA CSPro application is available for download at https://github.com/HHFA2023/HHFA_Public/releases. The HHFA application can be adapted for each country context and survey implementation. This chapter describes the basics of a CSPro data entry application and the file hierarchy of the HHFA CSPro application, as well as explaining the uses of the different files.

4.2 Basics of a CSPro data entry application

A CSPro data entry application contains a set of forms (screens) and logic that a data entry operator uses to key data to a disk file. Data entry applications can be used to add new data and to modify existing data. The CSPro data entry application consists of a number of files (see Fig. 2).

Fig. 2. CSPro data entry application files

![CSPro data entry application file organization](image)

Data entry application file organization

- **Data Entry Application File (.ent)**: The data entry application file is the master file for the data entry application. This file specifies all other files contained in the application, along with other information.

- **Forms File (.fmf)**: The forms file contains information about forms, their fields, text and rosters. The forms file also contains the name of the associated data dictionary file. The flow during data entry, i.e. the order in which forms and fields are entered, is defined in the forms file, not in the data dictionary. There is usually one forms file per application, but there may be multiple forms files. Each forms file contains one data dictionary file (.dcf) which represents the primary data file that is being created or modified.

- **Logic File (.apc)**: The logic file contains all the CSPro language statements which control the application. There is one logic file associated with each application.

- **Message File (.mgf)**: The message file is a text file where you can store message text and an associated message number. The message is displayed when an "errmsg" function with the message number is executed in a data entry application. A message may contain parameters. This is an optional file.
Question File (.qsf): The question file contains information related to computer-assisted personal interviewing (CAPI) data entry applications. Such information includes question text to appear on the screen with each field and when the operator presses the help key.

Data Dictionary File (.dcf): Each file manipulated by CSPro must be described by a data dictionary. The data dictionary file contains information defining the layout of the data file, including levels, records, items, value sets and values.

Other Data Dictionary Files (.dcf): Optional; it represents secondary data files (such as lookup files) that are read and/or written to during data entry.

Program Information File (.pff): The program information file is used to run applications or tools in production mode.

4.3 HHFA CSPro folder structure

The HHFA folder has the following folder structure:

- data
- deploy
- dicts
- entry
- prep
- process
- ref
- resources
- HHFA_Menu.ent
- HHFA_Menu.ent.apc
- HHFA_Menu.ent.mgf
- HHFA_Menu.ent.qsf
- HHFA_Menu.fmf
- HHFA_Menu.pen
- HHFA_Menu.pff

When moving around in the hierarchy, many files will be seen. This is because CSPro generates many different kinds of files. Data collectors do not need to know about the files or hierarchy, because a shortcut to launch the data entry application is provided for them. However, an administrator of the application needs to be familiar with several very important folders in order to customize the application and deploy it for data collection.
None of the folder, subfolder, nor application names can be renamed. Doing so would “break” numerous pieces of logic within the menu system and elsewhere, rendering the system inoperable. Also, do not change the location in which various files are stored.

The following section presents an overview of the uses of each file in the HHFA folder. When exploring the HHFA CSPro folder, it is highly recommended to configure Windows Explorer to show extensions for known file types, as a folder with CSPro files becomes confusing when the extensions are not shown. To do this: open the control panel, and in the upper right corner, choose “View by small icons”. Then click on “Folder options”. Choose the tab “View”, and un-tick “Hide extensions for known file types”. Then click OK.

data: Folder where data collected using the HHFA application are stored. These files are generated through the data collection process. All other “data” files related to application functionality are in the ref (reference) folder. All CSPro data files have the file extension .csdb.

- **HFA_Assignments(.csdb)**: This data file stores the section assignments for the facilities.
- **HFA_Data(.csdb)**: This data file stores the individual data records from the facility audit questionnaire.
- **HFA_COMB(.csdb)**: This data file stores the combined data records from the facility audit questionnaire.
- **HFA_COMB_DM(.csdb)**: This data file stores the combined data records from the facility audit questionnaire generated by the data manager interface.
- **Export_Data**: This folder stores data exported through the data manager interface.

deploy: Contains an example deployment script to send the full application to CSWeb or Dropbox.

dicts: Contains all the dictionaries that are used in the HHFA application. The following dictionaries are included in the dicts folder:

- **cHFA_setup**: Used for the HFA_setup application.
- **HFA_Assignments**: Used for the application that is run when assigning questionnaire sections.
- **HFA_COMB**: Used to generate the HFA_COMB data file during data concatenation.
- **HFA_DICT**: Used for the main data entry application for the facility audit questionnaire.
- **HFA_Facilities**: Used for the HFA_Facilities lookup file.
- **HFA_Staff**: Used for the HFA_Staff lookup file.
- **HHFA_Menu**: Used for the menu application.
- **QMapDict**: Used for the QMap lookup file.

entry: Contains the main HHFA data entry application. This will be used to make the most of the country-specific edits to the content of the HHFA questionnaire.

prep: Contains external applications that are used for preparation of the main application.

- **HFA_setup**: This is run by the data manager to set up/configure HHFA parameters.
- **HFA_Assignment**: The program that is run during section assignments (facility sections assignment will be discussed later).
process: Contains batch editing files that are used during the data processing phase.

ref: Contains reference files and lookup files that are used within the applications. The following files are contained within this folder:

- **csv_files folder**: This contains reports in .csv format that can be generated from the Data Manager menu.
- **reports folder**: This contains custom html reports that are displayed when the user generates reports within the application.
- **HFA_Facilities(.csdb)**: This a lookup file that contains the sample list of all the health facilities to be interviewed. This file will be generated during the configuration process.
- **HFA_setup(.csdb)**: This a lookup file that stores all the survey parameters set by the data manager. This file is **very critical** within the HHFA application. Without it, the HHFA application cannot run. This file will be generated during the configuration process.
- **HFA_Staff(.csdb)**: This is a lookup file that contains login information for each of the survey staff (data collectors, team leaders, supervisors). This file will be generated during the configuration process.
- **QMap(.csdb)**: This is a lookup file that contains mappings of the standard HHFA questions. Each question is mapped to a specific module.
- **QuestionMapping(.xlsx)**: This is the Excel file that is used to generate the question mappings.
- **Sample_Facilities_File(.xlsx)**: This is the reference Excel file that is used to generate the list of facilities to be uploaded into the HFA_Facilities(.csdb) file.
- **Sample_Staff_File(.xlsx)**: This is the reference Excel file that is used to generate login information for the survey staff to be uploaded into the HFA_Staff(.csdb) file.

resources: Contains additional resources useful for implementing the HHFA.

- **Data analysis platform folder**: This contains a demonstration dataset that can be used with the HHFA analysis platform.
- **Data manager guide folder**: This contains the HHFA data manager guide that corresponds to the CSPro application.
- **Images folder**: This is where country-specific logos can be saved.
- **Questionnaires folder**: This contains the HHFA paper questionnaires that corresponds to the CSPro application.
- **Training material folder**: This contains HHFA training materials.

**HHFA_Menu**: This is the main HHFA application and serves as an entry point to the HHFA data entry application. It contains the central menu system which defines the functionalities for different users of the application (data manager, supervisor, team leader, data collector). Launching of this application allows a user to access all the main functionalities such as setup, sending assignments, collecting data, syncing data, etc. Some time may be needed to open this application because of the number of linked dictionary files. Generally, it is only necessary to open this application on the computer as part of the data manager setup. Otherwise, all access will be through the tablet.
5. Set up synchronization method

There are two options for syncing data using the HHFA CSPro application: CSWeb or Dropbox. The HHFA CSPro application has been developed to allow for synchronization of data using either method. There are pros and cons to both approaches. The following section provides a brief overview of the differences between and resource requirements for data synchronization using CSWeb and Dropbox. Each survey implementation should select the most appropriate option and then proceed with the configuration steps for their selected synchronization method. Table 2 contains a comprehensive comparison between CSWeb and Dropbox.

**CSWeb:** CSWeb is a web server running the CSPPro synchronization server software. It is best for large surveys and censuses. The server software is written in PHP and can be run on any web server that has PHP and the MySQL database software installed. In a country, the server can be on premises or be a virtual server in the cloud.

**Dropbox:** Dropbox is a free cloud-based synchronization service. It is ideal for small and medium sized surveys. Dropbox requires no server setup or maintenance and avoids the cost and difficulty of setting up a CSWeb server.

<table>
<thead>
<tr>
<th></th>
<th>CSWeb</th>
<th>Dropbox</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey size</td>
<td>Best for large surveys</td>
<td>Best for small and medium surveys</td>
</tr>
<tr>
<td>Technical resources</td>
<td>Configuration requires some IT system administration skills (knowledge and experience with server administration and website technologies)</td>
<td>Configuration can be done by survey data manager (no advanced IT skills required)</td>
</tr>
<tr>
<td>Physical resources</td>
<td>Web server that has PHP and the MySQL database software installed; Server can be set up on a computer connected to the internet or may be set up on a hosted website or virtual cloud-based server</td>
<td>Free cloud-based synchronization service; Requires a dedicated e-mail account (e.g. Gmail)</td>
</tr>
<tr>
<td>Cost</td>
<td>Server cost is base monthly fee plus usage; however, this is generally very low for an HHFA survey (e.g. US$ 5 for monthly fee); Domain name (optional) has a one-time fee; prices vary (e.g. US$ 10)</td>
<td>Free of charge</td>
</tr>
<tr>
<td>Data security</td>
<td>Does not require input of username and password directly on data collection devices; Data resides on your own server (either physical or virtual); Allows definition of user roles and permissions</td>
<td>Requires input of username and password directly on data collection devices; Files reside on Dropbox server</td>
</tr>
<tr>
<td>Data downloading/monitoring</td>
<td>Easier monitoring of data during data collection; More direct data download</td>
<td>Must use intermediary CSPPro tools to monitor and download data</td>
</tr>
</tbody>
</table>

If you are unsure about which option to select for data synchronization, it is recommended to make the decision based on your organization’s technical resources. If your organization has experience with web server maintenance and cyber security, CSWeb is recommended. It is optimized to handle small to very large surveys and censuses. However, if your organization lacks the experience to work with CSWeb, Dropbox is recommended as it is appropriate for small to medium sized surveys, requires no server setup or maintenance and avoids the cost and difficulty of setting up a CSWeb server.
The next section provides instructions for setting up both Dropbox and CSWeb synchronization. Follow the instructions for the ONE approach you have selected.

5.1 Set up Dropbox synchronization

The first step in the Dropbox synchronization process is to create a dedicated Dropbox account for the survey. An e-mail address is required for this process and creation of a dedicated e-mail address for the survey is recommended to facilitate creation of the dedicated survey Dropbox account. Take the following steps to set up the relevant accounts:

1. Set up a free e-mail account through Gmail.
   a. Go to www.gmail.com and click on Create an account.
   b. Enter First Name, Last Name, Username, Password, Birthday and Gender. The following can be used:
      i. First name: Country
      ii. Last name: HHFA
      iii. Username: CountryHHFAYear
      iv. Password: HHFAYearCountry (or other password of choice))
      v. Birthday: 1 Jan 1990
      vi. Gender: select any.
   c. This will create the survey Gmail address. Continue to Gmail to open the e-mail account.

2. Set up a free Dropbox account.
   a. Go to www.dropbox.com and click on Create a new account.
   b. Enter first name, last name, the e-mail address created in Gmail (CountryHHFAYear@gmail.com) and a password (HHFAYearCountry or other password of choice). Then click on Agree to the terms and create an account.
   c. This may prompt you to download Dropbox installer. This is not required for the HHFA sync. Navigate to the Dropbox homepage and you will be able to see which files are in the Dropbox.

3. Click on Files ➔ New folder and name the folder “CSPro”. Then click on Share next to this new folder name.

4. A message will pop up asking you to verify the new Dropbox account through e-mail. Click on Send e-mail.

5. Return to your survey Gmail account. Check your inbox and click on the link in the e-mail received from Dropbox to verify your e-mail address. If you cannot find it, check your spam folder or ask Dropbox to resend the e-mail.

6. Dropbox should now display a message that your e-mail address has been verified and you can now share folders. Once again, click on Share next to the new folder (CSPro) that you created in Dropbox.

7. Select “Invite people to collaborate”, enter the e-mail address of the survey data manager and click Share folder.

8. The data manager should now be able to log in to their own personal e-mail and accept the folder invitation. Please limit the number of people invited to this folder as anyone who has access to this folder will be able to view, edit and delete the data entry application and the data during and after the data collection process.

9. Your Dropbox account is now ready to synchronize with the HHFA CSSPro application.
5.2 Set up CSWeb synchronization

There are many options for setting up CSWeb including:

- **Cloud server:** Amazon Lightsail, Digital Ocean, Linode, Google Cloud Platform, etc.
- **Physical server:** Server located on premises. Use of a physical server requires configuration of a virtual machine that is continuously internet accessible.

The CSPro documentation provides general guidance on how to configure CSWeb for various technology configurations.¹ There are three main steps to setting up CSWeb:

1. Set up server.
2. Configure domain name.
3. Configure CSWeb server.

The first step in setting up CSWeb is to set up a server. In order to connect to the server from devices outside your local network, such as tablets in the field, you will need to register a domain name for your server. While the process for setting up the server and configuring the domain name will be specific to the server platform, the process for the next steps – configuration of the virtual host and CSWeb server – will remain the same irrespective of the server platform. As such, the next instructions will start with step 3, which assumes the server has been set up and the domain name has been configured. The Annex includes an example set of instructions for steps 1–2 using one cloud server platform for reference.

The steps involved in setting up CSWeb on the server can be run through a manual process by executing commands on the remote server. The minimum requirements to run CSWeb on an Apache or IIS server include:

- **Apache 2.0** or above or **IIS 7.0** or above
- **MySQL 5.5.3** or greater
- **PHP 7.3** or 7.4
- **Settings in php.ini**
  - `enable_post_data_reading` on
  - `post_max_size=8M`
  - **Extensions in php.ini**
    - `extension=php_curl.dll`
    - `or allow_url_fopen=On`
    - `extension=php_fileinfo.dll`
    - `extension=php_openssl.dll`
    - `extension=php_pdo_mysql.dll`
    - `extension=php_pdo.dll`
    - `extension=php_zip.dll` (necessary with some installations of PHP)

---

¹ CSWeb help documentation: [https://www.csprousers.org/help/CSWeb/introduction_to_csweb.html](https://www.csprousers.org/help/CSWeb/introduction_to_csweb.html)
Harmonized Health Facility Assessment | 5. Set up synchronization method

- **Guzzle** (PHP HTTP client) one of the following must be true:
  - PHP 7.3 or 7.4
  - or `extension=php_curl.dll`
  - or The CA bundle is installed

- **Files directory**
  - Must exist and be writeable.

The following sections will provide instructions for setting up the minimum required configuration for both Apache and IIS servers.

### 5.3 Configure CSWeb server

This section will provide instructions on setting up a CSWeb server on a Linux operating system, specifically Ubuntu distribution.

#### Prerequisites

In order to execute the setup, you will need:

- A local machine/PC running Ubuntu 18.04/20.04
- A remote server instance running Ubuntu 18.04/20.04 accessible via ssh
- A sudo account configured on the remote server
- Ability to run Linux commands on bash/terminal.

#### Step 1: Install Apache webserver

- Open terminal and log on to the remote server using ssh command: `ssh sudo_user@IP address`, enter the remote user password when prompted.
- Ensure your server is up to date by running the following commands:
  
  ```
  sudo apt update
  sudo apt upgrade
  ```
- Install Apache using the following script:
  ```
  sudo apt install apache2
  ```
- Confirm Apache is running with following command:
  ```
  sudo systemctl status apache2
  ```
- You should get an output showing that apache2.service is running and enabled
- Test the installation by accessing the servers IP address on the browser:
  ```
  http://ServerIPAddress
  ```
- You should see a page with an “Apache2 Ubuntu Default” header showing that Apache2 has been installed successfully
- Enable mod_rewrite by running the following command:
  ```
  sudo a2enmode rewrite
  ```
After enabling mod_rewrite you need to restart Apache for the changes to take effect:

```
sudo systemctl restart apache2
```

- Navigate into the `/etc/apache2/sites-available`

```
cd /etc/apache2/sites-available
```

- Create a new Apache configuration for your installation:

```
sudo touch [your_domain_name].conf
```

- Open the created Apache configuration file using your text editor of your choice:

```
sudo vi [your_domain_name].conf
```

- Copy and paste the following code into the file:

```html
<VirtualHost *:80>
    ServerAdmin webmaster@localhost
    ServerName [your_domain_name]
    ServerAlias www. [your_domain_name]
    DocumentRoot /var/www/csweb
    ErrorLog ${APACHE_LOG_DIR}/error.log
    CustomLog ${APACHE_LOG_DIR}/access.log combined
    <Directory /var/www/csweb>
        Options -Indexes +FollowSymLinks
        AllowOverride All
        Require all granted
    </Directory>
</VirtualHost>
```

- Close and save the file by pressing `:wq`

- Disable default Apache configuration:

```
sudo a2dissite 000-default.conf
```

- Enable your new Apache configuration:

```
sudo a2ensite [your_domain_name].conf
```

- Restart Apache for the changes to take effect:

```
sudo systemctl restart apache2
```

- If you don’t get any errors, then the Apache configurations have been successfully set up.

### Step 2: Install PHP 7.4 and additional packages

The current version of CSWeb has only been tested to run correctly on PHP 7.3/7.4. For PHP versions above 7.4, the system will throw an error during set up of CSWeb. It is therefore recommended to install PHP 7.3 or 7.4.

- Installing PHP 7.4 on Ubuntu

```
sudo apt install software-properties-common ca-certificates lsb-release apt-transport-https
```

```bash
```
Add the Ondrej PPA to your system, which contains all versions of PHP packages for the Ubuntu systems:

```bash
LC_ALL=C.UTF-8 add-apt-repository ppa:ondrej/php
```

Now, update the Apt package manager cache:

```bash
sudo apt update
```

Install PHP 7.4 and PHP 7.4 extensions:

```bash
sudo apt install php7.4 php7.4-mysql libapache2-mod-php php7.4-xml python3-pip php-zip
```

Check the active PHP version:

```bash
php -v
```

Change the default PHP version for CLI:

```bash
sudo update-alternatives --config
```

Install additional packages:

```bash
sudo apt install wget unzip
```

**Step 3: Install and configure MariaDB**

MariaDB is an open-source relational database management system (DBMS) that is a fork of the original MySQL. It is intended as a drop-in replacement for the MySQL database technology.

Install MariaDB by running the following commands:

```bash
sudo apt install mariadb-server
```

Confirm it is correctly installed by running the following command:

```bash
sudo systemctl status mariadb
```

You should get an output showing mariadb.service is loaded and running.

Secure the MariaDB service by running the command:

```bash
sudo mysql_secure_installation
```

When prompted for root password, press Enter, since there is no password set on first installation instance. Proceed with the prompts to set a secure password. You can also remove anonymous databases.

Log into MariaDB using root user and the password in the previous step. Run the command:

```bash
mysql -uroot -p
```

After entering the correct mysql root password you should be redirected to the MySQL prompt.

Create the HHFA database and HHFA database user. Run the commands below in the MySQL prompt window:

- Create `csweb` database:
  ```sql
  create database hhfa_db;
  ```

- Create Database user:
  ```sql
  create user 'hhfa_user'@'localhost' identified by 'Secure Password';
  ```
  Please keep note of the HHFA user password as it will be required later during final setup

- Grant access privileges on database to database user:
  ```sql
  grant all privileges on hhfa_db.* to 'hhfa_user'@'localhost';
  ```

- Flush privileges:
  ```sql
  flush privileges;
  ```

- Exit:
  ```sql
  exit;
  ```
Step 4: Download CSWeb files

- Navigate to the temp folder
  
  ```bash
cd /tmp
  ```

- Visit the link below in your browser:
  
  https://www.census.gov/data/software/cspro.Download.html

- Look for CSWeb on the download page. Right click on the file and select Copy link address

- In the terminal window type in:
  
  ```bash
  sudo wget <paste in the link address copied> For example, it should be like:
  sudo wget https://www2.census.gov/software/cspro/download/csweb.zip
  ```

- A csweb.zip file will be downloaded into the /tmp folder. Unzip the csweb zip file into the Apache webserver directory:
  
  ```bash
  sudo unzip -d /var/www/csweb csweb.zip
  ```

- Navigate into the /var/www/csweb folder:
  
  ```bash
  cd /var/www/csweb
  ```

- Set folder permissions:
  
  ```bash
  ```

Step 5: Set up CSWeb

- Go to your web browser and access the host domain or IP address of the server, e.g. http://[your_domain_name]. If all of the system requirements have been met, you will see a page like this:

  ![CSWeb: Server Requirements](image)

  - The green check marks show that all the server requirements for CSWeb installation have been met. Click Next to proceed. You will be redirected to the following page:
Use the information used during setup of MariaDB to populate the database information:

- **Database name:** Name as defined during database setup i.e. demo2
- **Hostname:** usually localhost
- **Database username:** mysql_csweb_user as defined in database setup
- **Database user password:** mysql csweb password as defined in database setup
- **CSWeb admin password:** Enter the admin password for CSWeb admin user. This will be used for initial CSWeb browser login. **Please note this password.** If you forget this password, it cannot be retrieved, and you will have to reconfigure the CSWeb installation.

Select the appropriate time zone and leave the rest of the fields with default settings. Click Next to continue.

On successful configuration you will get the following page:

Click Login. You will be redirected to the following page:
Log in using the following credentials:

- Username: admin
- Password: CSWeb admin password set above.

On successful login you will be redirected to the CSWeb dashboard.

CSWeb dashboard

The data tab shows the list of dictionaries and submitted cases. Use this option to download the data.

The Applications tab lists applications that have been installed on CSWeb. Usually these are the applications deployed through the Deploy Applications tool, which is a part of CSPro software.

The Roles tab is where user roles and permissions are defined. There are two pre-defined roles within the application (administrator and standard user) upon initial configuration. Additional roles can be added as needed.

- **Administrator**: Has full access to all the system resources.
- **Standard User**: Has no access to browser-based interface. Can only download the CSPro application to a tablet and send data to the server from a tablet.
The Users tab lists all the users and their roles. An admin user will automatically be created when CSWeb is initially configured. For security purposes, it is recommended to create at least one standard user that can be shared with field teams if needed. For example, if the QR code scan is not working for installing the CSPro application, a username and password can be used instead. In this case, a standard user login credential (which has limited permissions) can be shared as opposed to an administrator credential.
6. Configuring the HHFA CSPro application

The HHFA application must be configured before it can be used in a survey – without this configuration, it will not work. Detailed instructions for each step in the configuration process can be found in this chapter.

6.1 Create staff lookup file

The HHFA CSPro application has been designed for multiple user roles, with different functionality assigned to each role. The staff file is used to define the individuals that will have access to the HHFA data collection application and assigns a role to each person.

Four roles can be assigned in the staff file:

- **Data manager**: The data manager is primarily responsible for configuring the HHFA CSPro application for country implementation. Data managers also are able reset the device registration for all devices.

- **Supervisor**: Supervisors serve two main functions: to generate facility reports to assess survey completeness for ALL data; and to collect data for supervisor validations. To complete these two functions, supervisors are given functionality to assign themselves questionnaire sections for the facilities they will visit for the 10% validation revisits, collect data at those visits and sync data to the central database. In addition, supervisors have functionality to download data and view reports to check on the progress of the survey. Supervisors do NOT have functionality to collect data for general data collection activities. They do have the functionality to reset a team leader or data collector’s device registration for individuals they are supervising.

- **Team leader**: Team leaders serve a vital function during data collection as they are responsible for assigning sections for data collection to each data collector on their team for every facility that will be surveyed. They are also responsible for receiving data from data collectors, creating a complete data record and syncing data. Team leaders can themselves also participate in data collection. There are also tools available to assist team leaders in understanding progress towards survey completion. The team leader can also transfer the data collection application files to a data collector over Bluetooth in the case of problems updating the application via the internet and has functionality to reset a data collector’s device registration.

- **Data collector**: The data collector’s primary responsibility is to collect data at health facilities. They receive section assignments from team leaders, collect data and send data to the team leader. Data collectors also have functionality to sync their data for backup and to view reports to monitor their own progress towards completion of assigned sections.

The staff lookup file defines the staff user roles and login codes that will have access to the HHFA CSPro application. To create the staff lookup file, take the following steps:

1. Generate a list of the names of all the data collectors, team leaders, supervisors and data managers that will participate in the HHFA. The list should include how teams will be nested (i.e. which data collectors report to which team leader; which team leaders report to which supervisor).

2. Open the example staff Excel lookup file called sample_staff_file.xlsx located in the ref folder (see example image opposite). The sample_staff_file.xlsx file contains five columns: Staff Code, Staff Name, Role, Supervisor, Team Leader. The names of these columns should NOT be changed, as this may cause difficulty in mapping the columns to the associated dictionary.
### 3. Configuring the HHFA CSPro application

#### a. Setting up the Sample Staff File

In column B (Staff Name), starting in row 2, replace the information with the names of your staff members by placing one staff member name on each row.

#### b. Assigning Roles

In column C (Role), enter the code corresponding to the role that should be assigned to each staff member. The codes for each role are as follows:

- **i.** Data manager = 1
- **ii.** Supervisor = 2
- **iii.** Team leader = 3
- **iv.** Data collector = 4

#### c. Entering Staff Codes

In column A (Staff Code), enter a unique numeric code for each staff member. This will serve as the login code to the HHFA CSPro application for each individual. The CSPro application accommodates a numeric code of up to five digits for the staff code. You can choose to use a two-, three-, four- or five-digit code for each staff member as long as each code uniquely identifies a staff member and all codes are numeric. (Alpha or alphanumeric codes cannot be used.)

- **i.** If you want to autogenerate random four-digit codes, you can use the following formula to generate unique four-digit codes in Excel. Remember to copy/paste the codes as values after generating them as these numbers will recalculate when you reopen the workbook if left as a formula.

\[
\text{=TRUNC((RAND())*(9999-1000)+1000),0}
\]

#### d. Recording Supervisors and Team Leaders

In column D (Supervisor) record the Staff Code of the Supervisor to which team leaders report. The Supervisor column should only be completed for staff who have been assigned the role of team leader.

In column E (Team leader) record the Staff Code of the Team leader to which the data collectors report. The Team leader column should only be completed for staff who have been assigned the role of data collector.

#### 4. Saving the File

Save the file as HFA_Staff.xlsx when you have finished editing and all survey staff have been entered.
5. Check the number of digits used for the numeric codes in the Staff Code, Supervisor and Team leader columns. If more than five digits have been used in any of these columns, take the following steps to edit the dictionaries to accommodate the additional digits. In addition, check the number of characters used for Staff names. If any Staff names are longer than 30 characters, the following steps should also be taken to edit the dictionaries to accommodate the additional digits.

   a. Go to the folder HFA_WHO\dicts
   b. Open the dictionary file HFA_Staff.dcf
   c. In the tree on the left, click on the record called “_IDS0”. On the right you will see one item called STAFF_CODE. Similarly, click on the record called “STAFF_REC”. On the right you will see four items called STAFF_NAME, STAFF_ROLE, SUPERVISOR and TEAM_LEAD. For each of these items, there is a field called “Len” which corresponds to the number of digits allocated to the variable. Change the “Len” field to match the number of digits required for each item. Save and close the dictionary.

6. The HFA_Staff.xlsx file will now be converted to a .csdb data file using the CSPro tool **Excel to CSPro**. Open the Excel to CSPro tool by clicking on Start  CSPro 7.7  Excel to CSPro. The following window will open. Make sure you are on the Excel to CSPro tab of the tool.

7. Click on Select Excel File. Select the Excel file, HFA_Staff.xlsx, that you created previously.
8. Click on Select CSPro Dictionary. Select the HFA_Staff.dcf CSPro dictionary from the folder HFA_WHO/dicts. This dictionary was previously created to match the Sample_Staff_File.xlsx file.

9. Click on Select Output Data File. Select the HFA_Staff.csdb data file from the folder HFA_WHO/ref. If this file already exists, you can replace it.

10. Now you are ready to complete the “Record to Worksheet Mapping”. This maps the Excel HFA_Staff.xlsx that you created to the CSPro dictionary. On the left side of the window where it says STAFF_RECORD, select the worksheet from the Excel file (Sheet 1). This should allow a mapping window to open on the right side of the window.

11. On the right side of the window, first look at the Options. Starting Row should say 2 as the HFA_Staff.xlsx file has a header row in the first row that does not need to be mapped. Case management should be set to “Create a new file” as opposed to “Overwrite an existing file”. Next, under “Item to Column Mapping” map the columns in the HFA_Staff.xlsx file to the corresponding item names in the CSPro dictionary. When all fields are complete, the window should look like the following image:

12. Click “Create CSPro Data File”. This will create and save the HFA_Staff.csdb file which has now been updated with the staff for the survey. Note: It is important to use this exact file name as the application will be expecting to find this specific file in the ref folder.

13. If you think you may need to recreate the staff file you can save the specification for reuse to avoid having to repeat the mapping steps using the Excel to CSPro tool. To save your specification, click on File → Save Specification and give your specification a name such as HHFA_staff_specification.

### 6.2 Create facility lookup file

The HHFA CSPro application is designed to be pre-populated with a list of health facilities that will be visited during the survey. This list should be generated based on the Master Facility List (MFL) and will consist of either the facilities sampled for inclusion in the survey or all the facilities in the country in the case of a census.

The facility lookup file defines the facilities for which data will be collected. To create the facility lookup file, take following steps:

1. Obtain the list of facilities to be included in the survey from the survey manager. Ask the survey
manager to ensure that the list includes information on the facility ID, the facility name and the location in terms of the first two administration levels (e.g. region, region code, district and district code). Often, the survey manager will provide this information in the form of the MFL, which may include additional information. Below is an example of what an MFL may look like:

2. Open the example facility Excel lookup file called sample_facilities_file.xlsx located in the ref folder (see example image below). The sample_facilities_file.xlsx file contains six columns: Facility Code, Facility Name, Region Name, Region Code, District Name, District Code. The names of these columns should NOT be changed as this may cause difficulty in mapping the columns to the associated dictionary. It is also important to make sure that you do not have extra columns in the final sample_facilities_file.xlsx file as extra columns can make it difficult to correctly map the columns to the associated dictionary.

3. We will now use the sample_facilities_file.xlsx file as a reference template and either edit the MFL of sampled facilities to match this format or use the sample_facilities_file.xlsx file and replace the existing content with your list of facilities. If you choose to edit/adapt the MFL of sampled facilities, in most cases the MFL will contain additional columns that will need to be removed in order to retain only the six required columns.

4. Save the file as HFA_Facilities.xlsx when you have finished editing and all facilities have been entered.

5. Check the number of digits used for the numeric codes in the Facility Code, Region Code and District Code columns. If more than nine digits have been used for the Facility Code or more than two digits have been used for the Region Code or District Code, take the following steps to edit the dictionaries to accommodate the additional digits. In addition, check the number of characters used for Facility Names. If any Facility Names are longer than 60 characters, the following steps should be followed to edit the dictionaries to accommodate the additional digits.

   a. Go to the folder HFA_WHO\dicts
   b. Open the dictionary file HFA_Facilities.dcf
6. Configuring the HHFA CSPro application

c. In the tree on the left, click on the record called “_IDS0”. On the right you will see one item called FACILITY_ID. Similarly, click on the record called “FACILITIES_REC”. On the right you will see three items called FAC_NAME, REG_CODE and DIST_CODE. For each of these items, there is a field called “Len” which corresponds to the number of digits allocated to the variable. Change the “Len” field to match the number of digits required for each item. Save and close the dictionary.

d. Repeat this process for the HFA_DICT.dcf and HFA_COMB.dcf dictionaries. In the HFA_DICT.dcf and HFA_COMB.dcf dictionaries, the region and district variables are in the record called “SECT01” and are called Region/Province code and District code. In both the HFA_DICT and the HFA_COMB dictionaries, the facility code is called Q100 and is in the “_IDS0” record, while the facility name is called Q102 and is in the “SECT01” record.

e. Repeat this process for the HHFA_Menu.dcf dictionary for the item called SELECT_FACILITY in the “HHFA_MENU_REC”.

6. The HFA_Facilities.xlsx file will now be converted to a .csdb data file using the CSPro tool Excel to CSPro. Open the Excel to CSPro tool by clicking on Start → CSPro 7.7 → Excel to CSPro. The following window will open. Make sure you are on the Excel to CSPro tab of the tool.

7. Click on Select Excel File. Select the Excel file, HFA_Facilities.xlsx, that you created previously.
8. Click on Select CSPro Dictionary. Select HFA_Facilities.dcf CSPro dictionary from the folder HFA_WHO\dicts. This dictionary was previously created to match the sample_facilities_file.xlsx file.
9. Click on Select Output Data File. Select the HFA_Facilities.csdb data file from the folder HFA_WHO\ref. If this file already exists, you can replace it.
10. Now you are ready to complete the “Record to Worksheet Mapping”. This maps the Excel HFA_Facilities.xlsx you have created to the CSPro dictionary. On the left side of the window where it says FACILITIES_RECORD, select the worksheet from the Excel file (Sheet 1). This should allow a mapping window to open on the right side of the window.
11. On the right side of the window, first look at the Options. Starting Row should say 2 as the HFA_Facilities.xlsx file has a header row in the first row that does not need to be mapped. Case management should be set to “Create a new file” as opposed to “Overwrite an existing file”. Next, under “Item to Column Mapping” map the columns in the HFA_Facilities.xlsx file to the corresponding item names in the CSPro dictionary. When all fields are complete, the window should look like the image below:

![Excel to CSPro](image)

12. Click “Create CSPro Data File”. This will create and save the **HFA_Facilities.csdb** file which has now been updated with the health facilities for the survey. **Note**: It is important to use this exact file name as the application will expect to find this specific file in the ref folder.

13. If you think you may need to recreate the facility file, you can save the specification for reuse to avoid having to repeat the mapping steps using the Excel to CSPro tool. To save your specification, Click on File ➔ Save Specification and give your specification a name such as HHFA_facilities_specification.

**Replacement facilities**: On occasion an MFL will erroneously include a facility that is closed, non-operational, etc. If a closed or non-operational facility ends up in the sample, it may be replaced. However, the replacement must by controlled by the data manager at the central level. The data manager must respect the random sampling procedures to select a replacement facility and then the replacement facility must be added to the facility lookup file and the HHFA application redeployed. Data collection teams can then update their tablet application and will have access to the updated list of facilities.

**Adding a level to the facility lookup file**

In some country contexts, it may be helpful to add an additional level to the facility lookup file, for example sub-district. This is generally useful when there are many facilities per district in the sample and further filtering by sub-district would be helpful for data collectors when identifying the facility for data collection.

To create an additional level in the facility lookup file, take following steps:

1. Open the HFA_Facilities.xlsx you created as part of creating the facility lookup file. Add a column for “Sub-district” and fill in the name of the sub-district for each facility in the file. Add another column for “Sub-district code” and assign codes to each sub-district. Sub-districts should be numbered within a district starting from 1 (e.g. there will be a sub-district 1 in each district). Do not number sub-districts sequentially across all districts.
2. Add two dictionary items for sub-district code and sub-district name to the HFA_DICT dictionary. Place the items in Section 1: Facility identifiers after Q105T (district name). See Section 8.1 (Add a new question) for details on how to add a dictionary item.

3. Copy the sub-district code and sub-district name items from the HFA_DICT and place in the same location in the HFA_COMB dictionary and the HFA_Facilities dictionary (i.e. Sub-district code [Q105A] and Sub-district name [Q105AT]). In the HFA_Facilities dictionary, change the item names to SUBDIST_CODE and SUBDIST_NAME.

4. Add the sub-district code and sub-district name variables to the concatenation program (see Chapter 8 for detailed instructions).

5. Convert the HFA_Facilities.xlsx file to HFA_Facilities.csdb using the same steps provided above. You should now additionally be able to map the sub-district code and sub-district name fields.

6. To add the sub-district to the facility selection menu, changes must be made to the menu system as well as the data entry system. Make the following changes.

   a. Menu:

   i. Open the HHFA_Menu.ent file. Go to the HHFA_MENU_REC in the dictionary. Insert an item after “Select District” and before “Select Facility for Assignments”. The item should have the following properties:

      1. Item label: Select Sub-district
      2. Item name: SELECT_SUBDISTRICT
      3. Data type: Numeric
      4. Len: 2
      5. Item type: Item
      6. Occ: 1
      7. Dec: No
      8. Zero fill: No

   ii. Add the new Select Sub-district item to the FACILITY ASSIGNMENT FORM in the FACILITY ADMIN BLOCK after “Select District”. Right click on the Select sub-district response box and select field properties. Change the capture type to radio button.

   iii. Click on the HHFA_MENU_FF to access the global logic. Scroll to line 65 and after the line “string capi_selected_district;” add a line of code that says “string capi_selected_subdistrict;”

   iv. Sub-district item: Go to the logic for the newly added SELECT_SUBDISTRICT item and paste the following logic:

   ```plaintext
   PROC SELECT_SUBDISTRICT
   onfocus
   SELECT_SUBDISTRICT = notappl;
   geography_vs.clear();
   geography_vs.add(maketext(1025), 99);//"Back to Menu"
   selcase(FACILITIES_DCF,"" include(SUBDIST_CODE,SUBDIST_NAME) where (REG_CODE= SELECT_REGION and DIST_CODE = SELECT_DISTRICT) multiple(automark);
   for FACILITIES_DCF do
   i=0;
   do j=1 while j<= geography_vs.length()
   if geography_vs.codes(j)=SUBDIST_CODE then
   i=1;
   ```
break;
endif;
enddo;
if i=0 then
   geography_vs.add(SUBDIST_NAME, SUBDIST_CODE);
endif;
enddo;
setvalueset(SELECT_SUBDISTRICT,geography_vs);
always = 1;
while always = 1 do
   k = geography_vs.show(“Select the SUB-district”);
   if k>0 then
      $=k;
      selected_fac_dist=k;
      always =2;
      break;
   endif;
enddo;
setvalueset($, geography_vs);
noinput;

postproc
   if $ = 99 then
      $=notappl;
      reenter SELECT_DISTRICT;
   endif;
capi_selected_subdistrict = getvaluelabel($);
//GetSubDistName(SELECT_REGION, SELECT_DISTRICT);

v. Select_facility item: Go to the logic for the SELECT_FACILITY item. Delete the logic present and replace with the following logic:

PROC SELECT_FACILITY
   onfocus
      $ = “”;
      if staff_role_no = 2 then
         entry_type = 1;
      elseif staff_role_no = 3 then
         entry_type = 2;
      endif;
   valueset facilities_vs;
   facilities_vs.add(maketext(1006), 9999999999);
   //“Back to Menu”
   selcase(FACILITIES_DCF,””)include(FACILITY_ID,FAC_ NAME) where (REG_CODE= SELECT_REGION and DIST_CODE=SELECT_ DISTRICT and SUBDIST_CODE = SELECT_SUBDISTRICT) multiple(automark);
   for FACILITIES_DCF do
      i = CheckFacilityAssigned();
      if i then
         facilities_vs.add(strip(FAC_ NAME)+maketext(0086), FACILITY_ID);
         //(Modify assignments)
      else
         facilities_vs.add(strip(FAC_NAME), FACILITY_ID);
      endif;
6. Configuring the HHFA CSPro application

```plaintext
endo;

always = 1;
while always = 1 do
    k = facilities_vs.show("Select the facility");
    if k>0 then
        $=edit("9999999999", k);
        always =2;
        break;
    endif;
endo;

//setvalueset($, facilities_vs);
noinput;

postproc
if $ = "9999999999" then
    onstop();
else
    loadcase(FACILITIES_DCF, SELECT_FACILITY);
    messgTxt = tr("Confirm selection of facility: %s, for section assignments");
    if CheckFacilityAssigned() then
        if find(HHFA_DICT, startswith, maketext("%010d",facility_id)) then
            messgTxt = "Data collection for facility %s has started. Do you want to modify the assignments? Please note, you"+
                " will not be able to reassign sections if data collection has started."
        else
            messgTxt = tr("Do you want to modify the section assignments for facility: %s");
        endif;
    endif;
// endif;
errmsg(messgTxt, toupper(strip(FAC_NAME)))
    select(maketext(0087), continue, maketext(0003), $);
    // select(tr("Yes, proceed"), continue, tr("Cancel"), $);
    CaseID = maketext("%010d%d%05d",facility_id,entry_type,login);
    runAssignments();
endif;
```

b. Entry application:

Go to the entry folder and open the HFA.ent file. Go to the HHFA_COVER form and add the Sub-district code (Q105A) and Sub-district name (Q105AT) items to the form below Q105/Q105A (district code and name).

i. Reorder the items in the forms tree to ensure Q105A and Q105AT come just after Q105T.

ii. Right click on the Sub-district code response box and select field properties. Check the box “Protected”.

iii. Right click on the Sub-district name response box and select field properties. Check the box “Protected”.
iv. Sub-district code item: Go to the logic for the Q105A / Sub-district code item. Add the following logic:

```preproc
if visualvalue($) in default, notappl then
  //$ = tonumber(sysparm(“dist_code”));
  $=SUBDIST_CODE;
endif;
```

v. Sub-district name item: Go to the logic for the Q105AT / Sub-district name item. Add the following logic:

```preproc
if strip($) = "" then
  //$ = sysparm(“dist_name”);
  $=SUBDIST_NAME;
endif;
```

7. Test out the application to ensure the sub-district is now included in the cascading menu for facility selection.

### 6.3 Configure the HHFA setup menu

The setup menu allows data managers to specify a set of parameters for country-specific implementation. This includes key features such as:

- default display language
- module selection
- synchronization method
- additional options to turn on/off questions.

This section reviews the steps for configuring the setup menu. Before running the HHFA setup menu, make sure that you have generated the following lookup files. Each of these should be a .csdb file that is saved in the folder HFA_WHO:

- staff lookup file (HFA_Staff.csdb)
- facility lookup file (HFA_Facilities.csdb).

To configure the HHFA setup menu, take the following steps:

1. Open the HFA_WHO folder, double click to open the HHFA_Menu.ent file as shown below.
2. The following window will open up. Click on the traffic icon at the top left of the screen to run the application.

3. Click OK to proceed when the next window pops up as in the image below.

4. Click OK in subsequent pop-up windows until the following window appears. Select “Y Setup Survey Parameters” and click on the green tick icon to proceed with the HHFA setup.
Note: If this is not the first time you have run the setup menu, you will not see this screen. Instead, you will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities.

5. When prompted for the HFA password, enter “Geneva”. The following setup screen will open. This is where you will begin entering information specific to the survey in your country.

6. Enter the survey basics:

   a. Select the country of survey in the **country code** field.
   
   b. HFA **start date**: Enter the HFA Start Year and Month. By default, the current year and month are preselected.
   
   c. HFA **end date**: Enter the HFA End Year and Month.

   The survey start date and end date are important fields because this controls the period during which data collectors will be able to enter data on tablets. Data collection on tablets will not be permitted outside of the defined survey time period. If data collection is attempted outside of the defined survey period one of the below error messages will be displayed.
d. Select the default **survey language**. This sets the default language for the HHFA CSPro application to run on the tablets. Chapter 8 (Modifying the HHFA application) explains where to add the relevant translated text. While some language options are provided here, additional languages can be added. You will need to do this in the modification of the HHFA application (Chapter 8) and then return to the setup menu to select the language you have defined as the default.

Enter the **data synchronization setup**: In this section you will setup the server synchronization method to be used with the application.

e. Select the data synchronization method – either Dropbox or CSWeb.

f. If you have selected CSWeb, enter a valid server URL. Please enter the URL of the CSWeb configured above with /api at the end, e.g. [https://cspro-hhfa.com/demo/api](https://cspro-hhfa.com/demo/api). The URL field contains a regex expression checker that validates the entered URL. If the URL is not valid, the following error message will appear:

```
Message (21) ×
Please enter valid CSWeb url in the format: httpsexample.com/csweb_server
OK
```

g. If you have selected CSWeb, enter the CSWeb username and password. The application will attempt to validate the CSWeb credentials entered. If the connection is successful, the following message will appear:

```
Message (25) ×
CSWeb connection successful!
OK
```

7. **Enter the module selection**: This section enables selection of the modules selected for the survey. The HHFA questionnaires are provided in two formats: “stand-alone” and “combined”. Each of the four HHFA modules has a set of stand-alone questionnaires that may include “Core”, “Core+Additional” and/or “Supplementary” questionnaires. The “Combined” questionnaire contains questions from the three facility audit questionnaires (Availability, Readiness, and Management and finance), integrated and organized by service site or respondent to facilitate data collection at facility level. Fig. 3 details the HHFA modules and questionnaires. Each country may select to implement one or more modules for their HHFA. In addition, countries may select Core, Core+Additional, and/or Supplementary questionnaires within each module selected. The module selection in CSPro should be completed to align with the questionnaires a country has selected for survey implementation.
### Fig. 3. HHFA modules and questionnaires

#### Service availability
- Facility infrastructure
- Staff
- Beds
- Specific services
- Building structure

#### Service readiness
- Guidelines
- Trained staff
- Equipment
- Diagnostics
- Medicines and commodities

#### Quality of care
- Adherence to standards in patient care processes

#### Management and finance
- Management systems
- Finance systems
- Health information systems
- Quality assurance systems

#### Stand-alone questionnaires
- **Availability:**
  - Core
  - Core+Additional
  - Additional/Supplementary

#### Stand-alone questionnaires
- **Readiness:**
  - Core

#### Stand-alone questionnaires
- **Quality of care:** Additional/Supplementary
- Record review

#### Stand-alone questionnaires
- **Management and finance:**
  - Core
  - Core+Additional

---

The selection (or not) of a module in CSPro determines whether a set of related questions will be activated (i.e. turned on) or deactivated (i.e. turned off). Selection of “Core” deactivates additional questions while selection of “Core+Additional” activates all Core and Additional questions. Additional/ Supplementary will activate the supplementary questions. Activating a question means that the question will be visible in the data entry application and data can be collected for that question. Deactivating a question means that the question is entirely skipped within the data entry application and no data will be collected for that question.

**Activation/deactivation:** The concept of activating/deactivating is used to help minimize the amount of effort required when you want to delete questions from the data entry forms, as the process of permanently deleting a question from the form requires adjusting/removing the associated syntax logic. The activate/deactivate concept means that you do not need to worry about the logic behind the questions. The program will check the status of each question and automatically readjust the skips.

8. Enter the question activation/deactivation sheet: After the module selection, the question mapping roster will be populated with all the WHO standard HHFA questions. Each question is mapped to its respective module and information on whether each question is expected to be activated or deactivated (based on the module selection) is displayed. At this stage, the question selection enables manual activation or deactivation of individual questions. This enables country-specific customization. For example, a country may choose to exclude a section of core questions if a disease area is not applicable to the country. In this case, those questions will need to be manually deactivated in the Question Selection phase using the question mapping roster. Similarly, a country may want to implement a core questionnaire but include a subset of additional questions. The additional questions will need to be manually activated in the Question Selection phase using the question mapping roster.
a. After completing the module selection, the CSPro application may take a few minutes to populate the question mapping roster. Please wait for the question mapping roster to populate before proceeding.

b. After the question mapping roster has been populated, the program will navigate to the section selection field. All sections within the questionnaire will be populated in the dropdown list as shown below.

c. By default, all sections of the questionnaire will be shown. If there is no single question activated in a section, a suffix phrase will appear at the end of the section as shown below.

d. To activate one or more questions, click on the section in which the question(s) fall. A question activation sheet will be displayed as below.
Note: All questions appearing in green background colour have been activated, while those appearing in red background colour have been deactivated.

e. If you would like to activate a group of questions, select by ticking the check box on the left side of the questions and click Activate selected. A confirmation box will be displayed as below. Click Yes to confirm activation.

f. Similarly, if you would like to deactivate a group of questions, select the questions by ticking the check box on left side of the questions and click De-activate selected. A confirmation box will be displayed as below. Click Yes to confirm deactivation.
g. You can also select the whole section by clicking on the check box in the header section. All questions will be selected, and you can perform the appropriate action.

h. Once you are done with question activation/deactivation within a section, click Exit to go back to the sections listing field. Select the subsequent section to perform question activation/deactivation. If no more sections need changes, click No more activation (Exit) and the program will complete the setup process.

**Note:** Any country-specific questions that have been added to the HHFA CSPro application will not show in the question mapping activation sheet. However, by default, any questions that are added to the HHFA CSPro application are activated. No further actions are required to ensure these country-specific additions are fielded with the HHFA application.

9. When the setup menu configuration is complete, you will receive the following message:
10. The setup menu will close and you will be returned to the menu system where you will be prompted for your login code. Enter your data manager login code to access the additional data manager functionalities. You should now see the Data Manager menu which looks like this:

11. If you re-enter the Setup HHFA survey parameters to make further adjustments to the question mapping, you will be given the option to keep the current question mapping settings or to reset them based on the module selection. If you do not want to lose any previous manual changes made to the question activation sheet, please make sure to select “No, keep current mappings”.

12. Most of the data manager functionalities will be discussed in Chapter 15 (Reviewing and editing data). However, after completing the initial setup, you may find that there are a few questions that need to be activated/deactivated. From the Data Manager menu, click on option B, **Activate/Deactivate Questions**. This option will open the same activation sheet similarly to the one in the setup tool, allowing you to activate/deactivate additional questions.
7. Getting to know the HHFA CSPro application

7.1 Start CSPro and open HHFA application

Now you are ready to start the HHFA application using CSPro:

1. Double click on the desktop’s CSPro 7.7 icon or select All Programs ➔ CSPro 7.7 ➔ CSPro 7.7 from the start menu.
2. Select Open an existing application and double click on …other files to browse to the HFA.ent file located at HFA_WHO\entry.
3. Alternatively, you can double click on the HFA.ent file in the HFA_WHO\entry folder.
4. The cover page of the HHFA data entry application opens. The screen is subdivided into two parts: the left part displays a files tree; the right part corresponds to the application.
7.2 Explore the HHFA application

The workspace

The CSPro workspace is divided into two parts: the left is reserved to display file trees; and the right window is reserved to display the actual application.

Trees

Trees are displayed in the left part of the screen and they present the relationship between the different files.

There are three types of trees, corresponding to the three tabs at the bottom part of the left screen (see red outline): the **Files tree (Files)**, the **Dictionary tree (Dicts)** and the **Forms tree (Forms)**.

- **Files**: The files tree shows all the data entry applications that are open, and the files they contain.
- **Dicts**: The dictionary tree shows all the dictionaries the application is using, and their contents.
- **Forms**: The data entry forms tree shows all the forms for the opened application. When clicking on the plus sign in front of a form, the items of the given form are also shown.

You can navigate from one tree to another by clicking on the tab of interest (marked with a red ring above).

In the above picture, the actual names of each of the fields of the form are displayed in the tree (for instance, Q102). This is sometimes helpful, but sometimes you need to know more about the field. To alternate between showing the name or the label of the items in the tree, click on View ➔ Names in tree (or use Ctrl+T).
Window

The window on the right side of the screen allows you to modify the contents of a dictionary or a form. Each different window has different functions associated with it (different menu and toolbar). When opening an existing application, CSPro displays the first form of the application as default (as shown above). To see the workspace for the dictionary instead, click on the dictionary icon above the workspace.

Toolbars

Menu toolbar

The menu bar includes features common to most Windows applications plus some that are unique to CSPro.

Data Dictionary toolbar

The Data Dictionary toolbar is displayed across the top of the window, below the menu bar. It provides quick mouse access to many features used in the Data Dictionary. It is available whenever the right-hand screen displays dictionary items. If the right-hand screen is not displaying dictionary items, click on the dictionary icon on the toolbar. The table below provides a description of the function of each icon in the data dictionary toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>![file]</td>
<td>Create a new dictionary</td>
</tr>
<tr>
<td>![open]</td>
<td>Open a dictionary</td>
</tr>
<tr>
<td>![save]</td>
<td>Save a dictionary</td>
</tr>
<tr>
<td>![margin]</td>
<td>Set up page margins and headings for printing</td>
</tr>
<tr>
<td>![preview]</td>
<td>Preview contents of the dictionary</td>
</tr>
<tr>
<td>![print]</td>
<td>Print contents of the dictionary</td>
</tr>
<tr>
<td>![undo]</td>
<td>Undo the last change to dictionary</td>
</tr>
<tr>
<td>![redo]</td>
<td>Redo last undo</td>
</tr>
<tr>
<td>![cut]</td>
<td>Cut the selected records, items, or values to the clipboard</td>
</tr>
<tr>
<td>![copy]</td>
<td>Copy the selected records, items, or values to the clipboard</td>
</tr>
<tr>
<td>![paste]</td>
<td>Paste the contents of the clipboard to the current position</td>
</tr>
<tr>
<td>![add]</td>
<td>Add levels, records, items, values sets, or values</td>
</tr>
<tr>
<td>![insert]</td>
<td>Insert levels, records, items, values sets, or values</td>
</tr>
<tr>
<td>![delete]</td>
<td>Delete levels, records, items, value sets, or values</td>
</tr>
<tr>
<td>![edit]</td>
<td>Edit notes for dictionary, level, record, item, value set, or value</td>
</tr>
</tbody>
</table>
Find a label or a name in the dictionary
Show the Layout window
Show last Dictionary window
Show last Forms window
Get help

Forms Designer toolbar
The Forms Designer toolbar is displayed across the top of the window, immediately below the menu bar. The toolbar provides quick mouse access to many of the often used features found in the Forms Designer. It is available whenever the right-hand screen is displaying forms. If the right-hand screen is not displaying forms items, click on the forms icon on the toolbar. The table below provides a description of the function of each icon in the forms designer toolbar.

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Create a New application" /></td>
<td>Create a New application</td>
</tr>
<tr>
<td><img src="image2" alt="Open an application" /></td>
<td>Open an application</td>
</tr>
<tr>
<td><img src="image3" alt="Save an application" /></td>
<td>Save an application</td>
</tr>
<tr>
<td><img src="image4" alt="Compile the logic (code) of your data entry application" /></td>
<td>Compile the logic (code) of your data entry application</td>
</tr>
<tr>
<td><img src="image5" alt="Run the current data entry application (i.e., start-up CSEntry)" /></td>
<td>Run the current data entry application (i.e., start-up CSEntry)</td>
</tr>
<tr>
<td><img src="image6" alt="Undo the latest changes" /></td>
<td>Undo the latest changes</td>
</tr>
<tr>
<td><img src="image7" alt="Redo the latest changes" /></td>
<td>Redo the latest changes</td>
</tr>
<tr>
<td><img src="image8" alt="Cut the selected elements to the clipboard" /></td>
<td>Cut the selected elements to the clipboard</td>
</tr>
<tr>
<td><img src="image9" alt="Copy the selected elements to clipboard" /></td>
<td>Copy the selected elements to clipboard</td>
</tr>
<tr>
<td><img src="image10" alt="Paste the contents of the clipboard to the form" /></td>
<td>Paste the contents of the clipboard to the form</td>
</tr>
<tr>
<td><img src="image11" alt="Delete the currently selected item(s)" /></td>
<td>Delete the currently selected item(s)</td>
</tr>
<tr>
<td><img src="image12" alt="Find text in logic" /></td>
<td>Find text in logic</td>
</tr>
<tr>
<td><img src="image13" alt="Toggle between selecting item(s) or drawing boxes" /></td>
<td>Toggle between selecting item(s) or drawing boxes</td>
</tr>
<tr>
<td><img src="image14" alt="View the forms" /></td>
<td>View the forms</td>
</tr>
<tr>
<td><img src="image15" alt="View the logic" /></td>
<td>View the logic</td>
</tr>
<tr>
<td><img src="image16" alt="View the CAPI question" /></td>
<td>View the CAPI question</td>
</tr>
<tr>
<td><img src="image17" alt="Show last Dictionary window" /></td>
<td>Show last Dictionary window</td>
</tr>
<tr>
<td><img src="image18" alt="Show last Forms window" /></td>
<td>Show last Forms window</td>
</tr>
<tr>
<td><img src="image19" alt="Get Help" /></td>
<td>Get Help</td>
</tr>
</tbody>
</table>
8. Modifying the HHFA application

The HHFA resource package consists of several interdependent components including: the questionnaire and data entry application, batch applications for data processing, and a data analysis platform to support data analysis and data visualization. All the parts are dependent on each other. It is therefore not recommended to modify the data entry application extensively. However, a limited number of country-specific changes will be needed. Question areas that usually require country adaptation include health facility types, health facility managing authorities, staff categories, trained staff and medicines as well as any questions which say [COUNTRY ADAPT] in the paper questionnaire. Table 3 has a list of issues to check for country adaptation.

There is generally a country questionnaire adaptation workshop in advance of the survey implementation where these decisions are made. A track changed paper questionnaire should be provided to the data manager with the adaptations that need to be made. However, sometimes not all required adaptations have been made during the questionnaire adaptation workshop and therefore it is also the responsibility of the data manager to review the adaptations and ensure all issues have been addressed.

### Table 3. Questionnaire adaptations

<table>
<thead>
<tr>
<th>Areas</th>
<th>References</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Health facility types</td>
<td>National classification of health infrastructures</td>
<td>The facility type classification should reflect the national classification, including both public and private structures.</td>
</tr>
<tr>
<td>Health facility managing authorities</td>
<td>National classification of health infrastructures</td>
<td>The managing authority types should reflect the national classification of authorities potentially in charge of a facility.</td>
</tr>
<tr>
<td>Country-specific medicines policy</td>
<td>National drug policy and any other specific drug policies (essential medicines, TB)</td>
<td>Standard lists of tracer items for medicines are proposed in the questionnaire according to international standards. Country-specific medicines, defined as “minimum standard” requirement, can be included in the lists.</td>
</tr>
<tr>
<td></td>
<td>Antiretroviral (ARV) national protocol</td>
<td>The ARV section should be customized based on the official recommended first-line treatment.</td>
</tr>
<tr>
<td>Staffing categories</td>
<td>Official categorization of human resources for health</td>
<td>The proposed human resources list available in the questionnaire should be updated according to the official classification of certified health personnel.</td>
</tr>
<tr>
<td>Trained staff</td>
<td>Official training cycle for health workers</td>
<td>A standard of 2 years’ interval in training cycle updates for staff is used in the questionnaire. If the timeframe for staff training updates is different, according to official policy, it should be reflected in the questionnaire.</td>
</tr>
<tr>
<td>Clinical guidelines</td>
<td>National guidelines for clinical care</td>
<td>Availability of guideline questions may need to be adapted to align with the official guidelines used by a country. If an overarching guideline document encompasses the topics across several HHFA guideline questions, it is recommended to add a country-specific guideline question that encompasses the range of topic areas and then program the CSPro logic to record responses to the individual topics aligned with the availability of the country-specific broader guideline.</td>
</tr>
</tbody>
</table>
Before any modification is made to the CSPro application, all edits should first be made on the paper questionnaire to facilitate tracking of country-specific changes. The following should be considered during the questionnaire adaptation process:

- It is important to consider that adding questions to the tool will impact the data collector training, the data collection and the data analysis. Any question addition should also be considered in terms of the analysis outputs, i.e. the related indicators should be defined before adding the questions.

- The original numbering structure of the standard questionnaire should be maintained. Changes to the numbering will affect links to the existing tools for automated data processing and results production.

- If a question is added, the number assigned should be the International Organization for Standardization (ISO) 2 code followed by the country-specific question number (e.g. SL_01).

- If a question is deleted from the paper questionnaire, the question and question number must both be deleted. Do not reuse the deleted question number nor renumber subsequent questions.

The questionnaire adaptation process is discussed further in the HHFA Quick guide and the HHFA Comprehensive guide.

The following modifications are commonly made to the HHFA CSPro applications:

- adding a new question
- editing an existing question
- adding languages/translations.

The following modifications to the CSPro application are not recommended:

- deleting a question
- reordering questions
- adding a new record (this can be done under specific circumstances but requires advanced programmer knowledge).

The following section explains how to make basic edits (including the aforementioned types of modifications) to the HHFA application. For this set of modifications, which focuses on questionnaire content, all modifications will be made using the HFA.ent file located in the HFA_WHO\entry folder.

8.1 Add a new question

Country-specific questions, that are considered key for measuring service delivery in the country context, can be added to the questionnaire. A country-specific numbering system should be used for all questions added to the HHFA CSPro application. A practical and recommended way to number these country-specific questions is to use the country’s ISO 2 code. For example, SL_01: where SL corresponds to the ISO 2
code for Sierra Leone, followed by sequential numbering according to the number of questions added. A country-specific numbering system ensures that new question numbers will not duplicate any existing question numbers in the HHFA application (as this is not permitted by the CSPro application).

Adding a new question to the HHFA CSPro application requires a series of steps including:

■ add a dictionary item to the dictionary
■ add response options
■ add dictionary item to forms
■ add computer-assisted personal interviewing (CAPI) question text
■ add/adjust logic
■ copy dictionary item to combined dictionary
■ add concatenation logic in the menu system.

The following sections provide instructions for each step required to add a new question to the HHFA CSPro application.

**Add a dictionary item to the dictionary**

The CSPro dictionary contains one item for each question in the questionnaire. If adaptations have been made to the paper questionnaire, such as the addition of a question, they must also be made to the CSPro dictionary. To add an item to the HFA.ent application, take the following steps:

1. Double click on the HFA.ent file in the HFA_WHO\entry folder.
2. Look at the tree on the left side of the screen and make sure Dictionary is selected. If not, click on the dictionary tab ( ). The screen should look similar to this:
3. Decide on the record to which the new dictionary item belongs (e.g. SECT16/Section 16: Services for mental health and neurological conditions). In the tree view on the left side, all the records are visible. Click the relevant record.

4. Look at the window on the right side of the screen and make sure dictionary items are showing. If not, click on the dictionary icon on the toolbar.

5. The screen should now look similar to this:

6. The following question will be added to the HFA_DICT dictionary:

<table>
<thead>
<tr>
<th>Number</th>
<th>Question</th>
<th>Result</th>
<th>Skip</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Please tell me if this facility provides the following services for patients with mental health or neurological conditions: IF YES, ASK: For each service, when a child is eligible is the service always provided, provided sometimes, but not always or is the service not provided?</td>
<td>YES, ALWAYS</td>
<td>YES, SOMETIMES</td>
</tr>
<tr>
<td>XX_1</td>
<td>Inpatient treatment of complicated mental/ neurological conditions</td>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>

7. In the right-hand window of CSPro, right click on the dictionary item below which you want to add a new dictionary item. For this example, we want the new item to be placed between Q1606 (Any other guidelines for diagnosis and/or management of mental and/or neurological conditions available in this service site today) and Q1607 (Have you or any provider(s) of mental health services received training on diagnosis, counselling and/or treatment of mental health conditions in the past 2 years?). Hence, right click on Q1607. Select Insert item and then fill out the following fields. Use the tab key to move between columns.
8. When all fields are complete, click anywhere in the window to complete the item entry. The result should be a new dictionary item that looks like the following:
9. Go to File ➔ Save or Ctrl+S to save your work.

**Note:** Country-specific questions must be added *within existing records* in the HHFA application, for questions to be readily available in the flow control of the application when deployed to tablets. If you are an advanced CSPro programmer and feel comfortable editing the flow control syntax to allow for additional records/sections, you may do so; please see Section 8.6 (Add a new record) for instructions. Within an existing record, a new question can be added in any location of your choosing.

**Add response options**

A value set contains the numeric responses that are given to each item and are used to define ranges of valid values during data entry. These should correspond to the response options and response codes provided in the paper version of the questionnaire. To access the area where value sets can be edited in CSPro, click on the dictionary icon on the toolbar on top of the CSPro window. By clicking on the items within the records in the tree view, you will get access to the value sets, as shown below.

We are going to add a value set to the previously added dictionary item "Inpatient treatment of complicated mental/neurological conditions" – or XX_1.

1. Double click on the HFA.ent file in the HFA_WHO\entry folder (if you do not have the application open).
2. Make sure you have the dictionary view in the right part of the display of CSPro by clicking on the dictionary icon on the toolbar.
3. Expand the SECT18E/Section 18.5: Maternal, Newborn, and Child Health Services record (click on the plus sign in front of it) and click on the XX_1 item to highlight it.
4. Right click in the right window and select Add Value Set.

5. Press Enter to accept the default Value Set Label and press Enter again to accept the default for Value Set Name. The cursor will drop to the line below into the Value Label column. Remember that the Value Set Label is a descriptive text label and the Value Set Name identifies the item for use in CSPro procedures.

6. The Value Label column corresponds to the descriptive text for a single value. In the HHFA questionnaire, this is the text of a response’s options. For example, a question that has “Yes” or “No” as pre-defined response options should have “Yes” and “No” as the value labels. If the question response does not have a pre-defined answer, such as for “Number of maternity beds”, leave the value label blank. The “From” and “To” columns define the range of possible values for that question’s response. The “From” column is for the single value, or starting value of a range associated with the value label. The “To” column is for the upper limit of the range of values being defined. It must always be greater than the “From” value on the same line. Where only a single value is associated with the value Label, the “To” value may be blank.

7. For this example, we will enter: Yes, always \(\rightarrow\) 1, Yes, sometimes \(\rightarrow\) 2, and No \(\rightarrow\) 3 for the “Value Label” and “From” columns, leaving the “To” column empty. Your screen should look like the following after entering the value set.
8. Go to File ➔ Save or Ctrl+S to save your work.

**Add dictionary items to forms**

After adding a dictionary item to the dictionary, it must next be added to the form. When opening the form (click on the form icon on the toolbar), you will see that the new item is not yet added to the form. The next step is to add the item to the form.

1. Double click on the HFA.ent file in the HFA_WHO\entry folder (if you do not still have the application open).

2. Make sure that the form is visible on the right side of the CSPro window, and the dictionary in the tree view on the left. (Click on the dictionary item on the bottom left part of the screen.) In the tree view, it is easy to see which elements have not been used in the form, as they have the icon marked turquoise (see the yellow highlight below). (Use Ctrl T to toggle between names and labels in the tree.)
3. Use the mouse to drag the item on to the forms canvas and place it where you want it. It should appear in the same order as is listed in the dictionary.

- Click and drag the mouse from just above Q1606 to just below Q1607, marking the questions you want to move:

- Now you can use the mouse to drag down the highlighted items to make space for the new item.
- Place the new item between Q1606 and Q1607.
- Right click on the response box for the new item and select field properties. Click on the button next to Capture type and make sure radio button is selected. Then click ok on the open screens. The HHFA survey uses radio buttons, number pad, text boxes as the main capture types.
4. The order of the questions when the application is running is the same as the order of the items displayed in the forms tree (click on the forms tab in the lower left part of CSPro):

Hence the new item is going to be asked at the very end of this section – even if it appears to be integrated in the middle of the form in the forms view layout. To have it asked in the right order, grab it with the mouse in the tree view, and drag it up to the right place in the tree:
Add CAPI question text

Notice that the icon of XX_1 in the tree view is different from the other icons: it does not have a question mark icon like the other questions.

This is because no CAPI question is defined for this item. To add the CAPI question text:

1. Double click on the HFA.ent file in the HFA_WHO\entry folder (if you do not still have the application open).
2. Click on the CAPI question icon on the tool bar on top of the screen.
3. Make sure the XX_1 item is highlighted in the tree view, and write the question in the upper text box on the right window:

4. Go to File ➔ Save or Ctrl+S to save your work.

Some questions include only instructions in the CAPI text. Questions where the item name starts with “i” indicate this is a general section instruction (i.e. not linked to a specific question). If you need to add an i question, take the following steps:

5. Follow the general steps for adding a question to the dictionary. Ensure the item name begins with “i”.
6. Add a response option to the newly added i question. In the “From “ column write the number 1. Leave all remaining fields blank.
7. Add your question to the forms then go to the logic and paste the following code to ensure the radio button is preselected and the user can just hit the forward arrow to continue.

```java
preproc
  QuestionIsActivated();
  $=1;
```

For some questions, the instructions are different depending on whether the Core or Core+Additional version of a module is being implemented. In these cases, conditional logic can be added to the CAPI text to show different question text depending on the module being implemented. For example, in the Staffing section, Q302 has different text depending on if the Availability Core module is being implemented or the Availability Core+Additional module is being implemented. The conditional logic is added just below the CAPI window as shown in the following image.

![CAPI window showing conditional logic](image)

Clicking on each condition will toggle between the CAPI text windows so you can add the text that should display for each condition. In order to add conditions based on module, the following nomenclature is used to refer to each module:

<table>
<thead>
<tr>
<th>Module</th>
<th>Nomenclature for CAPI conditions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Availability Core</td>
<td>availCore</td>
</tr>
<tr>
<td>Availability Core+Additional</td>
<td>availAdd</td>
</tr>
<tr>
<td>Availability Additional/Supplementary – Building Infrastructure</td>
<td>availAddSup</td>
</tr>
<tr>
<td>Readiness Core</td>
<td>readCore</td>
</tr>
<tr>
<td>Quality of Care Additional/Supplementary – Record Review</td>
<td>qocAddSup</td>
</tr>
<tr>
<td>Management and Finance Core</td>
<td>mgmtCore</td>
</tr>
<tr>
<td>Management and Finance Core+Additional</td>
<td>mgmtAdd</td>
</tr>
</tbody>
</table>
Question blocks

Some questions appear grouped together into blocks. This is very important in cases where you need to group related questions into a single group. On mobile devices the block’s fields can be displayed on the same screen or each question can appear separately on its own screen. Blocks can have question text; when running the data entry application this question text will appear above the question text for each field in the block.

An example question block is shown opposite.

Click the Plus(+) button on each block to expand and see the block’s items. The block’s fields will also be highlighted in the working area.

You can right click each block to view its properties.
The block’s properties allow you to define the label and name of the block. Just like the dictionary items, the block’s name must be unique within the application. Additionally, you can set whether to show the fields on the same screen on a mobile. However, this is only encouraged for fields that are highly related; for example, dates where you must select day, month, year etc. For other data entry fields it is recommended to uncheck this text box.

Add/adjust logic

The CSPro language lets you write programming logic for your Data Entry applications. In Data Entry applications you can write logic to control and check the keying (data entry) operation as it progresses. CSPro logic consists of a collection of events defined as procedures. Each procedure performs the operations you specify using CSPro statements and functions written in the CSPro Language.

Logic has already been programmed into the CSPro application for the HHFA questionnaire. If you have made changes to the HHFA application, you may also have to make changes to the logic. These changes will be specific to the questions added or changed. Below are several examples of how to change the application logic.

User defined functions

Several functions have been written to execute tasks specific for the HHFA CSPro application. You will see these functions used in the logic of the HHFA CSPro application. It is important to have a basic understanding of what they do so that these functions are not mistakenly removed from the logic of a question where edits are being made. In addition, it may be helpful to use some of these functions when adding a country-specific question to the HHFA CSPro application.

- **QuestionIsActivated**: Checks the question mapping settings to make sure the question has been activated. If the question is deactivated, it will not be asked. This line of code should not be removed from any question in the HHFA application. If you add a country-specific question, this code is not needed as the default is for all country-specific questions to be activated.
EndSection: At the end of every record in the HHFA CSPro application is a question called “section complete”. All questions added to a record MUST be placed before this question. When programming skip patterns in the HHFA CSPro application, skip patterns cannot skip outside of a record. If a skip pattern in the paper questionnaire is designed to skip to the “section complete” question of the record. This allows the data collector to return to the flow control menu and select a new section for data collection. When editing the HHFA CSPro application, you must be careful about the placement of any additional country-specific questions and make sure there is not a question with the “EndSection” logic before the question you have added. If you do find that there is a question with “EndSection” logic before the question you have added, you will need to replace the “EndSection” with a skip to the question you have added. Similarly, If the question you add needs a skip pattern to the next section, please use the “EndSection” function to do this.

CheckpointLen: This function is used for free response/text questions in the HHFA application. For questions that require a text response, a validation check is required to ensure the field is not left blank. This function checks the number of characters in the response to a text field and checks that it meets a minimum number of characters (i.e. the text response has at least 4 characters). If there is no text or the text is less than 4 characters, the following error message will appear: “Text fields must be at least 4 characters.” The user will then be required to re-enter a response.

Skip patterns

Depending on the type(s) of question(s) you have added, you may need to add a skip pattern to the HHFA application.

For this example, we will examine logic in the data entry application for a question in the Governance section. If the facility does not have a core management team (Q505), then all questions related to core management team Q506–Q511 should be skipped. Hence the program should skip to Q512.

1. Double click on the HFA.ent file in the HFA_WHO\Entry folder.
2. Look at the tree on the left side of the screen and make sure Forms is selected. If not, click on the Forms tab.
3. Look at the window on the right side of the screen and make sure a form is showing. If not, click on the Forms icon on the toolbar.
4. Click on the logic icon on the toolbar, or select View ➔ View Logic from the main menu (or press Ctrl+L).

   ![Logic Icon]

5. Go to View menu and select Names in tree (or press Ctrl+T) to show names instead of labels in the forms tree. You can toggle between names and labels at any time to make sure that you are working with the correct items.

6. Click on Q505 in the Forms tree. The frame on the right-hand side of the screen should show “PROC Q505” at the top. Note that “PROC” is short for procedure and Q505 is the item name corresponding to the question which asks about availability of the core management team in the facility. We put our logic in the procedure for Q505 because we want it to execute after the operator keys this field.

   Preproc: The logic is executed when you move forward onto an object, before a response is entered for the question.

   Postproc: The logic is executed when you complete an object; i.e. flow off from it after a response is entered for the question.
7. Note the logic displayed:

```c
PROC Q505
preproc
  QuestionIsActivated();

postproc
  if $<>1 then
    skip to Q512;
  endif;
```

Notice the use of semicolons at the end of each logic statement. A semicolon tells CSPro that the instruction is finished. If the logic is typed in directly after the PROC statement, the default is that the logic will be applied AFTER the question is answered. If you would like the logic to be applied BEFORE a question is answered, you must type preproc after the PROC statement.

There is an additional line of code here – QuestionIsActivated(); – which checks the question mapping settings to make sure the question has been activated. If the question is deactivated, it will not be asked. This line of code should not be removed from any question in the HHFA application.

8. If you have added a question that requires a skip pattern, add the appropriate logic for the skip pattern.

9. Go to File ➔ Save or Ctrl+S to save your work.

**Error messages**

Depending on the type(s) of question(s) you have added, you may need to add an error message to the HHFA application. Error messages are programmed using logic in the same way as for skip patterns. Unique error messages are given a number and then the text for each message is added in the message window. For example:

```c
PROC Q406
preproc
  QuestionIsActivated();

postproc
  if $ > Q405 then
    errmsg(0407)
    select(maketext(0408), Q405,
          maketext(0409), $);
  endif;
```

This error message tells us that if the value entered in the field (Q406) is greater than the value entered in Q405, display error message number 407 will appear and require the respondent to correct the value in Q405 or correct the value in Q406. When in the logic view, the message window is the tab in the bottom right window, next to the Compile output window. Click on the Message tab to see the list of error messages in the HHFA application.
Add the unique number for the new error message to the Messages tab and write the text for the error message.

Compile logic

In the previous sections, logic has been entered in CSPro language. As for all procedural languages, the system must check these to make sure that there are no syntax errors. This is called “compiling”. Once all logic changes have been entered, the CSPro application must be compiled. To do this, use the following steps:

1. Click on HHFA_FF at the very top in the Forms tree to show all the CSPro logic.
2. Compile the logic by clicking on the toolbar, or select File ➔ Compile from the main menu (or press Ctrl+K).
3. If you typed the logic correctly, you will see Compile Successful in the Compiler Output under the logic.
4. If you see a dialog box that says Compile Failed, you have typed something incorrectly. A red circle will appear in the margin indicating the approximate location of the error. The Compiler Output tab at the bottom of the screen will show you an error message to help you determine the error. Check very carefully to make sure you typed in exactly what was shown in the previous tasks.
5. The screen should look like this:
Harmonized Health Facility Assessment | Data manager guide

7. Go to File ➔ Save or Ctrl+S to save your work.

Copy dictionary item to combined dictionary

The HHFA CSPro application is unique in that it allows multiple data collectors to collect data for the same facility at the same time. This is accomplished by assigning different sections of the questionnaire to different data collectors, thus allowing each of them to collect data on tablets, syncing the various data files to a single team leader tablet, and then using a concatenation function to merge the various data files into a single record per facility on the team leader tablet. The process of concatenating the data requires a combined data dictionary which has a few key differences from the HHFA dictionary and uniquely specifies the merged HHFA data file. Any changes made to the HHFA dictionary (HFA_DICT.dcf) must also be made to the HHFA combined dictionary (HFA_COMB.dcf). If you have added a question to the HFA.dcf, you will need to copy that question into the HFA_COMB.dcf using the following steps.

1. Double click on the HFA.ent file in the HFA_WHO\entry folder.
2. Look at the tree on the left side of the screen and make sure Dictionary is selected. If not, click on the dictionary tab ( ).
3. Look at the window on the right side of the screen and make sure dictionary items are showing. If not, click on the dictionary icon on the toolbar.
4. In the tree on the left, click on the record in which you have added a new question. For this example, we will click on SECT16/Section 16. Services for mental health and neurological conditions.
5. On the right side of the window, locate the question you have added, click on it to select it, and right click to select Copy (or press Ctrl+C). In this example, select item XX_1.
6. Go to the HFA_WHO\dicts folder and open the HFA_COMB.dcf file.
7. In the tree on the left, click on the record in which you want to paste the new question. In this example, click on record SECT16/Section 16. Services for mental health and neurological conditions.
8. On the right side of the window, locate the question immediately below the place where you want to add the new question, click on it to select it, and right click to select Paste (or press Ctrl+V). In this example, select item Q1607.
9. Go to File, the Save or Ctrl+S to save your work. Repeat this process for all questions added to the HHFA application.
If many changes have been made to the HHFA CSPro application and it is impractical to copy changes between dictionaries for each item, an alternative approach may be used. However, this must be done with great care.

1. Go to the HFA_WHO
dicts folder. Change the name of the HFA_COMB.dcf file to HFA_COMB_old. Copy the HFA_DICT.dcf, paste it, and change the name to HFA_COMB.dcf.

2. Open the HFA_COMB.dcf file and make the following changes:
   a. Click on the top level in the tree. Change the label to “WHO HHFA, Combined Questionnaire” and change the name to “HFA_COMB”.
   b. ID items:
      i. Move ID_TEAML and q101 from Section 1 to ID items. The order of the ID items in the HFA_COMB dictionary should be Q100, Q101, ID_TEAML.
      ii. Delete interviewer code (ID_INTERV).
   c. Interview status:
      i. Add the interview status record:
         1. The interview status record includes six variables related to the status of the data collection and duration of data collection. Copy this record from the HFA_COMB_old.dcf.
         2. Check that all six variables are present and the response options associated with these six variables have also been copied over.
   d. Section 1:
      i. Remove visit log questions (Q107–QVRES) and GPS reading (GPS_READING).
      ii. Add variable: Facility Weight (WGT).
   e. Remove Section F: HFA flow control record.

3. The required changes are now complete. Continue with the adaptation process and test out the deployment of the application. If all is successful, you can delete the HFA_COMB_old.dcf file.

Add concatenation logic in the menu system

The process of concatenating the data also requires a data concatenation function which has been programmed into the HHFA menu system. If any questions are added to the HHFA CSPro application, they need to be added to the concatenation logic in the HHFA menu system. To do this, take the following steps:

1. Double click on the HHFA_Menu.ent file in the HFA_WHO folder.
2. Look at the tree on the left side of the screen and make sure Forms is selected. If not, click on the Forms tab.
3. Look at the window on the right side of the screen and make sure a form is showing. If not, click on the Forms icon on the toolbar.
4. Click on the logic icon on the toolbar, or select View ➔ View Logic from the main menu (or press Ctrl+L).
5. Click on HHFA_MENU_FF at the very top in the Forms tree to show all the CSPro logic.
6. Click in the logic window on the right, press “Ctrl+F”, and type in “function CombinedDataMapping” to find the concatenation function. You should locate a section of logic that looks like the image below:
7. The concatenation function maps each item/question in the HFA_COMB.dcf to each item/question in the HFA_DICT.dcf. All items/questions are listed in sequential order based on the order in which they appear in the HFA_COMB.dcf dictionary. For each additional question added to the HHFA application, one line of code must be added to the concatenation function to map the corresponding HFA_DICT and HHFA_COMB dictionary items/questions. Each line of code should be inserted in the logic in the appropriate place based on the question number/the place in which the question has been inserted in the questionnaire. Remember to use the following syntax convention for adding logic to the concatenation function:

```
HFA_COMB.Q108 = HHFA_DICT.Q108;
```

8. For this example, we will add question XX_1 to the concatenation function immediately after Q1606. Your concatenation function should look like the following:

```
HFA_COMB.Q108 = HHFA_DICT.Q108;
```

9. Compile the logic by clicking \( \text{Compile} \) on the toolbar, or select File ➔ Compile from the main menu (or press Ctrl+K).
10. If you typed the logic correctly, you will see Compile Successful in the Compiler Output under the logic.

11. Go to File ➔ Save or Ctrl+S to save your work.

8.2 Edit an existing question

Recall that the HHFA resource package makes linkages between the HHFA paper questionnaire, indicators, CSPro electronic data collection application and data analysis platform, including various automated tools to facilitate the data collection and analysis process. If these tools are to be utilized, some general parameters must be followed when editing existing questions:

- **Do not change the existing question numbering**: The original numbering structure of the questionnaire should be kept. Changes to the numbering will affect links to the existing tools for automated data processing and results production.

- **Modification of response options is permitted**: Modifications can be made to the question response options in order to adapt responses to align to the country context. This is particularly relevant for questions such as facility type and managing authority categories. The HHFA questionnaire has a number of questions that require questionnaire adaptation and these have been noted in the questionnaire. Be sure to track changes so that indicators can be adapted in the analysis phase based on country-specific adaptations.

- **Minor modification of question text is permitted**: Minor modifications can be made to question text for clarification. However, question text should not be replaced entirely by a different question. It is very important to keep each question with its original numbering, therefore it is not permitted to entirely change the content of existing questions. If the intent is to change the question completely, please use the instructions for adding a question (as opposed to modifying questions).

**Modify response options**

To modify the response options of a question, take the following steps:

1. Double click on the HFA.ent file in the HFA_WHO\entry folder.
2. Make sure the dictionary view is displayed. If not, click on the dictionary item on the toolbar of CSPro.
3. Expand the record that contains the item/question for which you want to change the response options. For this example, we will add the value “9 – Don’t know” to the value set we previously created for “inpatient treatment of neurological conditions: XX_1”.
4. Right click somewhere on the value set and choose “Add value”. This will add the value at the end of the value set. If you want to place it in somewhere in the middle, right click on the item under which you want it and choose “Insert value”. Enter the text “Don’t know” in the Value label field and “9” in the From field.

   If you want to change either the label or the value of an existing value in the value set, right click on the value, and choose “Modify value”. Enter either the new label or the new value.
5. Go to File ➔ Save or Ctrl+S to save your work.
6. Click on the question for which you have edited the value set in the right window to select it and right click to select Copy (or press Ctrl+C). In this example, select item XX_1.
7. Go to the HFA_WHO\dicts folder and open the HFA_COMB.dcf file.
8. In the tree on the left, click on the record for which you want to replace the question you have edited.
In this example, click on record SECT16/Section 16. Services for mental health and neurological conditions.

9. On the right side of the window, locate the question for which you have edited the value set, click on it to select it, and right click to select delete.

10. On the right side of the window, locate the question immediately below which you want to add the newly edited question, click on it to select it, and right click to select Paste (or press Ctrl+V). In this example, select item Q1607.

11. Go to File ➔ Save or Ctrl+S to save your work.

12. Return to the HFA.ent file.

13. Look at the tree on the left side of the screen and make sure Forms is selected. If not, click on the Forms tab.

14. Look at the window on the right side of the screen and make sure a form is showing. If not, click on the Forms icon on the toolbar.

15. Click on the logic icon on the toolbar or select View ➔ View Logic from the main menu (or press Ctrl+L).

16. Click on the question for which you have edited the response options in the Forms tree. Review the logic for this item/question and make any adjustments required to account for the changes to the response options.

17. Search the logic to determine if the item/question for which you have edited the response options is referenced anywhere else. If found, review the logic and make any adjustments required to account for the changes to the response options.

18. Go to File ➔ Save or Ctrl+S to save your work.

---

**Additional notes on changing value sets**

Value sets can be copied and pasted if the same response options apply to multiple questions. To copy a value set, right click on the value set in the right side of the screen and select Copy. (Note: You can copy several value sets by highlighting them prior to copying them.) Then click on the item in the left side of the window where you would like to paste the value set. In the window on the right side, right click and select Paste.

For some value sets, the length of the response may change. If the number of digits in the response changes, the length field of that item must be adjusted in the dictionary.

For a question in which the response is numeric, such as “Number of allocated generalist physicians”, the Value label can be left blank, and the “From” and “To” columns should contain the minimum and maximum response values, in this case 0–250.

---

**Modify question text**

To modify question text, take the following steps:

1. Double click on the HFA.ent file in the HFA_WHO\entry folder (if it is not still open).
2. Click on the CAPI question icon on the tool bar on top of the screen.
3. Make sure the item/question for which you want to edit the question text is highlighted in the tree view. Edit the question in the upper text box on the right window.
4. Go to File ➔ Save or Ctrl+S to save your work.

8.3 Add language and translations

CSPro supports the creation of applications that target multiple languages. The HHFA CSPro application is currently programmed in English. However, the official United Nations (UN) languages (Arabic, Chinese, French, Russian and Spanish) have been added to the language menu to facilitate adding these language translations to the HHFA CSPro application. Other languages can be added as described below. Adding translations requires adding translated text for response options, question text and error messages. To do this, take the following steps.

Response options

To add translations for response options:

1. Go to the HFA_WHO\entry folder and double click to open HFA.ent.
2. Make sure you are in dictionary view. Open the tree on the left and click on the question for which you want to add translated response options.
3. On the Menu bar, there is a dropdown box with a list of languages. Select the language you want to use for your translated text. For this example, we will select French.

4. In the response options, write the translated text over the English text. If you toggle between languages in the menu, both languages should now appear for the response options.

5. If you want the translated response option value sets to export with the final data set, the translated value labels must be copied into the combined dictionary. Refer to the above section on how to copy dictionary edits to the combined dictionary for instructions.
CAPI question text

To add translations for CAPI question text:

1. Go to the HFA_WHO\entry folder and double click to open HFA.ent.
2. Make sure you are in forms view. Click on the CAPI question icon on the tool bar on top of the screen.
3. On the Menu bar, there is a dropdown box with a list of languages. Select the language you want to use for your translated text. For this example, we will select French.
4. Using the tree on the left, navigate to the question for which you want to add translated question text. In the lower CAPI window, there is a dropdown box with a list of languages. Select the language you want to use for your translated text. For this example, we will select French.
5. Type the translated text in the lower CAPI window where the language you selected is displayed.

If you have translated text for many questions, there is an option to bulk copy the question text using the following steps:

6. Create an Excel sheet with three columns:
   a. Question number: Enter the question numbers of the questions for which you want to add translated text. You must use the CSPro question numbers (item names). To get a list of the CSPro question numbers, go to the dictionary view, right click on the highest level (HHFA_DICT) and select Dictionary Macros. Under Dictionary Names and Labels select Copy All. Open an Excel sheet and paste. Column O should be a complete list of all questions in the HHFA CSPro application.
   b. Language: Enter the two-digit code that corresponds to the language of the translated text to be added. The two-digit codes for the pre-specified UN languages are:
8. Modifying the HHFA application

c. **Question text:** Enter the translated text for each question.

![Excel sheet](image)

7. Highlight the three columns of your Excel sheet except for the header row and copy the text.

8. Go to the HFA_WHO\entry folder and double click to open HFA.ent.

9. Make sure you are in forms view. Click on the CAPI question icon on the tool bar on top of the screen.

10. Using the tree on the left, navigate to a question for which you want to add translated question text. Right click on a question and select question text macro. The following box will appear:

![Question Text Macros](image)

11. Click on Paste from Clipboard. All question text should now be in the CAPI lower window of the application.

**Message file (.mgf) translations**

In addition to question text language translations, error messages and menu options translations should also be added. These are provided in the message file with extension ".mgf". Translations should be added to the following message files:
1. To add translations to the message file, open the message file with a text editor of your choice (e.g. Notepad++).

   Each error message translation has a corresponding error message number that is referenced with the application logic.

   ```
   if datediff(hfa_start_date, sysdate("YYYYMMDD")) < 0 then
       errmsg(0024);
       stop(1);
   elseif datediff(hfa_end_date, sysdate("YYYYMMDD")) > 0 then
       errmsg(0025);
       stop(1);
   endif;
   ```

   ```
   errmsg(0024) will call error message "The survey date cannot be before the scheduled HHFA start date" in the message file.
   ```

2. To provide French translations, for example, copy all the error messages in the message files and paste them under the Language=FR tagline.

3. For each message number provide the corresponding language translation.

4. Repeat the process for HHFA_Menu.ent.mgf and HFA_Assignment.mgf files.
Add a non-UN language

To add a non-UN language to the HHFA CSPro application, take the following steps:

1. Go to the HFA_WHO\entry folder and double click to open HFA.ent.
2. Make sure you are in dictionary view. From the menu bar select Edit → Languages. The following set of options will appear:

   ![Languages window](image)

3. Click on Add. Give your language a two-letter name and then a full label. Then click on OK.
4. Go to Forms view. From the menu bar select CAPI, then CAPI languages. The following set of options will appear:

   ![Languages window](image)

5. Click on Add. Give your language the same two-letter name and full label as in the dictionary. Then click on OK.
6. You can now use the steps above to add translations in your user specified language to the HHFA CSPro application.
7. Now you need to add the language to the setup menu. Browse to the HFA_WHO\dicts folder and open the chFA_setup.dcf file. Navigate to the dictionary view. Open the CHFA_CC_REC record in the tree on the left. Click on the Survey language (SURVEY_LANG) item in the tree on the left.
8. Right click on the value label on the right window and add the name of your language. Add the two-letter language code in the From column.
8.4 Delete a question

It is not recommended to delete any items/questions from the HHFA application. Deleting a question can cause code blocks or failure of the program, as this also requires removing all references to that question throughout the HHFA logic.

As an alternative approach to deleting questions from the HHFA CSPro application, use the configuration menu to activate/deactivate questions. Activating/deactivating is used to help minimize the amount of effort required when you want to delete questions from the data entry forms, as the process of permanently deleting a question from the form requires adjusting/removing the associated syntax logic. However, with the activate/deactivate concept, you do not need to worry about the logic behind the questions. The program will check the status of each question and automatically readjust the skips.

Please think carefully about deactivating individual questions after module selection. Each question corresponds to a particular indicator and deactivating a question will affect the measurement of a given indicator and the analysis of results from the survey. Please be aware of this when deciding to deactivate a question.

**Note:** If you turn off all questions for a section, the section will be removed from the assignments list automatically. If you deactivate all core and additional questions in an HHFA section, but then add country-specific country questions, those country-specific questions will not be included in the survey as the entire section will not show up in the assignments list. There must be at least one core or additional HHFA question activated for a section to appear in the assignments list.

8.5 Reorder questions

It is not recommended to reorder the existing HHFA questions in the HHFA CSPro application. Reordering questions will require extensive work to check that all skip patterns have been adjusted to conform to the new question sequence. This may prove difficult and is prone to error given the scope and complexity of the HHFA questionnaire.

8.6 Add a new record

It is not recommended to add new records to the HHFA CSPro dictionary as the number of records is directly linked to the flow control of the application when deployed to tablets. However, there are a few circumstances in which it may be necessary to add a new record. For example, if a country has developed a set of questions related to a service not included in the HHFA questionnaire (e.g. dental care, eye care, additional service-specific record reviews). If this applies to your context and an advanced CSPro programmer is available to edit the flow control syntax to allow for additional records/sections, take the following steps:

1. Double click on the HFA.ent file in the HFA_WHO\entry folder.
2. In the dictionary view, click on the HHFA_level record.
3. Right click and select add or insert a record. Give the record a label (i.e. Section xx: service) and a unique name based on the section number (i.e. SECT15A). The type value can be any number. Set the required column to “No” and the Max to 1.
4. Go to the new record in the dictionary and add the corresponding questions and response options.

5. Go to the forms view. Right click on any form and select add form. Assign a label for the record that describes the section covered by the record (i.e. Section 15A: Service X). Assign a name to the record which references the section number. The name must include “_FORM” at the end of the name (i.e. SECT15A_FORM). Then click ok.

6. Drag the questions you have added onto the newly created form. Add CAPI text and logic as needed. Move the form into the correct order. The new form must be placed before the ENDINTRV record. Save your work.

7. Add the newly added questions to the combined dictionary and to the concatenation program (see section 8.1 for detailed instructions).

8. Double click on the HFA_Assignment.ent file in the HFA_WHO\prep folder.

9. In the dictionary view, click on ASSIGNMENTS_REC and then SECT_NUMBER. Right click and select add value. Record a value label that describes the new section and a From value that is sequential for the new section. The value label recorded here will be the name of the section in the flow control form. You must add the new section to the bottom of the list.

10. Go to the forms view, and open the logic. Click on ASSIGNMENTS_REC_FORM -> ASSIGNMENT_BLOCK -> ASSIGN_IN. In line 11, change the logic from:

```plaintext
if j=1 then
   SECT_FIELDED(1) = 1;
 
```

to

```plaintext
if j in 1,51 then
   SECT_FIELDED(j) = 1;
```

where 51 is the number of the new section and 1 is replaced with j.

11. Click on the top of the tree (HFA_ASSIGNMENT_FF) to access the global logic section. Go to line 105 and add an additional line of code for each section added, making sure to update the Checksection number and soccurs label to match the section(s) you have added:

```plaintext
elseif Checksection=51 & soccurs(SECT15A) then CheckIfCollected=1;
```

12. Save your work and test the application to ensure the new record has been added.
9. Preparing and deploying the HHFA application

9.1 Prepare to deploy the HHFA application

When preparing to deploy the HHFA application, three main checks are needed:

- checking the settings;
- setting the data connection method and application name; and
- compiling the logic.

Check the settings

1. Open the HHFA_Menu.ent file.
2. Make sure the Forms tab is active. On the Menu toolbar, select Options ➔ Data entry.
3. Ensure the options below are selected:

![Data Entry Options](image)

4. Save your application if any changes are made.

Set the data connection method and application name

The data connection method is a variable that helps to differentiate between testing, training, pilot or main data collection data. When deploying the HHFA application it is important that you set the correct data connection method. The values for this variable are as follows:

1 = Main data collection
2 = Pilot
3 = Training
4 = Testing.
1. Open the HHFA_Menu.ent file.

2. Click on the logic icon on the toolbar, or select View ➔ View Logic from the main menu (or press Ctrl+L).

3. Navigate to the top of the syntax file and locate the variable named: In_SetDataConnection as shown below:

   ```
   numeric In_SetDataConnection=4; {Main Data collection =1 Pilot=2 Training=3 Testing=4 }
   string WHO_HHFA="Testing (WHO HHFA 2022)"; // “WHO HHFA”;
   ```

   Modify the value of the variable to reflect the type of deployment you would like to make, e.g. for training you set the value to 3 (In_SetDataConnection=3).

4. Modify the string WHO_HHFA to reflect the name of deployment, e.g.

   ```
   string WHO_HHFA="Training (Country Name HHFA 2023)";
   ```

5. When deploying for the main data collection, uncomment the following lines of code which will delete training and test data. The default is to keep all pilot and main data collection data:

   ```
   {++++++++++++To remove the training/test data ++++++}
   // Should be activated before main data collection

   { if STAFF_ROLE in 2:4 then
     forcase HFA_ASSIGNMENTS where HFA_ASSIGNMENTS.SETDATACTION in 4,3,notappl,default do
     delcase(HFA_ASSIGNMENTS);
     enddo;
     forcase HHFA_DICT where HHFA_DICT.SETDATACTION in 4,3,notappl,default do
     delcase(HHFA_DICT);
     enddo;
     forcase HFA_COMB where HFA_COMB.SETDATACTION in
     delcase(HFA_COMB);
     enddo;
   endif;
   }
   {+++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++++

6. If you would like to keep only main data collection data (i.e. delete the pilot data in addition to test and training data), replace the code above with the below code and uncomment the code:

   ```
   {+++++++++++To remove the training/test/pilot data ++++++++}
   // Should be activated before main data collection

   { if STAFF_ROLE in 2:4 then
     forcase HFA_ASSIGNMENTS where HFA_ASSIGNMENTS.SETDATACTION in 4,3,2,notappl,default do
     delcase(HFA_ASSIGNMENTS);
     enddo;
     forcase HHFA_DICT where HHFA_DICT.SETDATACTION in 4,3,2,notappl,default do
     delcase(HHFA_DICT);
     enddo;
     forcase HFA_COMB where HFA_COMB.SETDATACTION in
     delcase(HFA_COMB);
     enddo;
   endif;
   }
   ```
When this code is activated, the data from the tablet will be cleared when the application is downloaded on a tablet. In addition, when a tablet with data that have been cleared is resynced to the server, any previously collected data will be marked as a deleted case. Therefore, it is not necessary to clear the server once training is complete if this approach is used.

7. Save the file after making the changes.

**Compile the logic**

When CSPro compiles your logic, it checks the logic you have written to see if there are any errors or warnings.

1. Open the HHFA_Menu.ent file.
2. Click on the logic icon on the toolbar, or select View ➔ View Logic from the main menu (or press Ctrl+L).
3. To compile the entire application, select the topmost entry of the data entry tree on the left side of the screen. The window should now look like this:

![Compilation window](image)

4. Compile the logic by clicking on the toolbar, or select File ➔ Compile from the main menu (or press Ctrl+K).

**Note:** Compiling the logic may take a long time (e.g. 10 to 30 minutes, depending on your computer). Please give the application time to do this compilation as there is a lot of complex logic within the application that needs to be checked during the compile.
5. The Compiler Output window under the logic will provide a message with the results: either “Compile Successful” or “Compile Failed”. If the compile is successful, you are now ready to deploy the HHFA application. If the compile fails, review the error messages to find the error, correct the error messages and repeat the logic compilation process until you get a “Compile Successful” message.

9.2 Deploy the HHFA application

The HHFA application can be deployed on Dropbox or CSWeb using the CSPro Deploy Application. An example deployment script has been prepared for the HHFA application. This script contains all the file configurations required to deploy the HHFA CSPro application. Separate scripts have been prepared for both Dropbox and CSWeb configurations. Take the following steps to deploy the HHFA application using the prepared script:

1. In the HFA_WHO\deploy folder, open the deploy script. Select either hhfa_csweb.csds if you are using CSWeb or hhfa_dropbox.csds if you are using Dropbox.

![Deploy Script Image]

2. Edit the following parameters in the deploy script:

   a. Package name: Country_ HHFA (e.g. GHANA_HHFA).
   b. Description: This is what data collectors will see on the tablet as the application name (e.g. Ghana HHFA 2022).
   c. Files: The default structure of the files is what is required to generate a .pen file which is the mobile version of the application. There is no need to edit the file structure (even if you have made edits to these files within your application). The required files include:

      - Entry
        - HFA.ent
        - HFA.pff
        - HHFA_Menu.ent
        - HHFA_Menu.pff
Prep

- HFA_assign.html
- HFA_Assignment.ent
- HFA_Assignment.pff
- JSON.apc

Ref

- HFA_Facilities.csdb
- HFA_setup.csdb
- HFA_Staff.csdb

Reports (folder and all files).

d. Dictionaries to upload for synchronization: The selected dictionaries are those that correspond to data that are being collected. There is no need to edit the selection of dictionaries as the default is to select the three required dictionaries which include:
  - HHFA_DICT (Individual dictionary)
  - HFA_COMB (Combined Dictionary)
  - HFA_Assignments (Assignments dictionary).

e. Deploy to:
  - CSWeb – indicate the specific URL for your server that you previously configured.
  - Dropbox – you will be prompted to enter the username and password when you deploy.

3. Click Deploy:

   a. For initial deployment on CSWeb, you will be prompted for your username and password.

   ![Login dialog]

   It is recommended to use a standard user account created in the section: Setup CSWeb. For subsequent deployments the credentials will be saved in the CSPro cache, hence you will not be prompted for username/password again, unless you clear the credentials in the settings.

   b. When deploying to Dropbox, it will open up a browser page prompting you to link Dropbox to CSPro. If there is an existing Dropbox account logged into the browser, it will be indicated at the top right. Click on the avatar icon to check the logged in account or sign out.

   c. When you click deploy, if the program compiles correctly, it will be deployed and you will get a message that the program has been successfully deployed. If there is an error compiling the program, it will inform you of the error and the program will not be deployed.

   ![Application deployed successfully dialog]
4. Save Deployment script so that configurations are saved for future deployments:
   a. File ➔ Save.

5. To check that your application has deployed:
   a. CSWeb: log in to CSWeb and see latest deployment time.

   ![CSWeb screenshot](image)

   b. Dropbox: check the CSPro/apps folder to see the date/time of the application upload.

   ![Dropbox screenshot](image)

   c. Tablet interface: the update feature will say if there is an update available.

6. Note on Dropbox credentials: You may want to change the Dropbox account to which you are deploying. To do this, you need to clear the Dropbox credentials associated with CSPro: open CSPro 7.7. Go to File ➔ CSPro settings. Click “Clear Credentials” to remove the saved Dropbox passwords.

7. Create QR code:
   a. Click on the QR code icon in the Deploy application.
   b. For CSWeb, click on the box to include the username and password and complete the fields. If you include the username and password, when the QR code is scanned, the application will immediately be installed and there will not be a requirement to type in the username and password for each installation.

   **Note:** This feature of embedding the username and password is not available if using the Dropbox sync functionality.

   c. Click Save, give the QR code a name (e.g. ISO_HHFA_QRcode.bmp) and save to a location of your choice that will be easily accessible for tablet installation (e.g. you can save this to the HFA_QHODeploy folder). You should now have created an image file that looks like the following:
10. Configuring tablets

10.1 Configure tablets

Basic configurations

All tablets need to be configured before they can be used for data collection in the field. The following are the recommended tablet configuration steps:

1. From the Google Play store, download CSEntry and Android Device ID and install on each tablet.
2. Hide all apps except:
   - GPS
   - CSEntry
   - Device ID
   - Settings.
3. Use App Lock to lock all other apps. (Make sure the four apps we will be using are NOT locked.)
4. Check that the date and time are set correctly; reset if incorrect.
5. Check the icons in the top ribbon:
   - GPS – ON
   - WiFi – ON
   - Screen rotate – ON
   - Power save – ON
   - Sound – OFF/MUTE.

Disable automatic updates from CSPro

Before sending data collectors into the field, consider what would happen if CSEntry automatically updated during the survey. If you developed a CSPro application for a previous version or the current version of CSEntry, you may not want the next update. Fortunately, it is simple to disable automatic updates for CSEntry or all apps on Android. Before data collectors are sent into the field to begin the survey, it is recommended that automatic updates are disabled for CSEntry on their Android devices, to avoid potential software problems.

To disable automatic updates for CSEntry, take the following steps:

1. Open the Google Play Store.
2. Tap Menu then My apps & games.
3. Select CSEntry.
4. Tap More.
5. Uncheck the box next to Auto-update.

To disable automatic updates for all apps, take the following steps:
1. Open the Google Play Store.
2. Tap Menu then Settings.
3. Tap Auto-update apps.
4. Select Do not auto-update apps.

To update apps manually, take the following steps:

1. Open the Google Play Store.
2. Tap Menu then My apps & games.
3. Apps with an update available are labelled Update.
4. Tap Update All to update all apps. For individual apps, find the specific app you want to update and tap Update.
   Tip: In some cases, you may need to restart your device to update an app.

10.2 Install the HHFA CSPro application

Installation of the HHFA CSPro application on a tablet requires:

- Android-enabled device with Android OS 4.0 and above
- active internet connection
- CSEntry application installed from the Google Play Store.

To install the HHFA CSPro application, take the following steps:

1. Open the CSEntry app on the tablet.
2. Select the three menu dots at the top right and then select Add application.
3. Select QR code as the location from which to download the application.
4. Scan the QR code previously generated in the deploy step.

Once you have scanned the QR code you may be prompted for a username and password if using the Dropbox sync option – please enter this information. For CSWeb, the username and password are generally integrated into the QR code so it can automatically load the questionnaire.

Upon installation, the HHFA application will be listed in the Entry Application screen.
If you need to change the Dropbox account associated with a tablet, take the following steps:

1. Press the Menu icon (vertical ellipses) on the Entry Applications screen of CSEntry.
2. Press Settings.

### 10.3 Configure handheld GPS devices (if in use)

If handheld GPS devices will be used, each device must be configured to ensure a standard approach to measuring GPS coordinates. This includes the following parameters:

- Both coordinate system (latitude-longitude) and the data must be set for all devices. WGS84 should be the default datum.
- These are the settings for the GPS tool within the CSPro application and so they will be comparable between handheld devices and tablets.

- POSITION FRMT: hddd.dddd
- MAP DATUM: wgs 84
- UNITS: metric
- NORTH REF: magnetic
- VARIANCE: 004.E
- ANGLE: degree
PART 2: TRAINING

Data managers are responsible for several tasks related to preparing for training of survey staff, training of survey staff, distribution of tablets, the data collection pilot exercise (field practice day of the data collection training workshop), and making final updates to the CSPro application after the pilot, if necessary.

11. Preparing for training

11.1 Training of Trainers course on CSPro

Data managers are responsible for knowing how the HHFA CSPro data collection system works. A training of trainers course is available through the OpenWHO platform (https://openwho.org/courses/HHFA-data-collection-tot) which provides the foundational information on the HHFA. Data managers should thoroughly learn the content in Module 4: Data collection in CSPro, which includes the following units:

- Unit 1: CSPro application basics
- Unit 2: User roles
- Unit 3: Data collection process: Before arrival at the facility
- Unit 4: Data collection process: At the facility
- Unit 5: Data collection process: At the end of the day
- Unit 6: Supervisor validations
- Unit 7: Tracking progress towards survey completion.

11.2 Review and adapt training materials

Data managers are responsible for facilitating the CSPro-related sections of the data collection training workshop for data collection teams. Presentations have been developed to support these trainings, but it is the responsibility of the data manager to:

- Become very familiar with the HHFA CSPro data collection system so that they feel confident to train others in the use of the system on tablets for data collection.
- Review the presentations and exercises, make necessary country-specific adaptations, and be prepared to facilitate the CSPro training sessions.

The CSPro-related presentations include the following content:

- Session 8: Introduction to CSPro
- Session 11: CSPro Data collection process: Before arrival at the facility
- Session 15: CSPro Data collection process: At the facility
- Session 20: CSPro Data collection process: At the end of the day
- Session 24: CSPro practice. Tool pre-testing (PPT)
- Session 30: Simulation exercise. At the service site entering data (PPT)
- Session 31: CSPro for supervisors.
**11.3 Manage distribution of tablets**

The data manager is responsible for managing the distribution of all tablets and maintaining a record of the individuals that received tablets, the number of tablets in each administrative area, and any notes reported on the status of the data collection. This is important for ensuring that all devices are returned and also for troubleshooting potential data management issues later in the data processing phase. If any data are missing, it will be critical to know if all tablets were returned and all data synced.

Tablets are distributed to data collectors during the data collector training workshop for practice in the classroom setting and for use in the pilot exercise in local health facilities.

It is recommended that all tablets be returned to the data manager after the pilot exercise to ensure that the updated/final version of the application is loaded onto all the tablets before they are distributed to the data collectors for official data collection in the field. Recall from Section 9.1 the need to set the data connection method before the main data collection begins so as to differentiate test data from official data in the dataset.

**11.4 Deploy HHFA application for training and pilot test**

The data manager is responsible for ensuring the HHFA CSPro application has been fully configured and deployed and can be used for both training and the pilot test at selected health facilities. This includes uploading a staff listing file which includes all training participants appropriately grouped into teams and uploading a facility file which includes the facilities to be visited for the pilot test. It is strongly recommended that efforts are made to assign participants staff roles that they will have during data collection (i.e. team leader vs data collector) so that they get appropriate practice executing the functions they are expected to complete in the field.

Do not underestimate the amount of time and advance preparation it takes to coordinate with the survey manager to ensure this level of logistics planning has been completed in advance of the training. It is important to allow sufficient time for this step in the HHFA process.
12. Facilitating training of data collectors, team leaders and supervisors

During the training of the data collection teams, the data manager is responsible for facilitating the training of data collectors and team leaders on the use of CSPro. In addition, the data manager is responsible for facilitating the training of supervisors in the use of CSPro for conducting data validation visits. Standard HHFA training materials, including a training agenda, facilitator’s guide, PowerPoint presentations, exercises and other tools, are available through the OpenWHO course site (https://openwho.org/courses/HHFA-data-collection-tot/items/2G9gALGjjar0aR4mlpMgD).

As the data manager is responsible for being the on-site expert for the HHFA CSPro data collection system, this chapter will review the content that the data manager is responsible for mastering and for providing training on during the training of data collectors, team leaders and supervisors. The key topics covered include:

- CSEntry basics
- HHFA CSPro application user roles
- HHFA CSPro data collection process
- HHFA CSPro for supervisors.

There are seven presentations for training of data collectors that accompany the content described in this chapter:

- Session 8: Introduction to CSPro
- Session 11: CSPro Data collection process: Before arrival at the facility
- Session 15: CSPro Data collection process: At the facility
- Session 20: CSPro Data collection process: At the end of the day
- Session 24. CSPro practice. Tool pre-testing (PPT)
- Session 30. Simulation exercise. At the service site entering data (PPT)
- Session 31: CSPro for supervisors.

12.1 CSEntry basics

Starting CSPro

To start CSPro, click on the CSEntry icon on your tablet. This will take you to the Entry applications screen.

Entry applications screen

Upon opening CSEntry, all data entry applications on the device are displayed. Click on an application to open it. If only one application is on the device, it will open automatically.

For the HHFA application, the displayed name reflects the application’s name set prior to deployment.
Login screen

When you open the HHFA application from the entry applications list, you arrive at the Login screen which contains the following information:

1. Survey country name and year of survey.
2. Application publish date and time; this is used to ensure the user is running the most recent version of the application.
3. The user who has pre-registered the device. If no user has registered the device, this text display will be blank.
4. Each user should be provided with a login code that enables them to access the application and perform different functions. Enter your login code to access the main menu.

Screen elements

The screen elements in CSEntry are the following:

1. Name of the survey.
2. Clicking on this bar menu icon displays user defined functions (partial save, advance to end).
3. Clicking on the pencil and paper icon displays a screen to type a field-specific note.
4. Clicking on the search icon and typing in a query allows you to filter the response listing.
5. The field label is a short description of the field that you are currently entering; for the HHFA it is the question number.
6. This is the question text for the field that you are currently entering.
7. These are the response options.
8. These are the left- and right-hand navigation buttons, which correspond to moving forwards or backwards in the data entry application.

User input types

There are several user input types that are utilized by the HHFA CSPro application:

- **Radio button**: When presented with a list of radio buttons, you must select **only one** response. Click on the response label or the corresponding radio button to enter your selection.
- **Check box**: When shown check boxes, you can select none, one, or multiple responses. Click on the response label, or the corresponding check box, to make a selection. Once you are finished making all selections, you can proceed to the next field.
- **Combo box**: A combo box is used when a question requires a numeric response, but pre-coded responses have been provided for options such as “None” or “Don’t know”. Click on the filter to the right of the numeric response box to see the radio button type responses and select one. A numeric response will be populated in the field based on your selection (e.g. Don’t know = 98).
### Numeric
A numeric field allows for a response that is a number only. Often a range will be set so that only valid numeric responses can be submitted (e.g. the number of days per week must be a number from 0 to 7).

### Text box
To enter data in a text box field, simply type the response using the keyboard. If a keyboard does not automatically appear, click on the field and a keyboard will appear.

### Additional features

#### Search box
After clicking on the search icon, a space will appear where you can type a search query. The list of responses will automatically filter based on your search query. The full text of each response is searched, but not necessarily starting from the first letter of the response.

### 12.2 HHFA CSPro application user roles

There are three main user roles within the HHFA CSPro system related to data collection:

- area supervisor
- team leader
- data collector.

A fourth user role, data manager, exists within the HHFA CSPro system. Data managers are responsible for configuring the HHFA CSPro application for country implementation, deploying the application, and data management during data collection. These functions are covered throughout this guide. The next section will review the main functionalities for each user role with respect to data collection.

### Area supervisors – what can they do?

- select facility sections for validation
- validate facility data
- sync validation data
- download all data
- view reports
- update application
- reset device registration.
Area supervisors have two main tasks to complete using tablets:

- collect data for supervisor validations;
- generate reports to assess survey completeness for ALL data.

To complete these two tasks, area supervisors have been given functionality to assign themselves questionnaire sections for the facilities they will visit for the 10% validation revisits, collect data at those visits, and sync data to the central database (either Dropbox or CSWeb).

They also have the ability to download all the data collected thus far from the central database to generate reports which provide information on progress towards completion of the survey. This does not let them view individual facility responses and they cannot edit the data and send them back, but they can review the reports and see the progress of the data collection teams.

**Team leaders – what can they do?**

- assign facility sections for data collection
- transfer assignments to data collectors
- collect data
- receive data from data collectors
- create complete data record
- sync data
- view reports
- update application
- transfer application files to data collector
- reset device registration.

Team leaders play a central role in managing data collection in the field. They are responsible for assigning sections of the HHFA questionnaire to data collectors for each facility visited and have a responsibility to ensure data have been collected for all sections of the HHFA questionnaire. The reporting functionality assists team leaders in tracking progress towards completion for individual facilities as well as across the facilities assigned to them.

**Data collectors – what can they do?**

- receive section assignments
- collect data
- send data to team leader
- sync data for backup
- view reports
- update application
- receive application files from team leader
- reset device registration.
Data collectors are responsible for collecting data for the sections of the questionnaire assigned to them at each facility they visit. The reporting functionality assists data collectors in tracking progress towards completion of assigned sections. In addition, data collectors are responsible for sending their data to the team leader as well as syncing data for backup.

When logging into the HHFA CSPro application, the staff code used (as specified in the staff lookup file) will determine the set of functionalities available to the user.

### 12.3 HHFA CSPro data collection process

Table 4 outlines the steps in the data collection process, the staff responsible for each step, and when each step should take place. The following sections discuss how each of these steps is accomplished with the HHFA CSPro application using tablets.

**Table 4. Data collection process steps**

<table>
<thead>
<tr>
<th>No.</th>
<th>Who?</th>
<th>What?</th>
<th>When?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Team leader</td>
<td>Assign sections for data collection</td>
<td>Before arrival at facility/At facility</td>
</tr>
<tr>
<td>2</td>
<td>Team leader</td>
<td>Transfer assignments to data collectors</td>
<td>Before arrival at facility/At facility</td>
</tr>
<tr>
<td>3</td>
<td>Data collector</td>
<td>Receive assignments</td>
<td>Before arrival at facility/At facility</td>
</tr>
<tr>
<td>4</td>
<td>Data collector</td>
<td>Collect data</td>
<td>At facility</td>
</tr>
<tr>
<td>5</td>
<td>Data collector</td>
<td>View reports</td>
<td>At facility</td>
</tr>
<tr>
<td>6</td>
<td>Data collector</td>
<td>Update application and/or receive application updates from team leader</td>
<td>As needed</td>
</tr>
<tr>
<td>7</td>
<td>Data collector</td>
<td>Send data to team leader</td>
<td>End of the day</td>
</tr>
<tr>
<td>8</td>
<td>Data collector</td>
<td>Sync data for backup</td>
<td>End of the day</td>
</tr>
<tr>
<td>9</td>
<td>Team leader</td>
<td>Receive data from data collectors</td>
<td>End of the day/After completion of each facility</td>
</tr>
<tr>
<td>10</td>
<td>Team leader</td>
<td>Create complete record</td>
<td>End of the day/After completion of each facility</td>
</tr>
<tr>
<td>11</td>
<td>Team leader</td>
<td>View reports</td>
<td>End of the day</td>
</tr>
<tr>
<td>12</td>
<td>Team leader</td>
<td>Sync data</td>
<td>End of the day</td>
</tr>
<tr>
<td>13</td>
<td>Team leader</td>
<td>Update application and/or send application updates to data collector</td>
<td>As needed</td>
</tr>
<tr>
<td>14</td>
<td>Team leader</td>
<td>Reset device registration for data collectors on their team</td>
<td>As needed</td>
</tr>
<tr>
<td>15</td>
<td>Supervisor</td>
<td>Reset device registration for team leaders or data collectors on their team</td>
<td>As needed</td>
</tr>
<tr>
<td>16</td>
<td>Data manager</td>
<td>Reset device registration for supervisors, team leaders, or data collectors</td>
<td>As needed</td>
</tr>
</tbody>
</table>
Assign sections for data collection

Depending on the modules selected and the level of the health facility visited, completion of the HHFA survey tool can be very long and time consuming. To improve the efficiency of data collection, the different sections of the questionnaire can be distributed among multiple data collectors. Data collection can then occur simultaneously. In addition, data collectors have flexibility in the order in which sections of the questionnaire are completed. However, some parameters must be respected for smooth implementation of this process:

- A single team is in charge of collecting data in a specific health facility.
- A specific section can only be assigned to one data collector.
- Before data collection can commence in a facility, ALL sections within the HHFA questionnaire must be assigned to data collectors irrespective of whether the service is offered or not.
- Section assignments should be made prior to visiting the facility or at the facility before approaching the in-charge to start data collection. The team leader should check that the assignments have been made correctly before sharing the assignments with data collectors.
- If the team leader chooses to reassign sections for a facility, they should:
  - Receive the data from all the data collectors, if data collection has commenced.
  - Share the updated assignments with all the data collectors before data collection commences.
- Once data collection in a facility has commenced, the team leader is advised AGAINST REASSIGNING sections within the facility.
- Sections for which the data collection has already started CANNOT be reassigned.
- The section assignments can be shared via Bluetooth if the team leader and data collectors are within close proximity or via the internet if they are far apart geographically.
- It is important to ensure that data collection teams are well trained and understand the importance of selecting the correct facility name when selecting the facility for which they will be collecting data. Some facilities may have similar names and incorrect facility selection can create the appearance of duplicates in the data set. This can be time consuming and difficult to resolve during the data processing stage.

The team leader is responsible for assigning sections to data collectors for each facility. Section assignments should be completed before arrival at the facility. To assign sections on the tablet, take the following steps:

1. The team leader decides how to distribute the survey sections/service areas amongst their team members.
2. The team leader logs in to CSPro and selects the facility for which they want to make assignments. Team leaders assign sections for the facility to the data collectors on their team.

- Once the facility has been opened for section assignments, the user will be presented with various screens where they can assign sections to the data collectors. The application will loop through all the relevant sections. All sections must be assigned, regardless of whether the facility offers the service or not.

- First the team leader will select Assign facility sections for data collection. Then they will select the facility administrative location (region and district). A list of facilities will be shown that is filtered based on the region and district selected. The team leader selects the facility which will be visited for data collection and confirms their selection.

- The sections to be assigned should be selected by ticking the corresponding box on the left, clicking on Assign selected in the menu bar, and selecting a user to assign the selected sections. After selecting Assign selected, the list of team members who have been assigned various sections will appear and assigned sections will be shown in green background colour. Continue assigning sections until all sections have been assigned to team members. The team leader can also assign themselves sections for data collection.
3. The team leader confirms assignments.

- When all assignments are complete, select Exit and Done with assignment. A report is generated showing how the sections have been assigned. The assignments can be confirmed or, if needed, changed. The team leader should select “Yes, proceed” if the sections were assigned correctly and to continue to the main menu. The “No, reassign” option will loop through the assignments again and allow the team leader to make and required changes.

Transfer assignments to data collectors

There are two options for syncing HHFA data: Bluetooth and the internet. Each approach has different requirements and may be useful in different contexts. Transferring data using Bluetooth requires both team
leader and data collector to be in close proximity and both team leader and data collector actions must be done simultaneously. It does not require an internet connection. Transferring data using the internet requires an active internet connection. However, the team leader and data collectors do not need to be in the same place and the team leader and data collector actions can be done independently.

**Summary of differences between Bluetooth and internet sync**

<table>
<thead>
<tr>
<th>Bluetooth</th>
<th>Internet</th>
</tr>
</thead>
<tbody>
<tr>
<td>Does not require internet connection</td>
<td>Requires active internet connection</td>
</tr>
<tr>
<td>Devices must be in close proximity</td>
<td>Devices do not need to be in close proximity</td>
</tr>
<tr>
<td>Devices must be paired</td>
<td>Devices do not need to be paired</td>
</tr>
<tr>
<td>Data sharing options must be selected simultaneously</td>
<td>Data sharing options are selected independently</td>
</tr>
</tbody>
</table>

To transfer assignments from team leader to data collector using Bluetooth:

1. Team leader selects Transfer assignments to data collectors. At the same time, data collector selects Receive section assignments.
2. Both team leader and data collector select Bluetooth as the sync method.
3. Both team leader and data collector wait for pairing request. When pairing request is received, both accept to enable the devices to pair.
   a. The team leader device will be listed according to the team leader name and code (e.g. Team Leader 1 (2001)), so the data collector can easily identify the exact team leader to pair with.
   b. Should the data collector accidentally select the wrong team leader, the file transfer will terminate and indicate “The selected device does not belong to the respective team leader”. The data collector can then try again to pair with the appropriate team leader.
4. Once the devices are paired and connected, the assignments will be transferred to the data collector’s device.
To transfer assignments from team leader to data collector using the internet:

1. Team leader selects Transfer assignments to data collectors.
2. Team leader selects internet as the sync method.
3. On successful sync to the cloud, a message will appear informing the team leader that the section assignments were uploaded successfully.

4. When the data collector is ready to receive the assignments, the data collector selects Receive section assignments.
5. Data collector selects Internet as the sync method.
6. On successful sync from the cloud, a message will appear informing the data collector that the section assignments were received successfully.
Collect data

Once data collectors have received their assignments, they can begin collecting data. Note that team leaders are also able to assign themselves sections so that they can participate in the data collection process. If a team leader has been assigned sections, they will follow the same steps for collecting data as the data collectors. To collect data, take the following steps:

1. Data collector selects the Collect data option from the main menu.
2. A list of the facilities for which the data collector has been assigned sections will appear. Select the facility you will be visiting for data collection.
3. A message will appear asking you to confirm the selection of the facility. Press Continue to confirm or Cancel to go back to make a different facility selection.
4. Next, the interview result question will appear. This is used to record the status of the interview. Select Facility located and open if you arrive at the health facility and are able to begin data collection. Select one of the other options if you arrive at the health facility and are not able to collect data because the facility is closed today, closed permanently, destroyed, cannot be found, or for some other reason. Note, the data collector who has been assigned Section 1: Facility identification, will receive some additional initial questions before arriving at the interview result question. If an option other than Facility located and open is selected, the data collector will be asked to confirm the selection. Then, for all options except Facility not found, the data collector will be given the option to collect GPS coordinates before data entry closes.
5. The data collector assigned Section 1: Facility identification, is required to complete that section before entering the flow control form and having the option to complete other sections.

6. GPS coordinates will be taken by the data collector assigned the facility identification section. The GPS question will prompt the data collector to ensure they are outside with a clear view of the sky before attempting to capture the GPS coordinates. When ready to capture coordinates, the data collector should select “Yes”. A message will appear saying Obtaining GPS location. After GPS coordinates are successfully obtained, the application will continue on to the flow control form. Selecting “No” will return the data collector to the flow control form. There is also an option to manually input GPS data which can be used if an external GPS device is used to collect GPS data.
Next you will arrive at the flow control form. The flow control form allows data collectors to navigate into sections and enter data. Additionally, it helps them keep track of the number of assigned sections and how many have been completed. To enter data for a particular section, take the following steps:

1. Click on the radio button next to Enter/edit data for a section.
2. This takes you to the list of sections you have been assigned. For each section, you should be able to see the interview status (Section not started, Section incomplete, Section complete) and a column indicating if the section is done (Done, INC). Click on the name of the section followed by the green check mark to enter the section and collect data.

<table>
<thead>
<tr>
<th>Sect</th>
<th>Section name</th>
<th>Interview status</th>
<th>Done?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.00</td>
<td>Facility Identification</td>
<td>Section not started</td>
<td>INC</td>
</tr>
<tr>
<td>2.00</td>
<td>Client services</td>
<td>Section not started</td>
<td>INC</td>
</tr>
<tr>
<td>3.00</td>
<td>Health workforce</td>
<td>Section not started</td>
<td>INC</td>
</tr>
<tr>
<td>4.00</td>
<td>Facility beds and isolation units</td>
<td>Section not started</td>
<td>INC</td>
</tr>
<tr>
<td>5.00</td>
<td>Governance and management</td>
<td>Section not started</td>
<td>INC</td>
</tr>
<tr>
<td>6.00</td>
<td>Systems to support staff</td>
<td>Section not started</td>
<td>INC</td>
</tr>
</tbody>
</table>

3. When you have completed the data collection for a facility, click on End entry for this facility from the flow control main form. If all sections are complete, you will get a message saying Data entry is complete, with the following options: Exit, Save changes, and Continue entry. Click Exit, Save changes to end data entry. If one or more sections are incomplete, you will get a message saying One or more sections are not yet complete with the options: Continue to exit? (YES) and Continue to exit? (NO). Click on Continue to exit? (YES) to end data entry. For either of these options, the data are saved and the program returns to the main menu.

4. Once a section has been selected, the questions are displayed sequentially as they appear in the paper version of the questionnaire. When data entry for a section is complete, a message appears giving the data collector the option to return to the flow control form or to stay in the section. It is mandatory that for all assigned sections the data collector is required to go through all the questions until they arrive at the Section completion page. Skip patterns/filter questions have been introduced to reduce the data collection burden if a facility does not offer a particular service. However, the section must still be opened, the filter question must be asked (e.g. Does this facility offer xx service) and then the skip patterns will appropriately skip to the next section.
5. The HHFA CSPro application allows for partial saving during data entry. During data entry in a section, if a data collector wants to partially save the data and exit data collection, they can press the back button on the tablet. A message should display saying You are attempting to exit from this section, with the options: Save data and exit or Continue entry. Select Save data and exit to exit the section.

6. When re-entering a partially saved section, the application will ask the data collector if they prefer to resume entry from the last saved question or from the beginning of the section.
View reports: data collector

The data collector can generate two types of reports:

- a general progress report; and
- a facility progress report.

The general progress report gives an overview of the number of sections assigned per facility as well as the number of completed and pending sections. The facility progress report provides the status of each of the assigned sections for a single facility. To generate a report, data collectors take the following steps:

1. Select the View reports option from the main menu.
2. Select report type, either General Progress Report or Facility Progress Report:
   a. If General Progress Report is selected, the report will be displayed.
   b. If Facility Progress Report is selected, the facility must then be selected before the report is displayed.
3. Use the Back button on the tablet to return to the data collector menu.

---

**General progress report**

- number of sections assigned for each facility
- number of completed and pending sections

---

**Facility progress report**

---

**Update application and/or receive application updates from team leader**

There are two options for data collectors to update the HHFA application: internet and Bluetooth.

**Updating the application via the internet** requires an active internet connection. To update the HHFA application using the internet, the data collector takes the following steps:

1. Select the Update application option from the main menu.
2. When the update is complete, one of two messages will appear. If no changes have been made, the message will say Application updated successfully. If changes have been made, the first message will say “The application has changed and will now restart to ensure that you are using the updated version”. The second message will say “Application updated successfully”.
3. The application publish date shown at the top of the data collector menu should now be updated to reflect the recent update.
Updating the application via Bluetooth is a manual transfer of application files from the team leader’s device to the data collector’s device. This option should be used if the data collector is not able to access an internet connection. To update the HHFA application using Bluetooth, take the following steps:

1. The data collector selects the Receive application files from team leader option on the main menu. At the same time, the team leader selects Transfer application files to the data collector.
2. Both team leader and data collector select Bluetooth as the sync method.
3. Both team leader and data collector wait for the pairing request. When the pairing request is received, both individuals accept it to enable the devices to pair.
4. Once the devices are paired and connected, the application files will be transferred to the data collector’s device.

Send data to team leader

At the end of each day of data collection in a facility data collectors should send their data to the team leader (even if the data are partially complete). There are two options for data collectors to send data to the team leader: internet and Bluetooth.

Transferring data via Bluetooth does not require an internet connection, but the team leader and data collector need to be in close geographic proximity. To transfer data from the data collector to the team leader using Bluetooth, take the following steps:

1. The team leader selects Receive data from data collectors. At the same time, the data collector selects Send data to team leader.
2. Both team leader and data collector select Bluetooth as the sync method.
3. Both team leader and data collector wait for the pairing request. When the pairing request is received, both individuals accept it to enable the devices to pair.
4. Once the devices are paired and connected, the data will be transferred to the team leader’s device. The team leader can generate a report to check if the data have been received.

Transferring data via the internet requires an active internet connection, but the team leader and data collector do not need to be in close geographic proximity. To transfer data from data collector to team leader using the internet, take the following steps:

1. The data collector selects Send data to team leader.
2. The data collector selects Internet as the sync method.
3. On successful sync to the cloud, a message will appear informing the data collector that the data was successfully sent to the team leader.

4. When the team leader is ready to receive the data, the team leader selects Receive data from data collectors.
5. Team leader selects Internet as the sync method.
6. On successful sync from the cloud, a message will appear informing the team leader that the data were successfully synced.
Sync data for backup

The sync option allows data collectors to send data directly to the server (CSWeb or Dropbox) as a backup. The process is similar to sending the data to the team leader via the internet and requires an active internet connection. To sync data for backup, take the following steps:

1. Data collector selects Sync data for backup.
2. The application will connect to the internet and the server. Upon successful data sync, a message will be displayed which says Data synced successfully.

**Note:** CSPro stores data in a file format called CSPro DB with the file extension `.csdb`. The CSPro DB data source simplifies data collection as all information about cases is stored in a single place and the revision history allows CSPro, when syncing data, to only sync data that have changed. This file format makes it possible to sync partially saved cases as those cases are subsequently updated when additional data are collected and an updated case is synced in the future.
Create complete record

Recall that, based on the section assignments, each data collector will have data for a particular set of assigned sections for a single facility. The data files from all the data collectors who have collected data at a facility must be combined to create a complete record for the facility (see visual below).

After the team leader has received data from the data collectors, they are expected to create a complete facility record by combining all the data collectors’ files. This process is often called data concatenation. Data concatenation uses the Facility Assignments file to create a complete data record for the facility. The process is automated, hence everything runs in the background. The program checks through all the assignments done by the team leader, retrieves the associated data files, and merges them into a complete facility data file. Depending on the amount of merging required, this process may be quite fast and you may not notice any activity.

To create a complete record, take the following steps:

1. Team leader selects Create complete data record.
2. If the concatenations process is successful, a message will appear that says Data concatenation complete.
The complete record is used for generating reports about survey completeness. If you do not create the complete record, the supervisors and data manager will think you have not completed data collection. At the end of each day, utilize the Create complete facility record and sync data to ensure the most up-to-date information is available for survey progress monitoring!

**View reports: team leader**

The team leader can generate two types of reports:

- **General progress report (all facilities)**: This report outlines the interview status of all assigned health facilities. It also shows whether the GPS coordinates for the facilities have been collected.

- **Facility progress report**: This report shows the interview status of each of the assigned sections for a single facility.
To generate a report, the team leader takes the following steps:

1. Team leader selects the View reports option from the main menu.

2. Select report type, either General progress report (all facilities) or Facility progress report.
   a. If General progress report (all facilities) is selected, the report will be displayed.
   b. If Facility progress report is selected, the facility must then be selected before the report is displayed.

3. Use the Back button on the tablet to return to the team leader menu.

**Sync data**

The sync option allows team leaders to send data directly to the server (CSWeb or Dropbox). During this process, three data files are sent to the server: the original data collector data file, the combined data set and the assignments file. The process requires an active internet connection. To sync data, take the following steps:

1. Team leader selects Sync data for backup.
2. The application will connect to the internet and the server.
3. On successful connection, the data files are synced. Upon successful data sync, a message will be displayed to confirm the data have been successfully synced. A total of three files will be synced – HFA_Data.csdb (interviewer data), HFA_COMB.csdb (combined data) and HFA_Assignments.csdb (assignments data).
Update application: team leader

The update application feature for team leaders is the same as for data collectors in that it allows the user to get the latest version of the HHFA CSPro application from the server. The team leader update application function requires an active internet connection. To update the HHFA application using the internet, take the following steps:

1. Team leader selects the Update application option from the main menu.
2. When the update is complete, a message appears informing the team leader that the application has updated successfully and that the application will restart to ensure use of the updated version.
3. The application publish date shown at the top of the team leader menu should now be updated to reflect the recent update.
Reset device registration

Device registration restricts a data collection device to a single user. If a data collector logs into two different devices to collect data for the same facility, this will result in duplication and/or data loss. During data concatenation, the program might not locate the correct data set, and consequently some sections of data could end up missing in the data set. In addition, if a team leader logs into two different devices and syncs data, this will result in duplication of data on the central server. To avoid this, there is a restriction of one device per user. This applies to data collectors, team leaders and supervisors.

On initial login to the device/tablet, the user is prompted to register the device under their code. Once registered, no other user will be able to log in to the device unless the registration is reset.

Resetting the device registration enables a registered device to be reset so that another user can log in. However, **SHARING of devices is HIGHLY discouraged!** The reset device registration feature can be used in a situation where the device needs to be used by another data collector, team leader or supervisor.

The data manager can reset the device registration for any user. Supervisors can reset the device registration for team leaders and data collectors under their supervision. Team leaders can reset the device registration for data collectors on their team. Resetting device registration must be done in-person and cannot be done remotely. To reset a device’s registration, take the following steps:

1. The respective team leader/supervisor/data manager logs into the device that has been registered using the code that the device was originally registered to.
2. Enter the device reset code.
3. A prompt will appear asking for confirmation of the device deregistration. Select Yes to proceed.
4. A message will appear informing that the device has been successfully deregistered. At this point, the next user that logs into the device will be required to register the device before they can use it to collect HHFA data.
Device sharing is not permitted! **Do not:**

- use your own device
- use a second device
- share devices.

If you need to replace your device, talk to the data manager for instructions on how to do so appropriately.

**Additional functionalities**

**Change display language**

To change the display language, press the Menu icon (vertical ellipses) and select Change Language. Available languages will be listed and the data collector can select the language of interest. Data collectors can change the language at any point during the data collection process, which may prove helpful if in some countries more than one language is spoken.

**Troubleshooting**

I’ve selected the wrong facility name when I made assignments and data collection has already begun – what do I do?

- If data collection has already started, continue collecting data and inform the data manager. This information will be tracked and corrected in the data processing phase.
- It is a larger issue if you are also supposed to collect data for the facility for which you have picked the wrong name. In this case contact the data manager for further instructions. The data manager will likely tell you to collect the second facility under the first facility name and then they can change the facility ID for both facilities during the data processing phase.
12.4 HHFA CSPro for supervisors

Overview of data quality

Why is data quality important?

- Solid data supports solid conclusions and recommendations.
- Future public policy decisions may rely on this evidence.
- Critics will look for weaknesses.
- Results will be publicly accessible.
- Project values should reflect honesty and transparency.
- Fairness to affected parties requires that data reflect the true situation.

Data quality assurance is an ongoing process throughout the entire survey process. All survey team members have a role to play in ensuring data quality. Data quality assurance procedures include:

- Field supervision by survey coordinators and area supervisors.
- Data managers downloading data, assessing key fields, and providing teams with feedback.
- Team leaders and area supervisors monitoring for data completeness and correctness.
- Frequent mobile phone communication for rapid problem solving and information sharing.
- Electronic data collection with automated skip patterns, range checks, consistency checks and auto-fills.
- Validation through a sample of facilities to be re-surveyed by the quality assurance (QA) team (generally area supervisors or external QA team).

The area supervisor has two main roles in ensuring HHFA survey data quality:

- Conducting supervisor validation visits.
- Tracking progress towards survey completion.

Overview of area supervisor validation

The area supervisor will do a validation visit in 10% of health facilities. They will return to a selection of the sampled facilities (10%; randomly selected) and collect data again, to make sure that the data obtained by the data collectors are accurate and reliable. A supervisor validation may be conducted using either the entire HHFA questionnaire being implemented in a country or only selected sections of the questionnaire. This will be decided by the survey coordinating committee. If validation is conducted on selected sections of the questionnaire, it is recommended to select different sections across facilities so that all sections are covered across the validation process for a team. There are five main steps in the supervisor validation process:
1. Select facilities for validation at random.

2. Conduct the validation visits on the same day as the visits to these facilities by data collectors (or as soon after as possible).
   a. Be sure to use the HHFA CSPro application to collect all supervisor validation data. This helps facilitate comparison of data between supervisor validations and data collectors.

3. Compare the data obtained with those collected by the data collectors.
   a. Data managers will support the comparison of supervisor validation data to data collector data and provide a report of discrepancies.

4. Identify and resolve any issues/mistakes and discuss with data collectors.
   a. Remember, not all questions are expected to be an exact match and not all differences are indicative of data quality problems, for example, minor differences in the spelling of facility location, or other text only fields. In addition, differences in issues such as the availability of medicines may be true differences if the data were not collected on the same day, as medicine availability is subject to change. The comparison results must be interpreted with a view towards identifying differences that may be indicative of a problem with data quality.

5. The consistency of responses (exact matching) will be analysed as a measure of quality control.

**Process of supervisor validation on tablets**

Table 5 outlines the steps in the supervisor validation process, the staff responsible for each step, and when each step should take place. The following sections discuss how each of these steps is accomplished with the HHFA CSPro application using tablets. Note that when conducting a supervisor validation visit, only one person can collect data. The sections cannot be divided amongst multiple supervisors to collect data at a single facility.

**Table 5. Supervisor validation process steps**

<table>
<thead>
<tr>
<th>No.</th>
<th>Who?</th>
<th>What?</th>
<th>When?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Supervisor</td>
<td>Select sections for validation</td>
<td>Before arrival at facility/At the facility</td>
</tr>
<tr>
<td>2</td>
<td>Supervisor</td>
<td>Validate facility data</td>
<td>At facility</td>
</tr>
<tr>
<td>3</td>
<td>Supervisor</td>
<td>Sync validation data</td>
<td>End of the day</td>
</tr>
<tr>
<td>4</td>
<td>Supervisor</td>
<td>View reports</td>
<td>End of the day</td>
</tr>
<tr>
<td>5</td>
<td>Supervisor</td>
<td>Update application</td>
<td>As needed</td>
</tr>
</tbody>
</table>
Select sections for validation

The supervisor is responsible for selecting sections to validate at each facility. To select sections for validation on the tablet, take the following steps:

1. Supervisor logs in to CSPro and selects “Select facility sections for validation” in order to select the facility for which they want to make assignments. They select the region, district and the facility to make assignments for. The selection of the facility is similar to the assignment of sections to data collectors that team leaders do before arrival at the facility.

2. Supervisor selects sections to validate at the facility by checking the box next to each section which will be validated. It is required to include section 1 – facility identification.

3. Upon completion of the section selection, a report is generated showing the sections that have been selected for validation for the facility.

4. Confirm the section selection to continue to the main menu.

Validate facility data

Once supervisors have completed section selection, they can begin collecting data. To collect data, take the following steps:

1. Supervisor selects the Validate facility data option from the main menu.

2. A list of the facilities for which the supervisor has made section selections will appear. Select the facility you will be visiting for validation.

3. A message will appear asking you to confirm the selection of the facility. Press Continue to confirm or Cancel to go back to make a different facility selection.

4. Next, the interview result question will appear. This is used to record the status of the interview. Select Facility located and open if you arrive at the health facility and are able to begin data validation. Select one of the other options if you arrive at the health facility and are not able to collect validation data because the facility is closed today, closed permanently, destroyed, cannot be found, or for some other reason. If an option other than Facility located and open is selected, the supervisor will be asked to confirm the selection. Then, for all options except Facility not found, the supervisor will be given the option to collect GPS coordinates before data entry closes.

5. The supervisor will be required to complete section 1 – facility identification before entering the flow control form and having the option to complete other sections.

6. GPS coordinates will be taken by the supervisor as part of the facility identification section. The GPS question will prompt the supervisor to ensure they are outside with a clear view of the sky before attempting to capture the GPS coordinates. When ready to capture coordinates, the supervisor should select “Yes”. A message will appear saying Obtaining GPS location. After GPS coordinates are successfully obtained, the application will continue on to the flow control form.

Next you will arrive at the flow control form. The flow control form allows supervisors to navigate into sections and enter data. Additionally, it helps them keep track of the number of assigned sections and how many have been completed. To enter validation data for a particular section, take the following steps:

7. Click on the button next to Enter/edit data for a section.

8. This takes you to the list of sections you have selected for validation. For each section, you should be able to see the interview status (Section not started, Section incomplete, Section complete) and a column indicating if the section is done (Done, INC). Click on the name of the section followed by the green check mark to enter the section and collect data.

9. When you have completed the data collection for a facility, click on End entry for this facility from the flow control main form. If all sections are complete, you will get a message saying Data entry is complete, with the following options: Exit, Save changes, and Continue entry. Click Exit, Save changes to end data entry. If one or more sections are incomplete, you will get a message saying
One or more sections are not yet complete with the options: Continue to exit? (YES) and Continue to exit? (NO). Click on Continue to exit? (YES) to end data entry. For either of these options, the data are saved and the program returns to the main menu.

10. Once a section has been selected, the questions are displayed sequentially as they appear in the paper version of the questionnaire. When data entry for a section is complete, a message appears giving the supervisor the option to return to the flow control form or to stay in the section. It is mandatory that for all selected sections the supervisor is required to go through all the questions until they arrive at the Section completion page. Skip patterns/filter questions have been introduced to reduce the data collection burden if a facility does not offer a particular service. However, the section must still be opened, the filter question must be asked (e.g. Does this facility offer xx service) and then the skip patterns will appropriately skip to the next section.

11. The HHFA CSPro application allows for partial saving during data entry. During data entry in a section, if a supervisor wants to partially save the data and exit data collection, they can press the back button on the tablet. A message should display saying You are attempting to exit from this section, with the options: Save data and exit or Continue entry. Select Save Data and exit to exit the section. When re-entering a partially saved section, the application will ask the supervisor if they prefer to resume entry from the last saved question or from the beginning of the section.

Sync validation data

The sync option allows supervisors to send validation data directly to the server (CSWeb or Dropbox). This option has two functions:

- creates combined data record; and
- syncs data with the server.

Both functions run in the background, so this process may take some time. During this process, three data files are sent to the server: the original supervisor data file, the combined data set, and the assignments file. The process requires an active internet connection. To sync data, take the following steps:

1. Supervisor selects Sync validation data.
2. The application will connect to the internet and the server.
3. On successful connection, the data files are synced. Upon successful data sync, a message will be displayed to confirm the data have been successfully synced. A total of three files will be synced: HFA_Data.csdb (supervisor validation data), HFA_COMB.csdb (combined data) and HFA_Assignments.csdb (assignments data).
View reports

The supervisor can generate a report to view information about the facility validation data collection:

- **Facility validation progress report**: Facility progress report for the validated facilities. This gives the interview status for each of the assigned sections selected for validation for a single facility.

To generate a report, supervisors take the following steps:

1. Select the View reports option from the main menu.
2. Select the report type, Facility validation progress report. The facility must then be selected before the report is displayed.
3. Use the Back button on the tablet to return to the supervisor menu.

Update application

Updating the application for supervisors is done via the internet and requires an active internet connection. To update the HHFA application using the internet, the supervisor takes the following steps:

1. Select the Update application option from the main menu.
2. When the update is complete, one of two messages will appear. If no changes have been made, the message will say Application updated successfully. If changes have been made, the first message will say The application has changed and will now restart to ensure that you are using the updated version. The second message will say Application updated successfully.
3. The application publish date shown at the top of the supervisor menu should now be updated to reflect the recent update.

Reset device registration

Device registration restricts a data collection device to a user. If a data collector logs into two different devices to collect data for the same facility, this will result in duplication and/or data loss. During data concatenation the program might not locate the correct data set, and consequently some sections of data could end up missing in the data set. In addition, if a team leader logs into two different devices and syncs data, this will result in duplication of data on the central server. To avoid this, there is a restriction of one device per user. This applies to data collectors, team leaders and supervisors.

On initial login to the device/tablet, the user is prompted to register the device under their code. Once registered, no other user will be able to log in to the device unless the registration is reset.

Resetting the device registration enables a registered device to be reset so that another user can log in. However, **SHARING of devices is HIGHLY discouraged**! The reset device registration feature can be used in a situation where the device needs to be used by another data collector, team leader, or supervisor.

The data manager can reset the device registration for any user. Supervisors can reset the device registration for team leaders and data collectors under their supervision. Team leaders can reset the device registration for data collectors on their team. Resetting device registration must be done in-person and cannot be done remotely. To reset a device’s registration, take the following steps:

1. The respective team leader/supervisor/data manager logs into the device that has been registered using the code that the device was originally registered to.
2. Enter the device reset code.
3. A prompt will appear asking for confirmation of the device deregistration. Select Yes to proceed.
4. A message will appear informing that the device has been successfully deregistered. At this point, the next user that logs into the device will be required to register the device before they can use it to collect HHFA data.

Device sharing is not permitted! Do not:

- use your own device
- use a second device
- share devices.

If you need to replace your device, talk to the data manager for instructions on how to do so appropriately.

**Tracking progress towards survey completion**

In addition to collecting validation data, supervisors are responsible for tracking progress towards survey completion for the teams they supervise. The following sections discuss how tracking progress is accomplished with the HHFA CSPro application using tablets.

<table>
<thead>
<tr>
<th>No.</th>
<th>Who?</th>
<th>What?</th>
<th>When?</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Supervisor</td>
<td>Download all data</td>
<td>As needed</td>
</tr>
<tr>
<td>2</td>
<td>Supervisor</td>
<td>View reports</td>
<td>As needed</td>
</tr>
</tbody>
</table>

**Download all data**

The first step in tracking progress towards survey completion is downloading all the data from the server. This is required to generate and view reports on facility coverage. To download all data, take the following steps:

1. Select the Download all data option from the main menu.
2. If data are downloaded successfully, you will get the message “HHFA data downloaded successfully!”
View reports

Two types of facility coverage reports can be generated by the supervisor to track team data collection progress.

- **Facility coverage report (List)**: List of facilities done by the respective teams under the supervisor. The report provides the interview status for each facility.

- **Facility coverage report (Map)**: Gives a map showing the exact points on the map where the facilities are located that the supervisor’s teams have visited and collected data for.

To view the facility coverage report – list view, take the following steps:

1. Select the Download all data option from the main menu. When data are successfully downloaded you will be returned to the main menu.
2. Select the View reports option from the main menu.
3. Select Facility coverage report (List) and click on the green check mark.
4. The supervisor can then either select all regions for a specific date range to get a list of all facilities, or they can filter by a specific region and/or district to review a subset of completed facilities.
5. A list of facilities visited by the team will show with the interview status for each facility.

6. Use the back button on the tablet to return to the supervisor menu.

After reviewing the facility coverage report, discuss with your team leaders to make sure:

- The team is on track with data collection.
- The information on facility completion in your report is consistent with the team leader report.

The complete record is used for generating reports about survey completeness. If team leaders do not create the complete record, the supervisors and data manager will think data collection is incomplete. If there is a discrepancy between the facility completeness report seen by supervisors/data manager and team leaders, ask the team leader to utilize the Create complete facility record and Sync data. **Remind team leaders on an ongoing basis that at the end of each day they should utilize the Create complete facility record and Sync data** to ensure the most up-to-date information is available for survey progress monitoring.

To view the facility coverage report – map view, take the following steps:

1. Select the Download all data option from the main menu. When data are successfully downloaded you will be returned to the main menu.
2. Select the View reports option from the main menu.
3. Select Facility coverage report (Map) and click on the green check mark.
To view a map of the facilities, the supervisor chooses “Facility Coverage Report (Map)”.

4. A map will show with a point for each facility where data have been collected by your team. Each facility is labelled with the facility code.

5. Click on any facility to get key information on that facility.

6. Click on the "basemap" icon to toggle between basemap types. There are four basemap types – normal, hybrid, satellite and terrain. The default map types is “normal”.

7. Click on the “filter” icon to only show facilities for a selected region and to zoom to that region on the map. After selecting the filter button, select the region of interest. The map now shows only the facilities for that region.

8. Use the back button on the tablet to return to the supervisor menu.
13. Preparing for data collection

13.1 Clear data after training/pilot

Before the tablets are sent out for official data collection, data must be cleared from all tablets that were used for training and piloting the questionnaire. This is a vital step. Any training data that remain on the tablets may create problems with data management as duplicate data sections may appear and it can be very difficult to distinguish training data from real data once data collection begins. Ultimately, loss of survey data may occur if training data remain on the tablets. See Section 9.1 for instructions on setting the data connection which will clear data from tablets and the server.

13.2 Make final updates to the HHFA CSPro application

The pilot (field practice) experience during training provides an opportunity to practice the data collection process. During the pilot, often the survey team identifies minor adjustments that need to be made to either the questionnaire content or the CSPro programming. It is the responsibility of the data manager to make final updates to the HHFA CSPro application based on feedback from the pilot experience and decisions by the survey management team.

Note: Making changes to the HHFA CSPro application assumes that pilot data will be discarded and not used in the final survey data set.

13.3 Deploy HHFA CSPro application for data collection

As part of the HHFA application finalization process, the data manager is also responsible for:

- Checking the staff listing and ensuring that data collection teams have been finalized.
- Checking that the facility sample file has been finalized.
- Redeploying the final HHFA application, updating all tablets, and redistributing tablets to data collection teams.
PART 3: DATA COLLECTION

Ensuring high-quality data requires reviewing data in real time during data collection. Multiple individuals have responsibilities for reviewing data over the course of an HHFA. As a general rule for the HHFA CSPro application, while data collection is ongoing, all edits to the data must be made on the tablet originally used to collect the data. This section will briefly discuss the process of reviewing data during data collection.

14. Reviewing data during data collection

14.1 Review data during data collection

During data collection, reviewing of data is the responsibility of almost all HHFA user roles:

- Data collectors use the View reports feature to review the completeness of the sections they have been assigned for specific facilities.
- Team leaders use the View reports feature to review the completeness of questionnaires for facilities assigned to their team.
- Supervisors use the View reports feature to review the completeness of questionnaires for facilities assigned to several teams, in order to see progress across a district or region.
- Data managers use the tracking sheet (described later in the section) to track the progress across all teams towards completing data collection for all facilities. Data managers are responsible for recording information such as facilities that are replaced, closed, etc. throughout the data collection process. In addition, data managers should use the tracking sheet to record any issues with duplicate facility names/codes observed in the data set and the resolutions that need to be implemented in the data processing phase based on discussion with field teams.

Regular review of the data helps to ensure that all sections for all facilities are captured. It can also help to identify any missing data and/or challenges with the data collection process in real time, so that the issues can be addressed while data collection teams are still in the field. It is important to note that all editing of data must be done on the original tablet on which the data were collected until data collection is complete and the data have been handed over to the data manager for the final stages of data processing.

14.2 Track progress towards survey completion

Download data

Tracking of progress towards survey completion requires downloading of the HHFA data. Data managers have several options for downloading data:

- Download from the HHFA setup menu.
- Download from CSWeb or Dropbox (depending on the sync method used).

A quick recall of the data collection process may help to understand the data download options and the files that are downloaded:

- Team leaders assign sections of the HHFA questionnaire to data collectors. The module assignments are saved in the HFA_Assignments.dcf dictionary (also called the HHFA Section Assignments).
Data collectors collect data using the HFA_DICT.dcf dictionary (also called WHO HHFA Individual Interviewer Questionnaire).

Data collectors sync the data they have collected to the server.

Data collectors also send the data they have collected back to the team leader.

The team leader has a function on their tablet to merge sections across data collectors for a facility and create a complete record per facility. These data are saved with the HFA_COMB.dcf dictionary (also called WHO HHFA Combined Questionnaire).

Therefore, the data manager can choose to download:

- the combined data file;
- the individual interviewer questionnaire files; and/or
- the modules assignment file.

To download data through the HHFA setup menu, take the following steps:

1. Open the HFA_WHO folder, double click to open the HHFA_Menu.ent.
2. Click the traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:

5. Select Option C to download all data. You will get three successful download messages and the data will automatically be saved in the HFA_WHO\data folder. This will download the HFA_Data.csdb file, HFA_COMB.csdb file and HFA_Assignments.csdb file.

6. Select Option Z to exit the Data Manager menu.
To download data from CSWeb, take the following steps:

1. Go to the CSWeb server link you have set up and log in as an administrator.
2. Click on the data tab on the left.
3. Click Download next to the data set you want to download. This downloads a .pff file to your computer.
4. Open the .pff file. This launches the CSPro Data Viewer. Enter your username and password. The .csdb file will automatically download.
5. If you want to change the name and/or the location where the file is saved, click File ➔ Save as ➔ Data, and browse to a location of your choice. It is recommended to save the data files in the HFA_WHO\data folder.

CSPro’s Dropbox sync does not store a single data file in Dropbox. Instead, it stores a file in /CSPro/DataSync/ for every synchronization. Therefore, you will not see the data as a single file. In order to obtain the combined data file, use the Data Viewer to download the data from Dropbox. To download data from Dropbox, take the following steps:

1. Go to the start menu and select Programs ➔ CSPro 7.7 ➔ Data Viewer.
2. From the file menu of the Data Viewer, select Download.
3. In the resulting dialog box, select Dropbox and click on the Connect button. You will need to enter the Dropbox account that is associated with the survey. CSPro will populate the “Data” dropdown using the data file list from Dropbox. Select the dictionary label associated with the files you wish to download.
4. In Save As, navigate to the folder in which to store the file and give the file a name. Click the Save button. For the HHFA, save the file in the HFA_WHO\data folder.
5. Click Download. CSPro will download the file to the specified folder/file name and will display the contents of the file.
6. After downloading the file, to get updated data, you can open the .csdb file again in Data Viewer and choose Synchronize instead of Download. This should be faster since it will only download cases that were updated since the file was last synced.

**Note:** You do NOT need to have Dropbox installed on the computer to use Dropbox synchronization or Data Viewer. CSPro uses the Dropbox web application programming interface (API) which is independent of the Dropbox client software that you install on your computer.

If you have problems using the Data Viewer, a few common issues can be checked:

- Make sure that the internet network you are using has not blocked access to Dropbox.
- Make sure that your computer has .NET framework version 4.7 or later installed.

If you want to change the Dropbox account associated with the Data Viewer synchronization, you must remove the saved username and password. To do this, take the following steps:

- **On Windows desktop:** Select the File tab in CSPro, click CSPro Settings, and then click Clear Credentials.
- **On Android:** Press the Menu icon (vertical ellipses) on the Entry Applications screen of CSEntry. Press Settings, then press Clear Credentials.
**Track progress**

Throughout data collection, the data manager is responsible for taking stock of the data and knowing which facilities have been visited. In addition, the data manager is responsible for recording key information from the field teams about facilities that may be closed, inaccessible, or could not be found so that at the end of data collection all this information is readily available for the data cleaning and data set finalization process.

An Excel tracking table such as the following should be maintained by the data manager to facilitate this process:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ID</td>
<td>Country Code</td>
<td>Facility</td>
<td>District</td>
<td>Health District</td>
<td>Facility</td>
<td>County</td>
<td>Province</td>
<td>Comments</td>
</tr>
<tr>
<td>2</td>
<td>123456</td>
<td>GY</td>
<td>123456</td>
<td>123456</td>
<td>123456</td>
<td>123456</td>
<td>123456</td>
<td>123456</td>
<td>123456</td>
</tr>
<tr>
<td>3</td>
<td>456789</td>
<td>YZ</td>
<td>456789</td>
<td>456789</td>
<td>456789</td>
<td>456789</td>
<td>456789</td>
<td>456789</td>
<td>456789</td>
</tr>
<tr>
<td>4</td>
<td>987654</td>
<td>ZW</td>
<td>987654</td>
<td>987654</td>
<td>987654</td>
<td>987654</td>
<td>987654</td>
<td>987654</td>
<td>987654</td>
</tr>
<tr>
<td>5</td>
<td>012345</td>
<td>WX</td>
<td>012345</td>
<td>012345</td>
<td>012345</td>
<td>012345</td>
<td>012345</td>
<td>012345</td>
<td>012345</td>
</tr>
<tr>
<td>6</td>
<td>654321</td>
<td>ZY</td>
<td>654321</td>
<td>654321</td>
<td>654321</td>
<td>654321</td>
<td>654321</td>
<td>654321</td>
<td>654321</td>
</tr>
</tbody>
</table>

In this example, the facilities highlighted in green are those that were in the original data set and that have been assessed. The facilities highlighted in yellow are replacement facilities. It is important to indicate which of the facilities from the original sample have been replaced and which facilities have been used as replacements. Finally, the facilities highlighted in red are those that could not be assessed. Information on why the facility could not be assessed should be included in the comments column of the tracking table.

**Tips for creating a tracking sheet**

- The first tab of the tracking sheet is most easily populated using the facility sample file.
  - Add two additional columns: “Completed” and “Comments”.
  - Name the first tab “Sample”.

- The second tab of the tracking sheet is most easily populated by downloading your final Combined Questionnaire data set, exporting to Excel using the CSPro Export tool (see Chapter 16), and copy/pasting the list of facility IDs (Q100) to column A.
  - Add a second column called “In sample”.
  - Name the second tab “Data_file”.

- Use VLOOKUP to populate the “Sample” column called “Completed”. This will check the list of facilities from the Data_file tab. If the facility ID is found, the Completed column will say “Yes”; if not, it will say “No”:
  - =IF(ISNA(VLOOKUP(A5,data_file!A:A,1,FALSE)), “No”, “Yes”).

- Use VLOOKUP to populate the “Data_file” column called “In sample”. This will check the list of facilities from the Sample tab. If the facility ID is found, the In sample column will say “Yes”; if not, it will say “No”. This tab is useful for identifying facilities that were not part of the original sample (i.e. replacements).
  - =IF(ISNA(VLOOKUP(A2,Sample!A:1,1,FALSE)), “No”, “Yes”).
Apply conditional formatting to the “Sample” column called “Completed” to easily identify missing facilities:

- Select Column, then go to Home ➔ Conditional formatting ➔ Highlight cell rules ➔ Text that contains... to apply conditional formatting colours.

### Additional data manager tools useful for tracking survey completeness

Several additional reports can be generated from the Data Manager menu to assist with tracking survey progress. These include:

- **Duplicates report**: Checks for duplicate facility IDs in the combined data set and provides a report of the facility name, facility ID, team leader, and interview status for any duplicate facilities.
- **Survey progress report**: Provides an overview of the status of data collection for all facilities in the facility sample file.
- **Detailed incomplete sections report**: Provides information on which sections are incomplete for facilities that have been assigned to data collectors.
- **Facility validation report**: Provides information on which facilities have had a supervisor validation visit.

Instructions for generating these reports are included in Chapter 15 (Reviewing and Editing data).
PART 4: DATA PROCESSING

15. Reviewing and editing data

Ensuring high-quality data requires reviewing and editing data in real time during data collection as well as after data collection is complete. Multiple individuals have responsibilities for reviewing data over the course of an HHFA. As a general rule, for the HHFA CSPro application, while data collection is ongoing, all edits to the data must be made on the tablet originally used to collect the data. Once all data collection is complete, further data edits can be made to the combined data set by the data manager using a batch edit application. This section will provide in-depth instructions on reviewing and editing data after data collection is complete.

15.1 Track progress towards survey completion

Sync data from all tablets

Once data collection is complete, it is highly recommended that the data manager sync data from all tablets one final time as the tablets are returned from the field. This will ensure that all data that have been collected are reflected in the final data set and will help in managing issues that may arise with missing data during the data processing phase. Syncing data from all tablets should include:

- syncing data from data collector tablets to server;
- syncing data from data collector tablets to team leader tablets;
- creating complete records on team leader tablets; and
- syncing team leader tablets to server.

These steps may seem time consuming, but they will ensure that all data are included in the final data set and that any facilities not accounted for in the final data set are not hidden on a tablet somewhere. Much time can be lost in hunting down missing facility data after data collection is complete.

Download data

Tracking of progress towards survey completion requires downloading of the HHFA data. Data managers have several options for downloading data:

- download from the HHFA setup menu; and
- download from CSWeb or Dropbox (depending on the sync method used).

A quick recall of the data collection process may help to understand the data download options and the files that are downloaded:

- Team leaders assign sections of the HHFA questionnaire to data collectors. The module assignments are saved in the HFA_Assignments.dcf dictionary (also called the HHFA Section Assignments).
- Data collectors collect data using the HFA_DICT.dcf dictionary (also called WHO HHFA Individual Interviewer Questionnaire).
- Data collectors sync the data they have collected to the server.
- Data collectors also send the data they have collected back to the team leader.
The team leader has a function on their tablet to merge sections across data collectors for a facility and create a complete record per facility. These data are saved with the HFA_COMB.dcf dictionary (also called WHO HHFA Combined Questionnaire).

Therefore, the data manager can choose to download:

- the combined data file;
- the individual interviewer questionnaire files; and/or
- the modules assignment file.

In some cases, the data manager may want to download both the combined data file and the individual interviewer questionnaire files. The data manager may then want to use the individual interviewer files to recreate the combined file as a check that the data from all data collectors ended up in the final combined data set (this requires the assignments file). If you want to do this, please download data from the HHFA setup menu as there is some additional functionality in this interface to support this approach.

To download data through the HHFA setup menu, take the following steps:

1. Open the HFA_WHO folder, double click to open the HHFA_Menu.ent.
2. Click the traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:

![Data Manager Menu](image)

5. Select Option C to download all data. You will get three successful download messages and the data will automatically be saved in the HFA_WHO\data folder. This will download the HFA_Data.csdb file, HFA_COMB.csdb file, and HFA_Assignments.csdb file.
6. Select Option Z to exit the Data Manager menu.
To download data from CSWeb, take the following steps:

1. Go to the CSWeb server link you have set up and log in as an administrator.
2. Click on the data tab on the left.
3. Click Download next to the data set you want to download. This downloads a .pff file to your computer.
4. Open the .pff file. This launches the CSPro Data Viewer. Enter your username and password. The .csdb file will automatically download.
5. If you want to change the name and/or the location where the file is saved, click File ➔ Save as ➔ Data, and browse to a location of your choice. It is recommended to save the data files in the HFA_WHO\data folder.

CSPro’s Dropbox sync does not store a single data file in the Dropbox. Instead, it stores a file in /CSPro/DataSync/ for every synchronization. Therefore, you will not see the data as a single file. In order to obtain the combined data file, use the Data Viewer to download the data from Dropbox. To download data from Dropbox, take the following steps:

1. Go to the start menu and select Programs ➔ CSPro 7.7 ➔ Data Viewer.
2. From the file menu of the Data Viewer, select Download.
3. In the resulting dialog box, select Dropbox and click on the Connect button. You will need to enter the Dropbox account that is associated with the survey. CSPro will populate the “Data” dropdown using the data file list from Dropbox. Select the dictionary label associated with the files you wish to download.
4. In Save As, navigate to the folder in which to store the file and give the file a name. Click the Save button. For the HHFA, save the file in the HFA_WHO\data folder.
5. Click Download. CSPro will download the file to the specified folder/file name and will display the contents of the file.
6. After downloading the file, to get updated data, you can open the .csdb file again in Data Viewer and choose Synchronize instead of Download. This should be faster since it will only download cases that were updated since the file was last synced.

**Note:** You do NOT need to have Dropbox installed on the computer to use Dropbox synchronization or Data Viewer. CSPro uses the Dropbox web application programming interface (API) which is independent of the Dropbox client software that you install on your computer.

If you have problems using the Data Viewer, a few common issues can be checked:

- Make sure that the internet network you are using has not blocked access to Dropbox.
- Make sure that your computer has .NET framework version 4.7 or later installed.

If you want to change the Dropbox account associated with the Data Viewer synchronization, you must remove the saved username and password. To do this, take the following steps:

- **On Windows desktop:** Select the File tab in CSPro, click CSPro Settings, and then click Clear Credentials.
- **On Android:** Press the Menu icon (vertical ellipses) on the Entry Applications screen of CSEntry. Press Settings, then press Clear Credentials.
Track progress

When data collection is complete, the data manager is responsible for taking stock of the data and determining what has been collected. It is important to check that all facilities in the sample have been covered and, if not, to keep track of those that are missing, replaced, closed, inaccessible, etc. An Excel tracking table such as the following should be maintained by the data manager to facilitate this process.

In this example, the facilities highlighted in green are those that were in the original data set and that have been assessed. The facilities highlighted in yellow are replacement facilities. It is important to indicate which of the facilities from the original sample have been replaced and which facilities have been used as replacements. Finally, the facilities highlighted in red are those that could not be assessed. Information on why the facility could not be assessed should be included in the comments column of the tracking table.

The tracking process can help identify issues with duplicate facilities, tablets that did not sync, issues with assignments and syncing of data, etc. Make sure that you can account for all facilities before proceeding with data review and editing of data. Determine the total number of facilities that are missing. Seek out the reasons why they were not surveyed from the data collection teams. Make all efforts to capture data before proceeding. This information is extremely useful in understanding what happened during the field data collection and any deviations from the original plan. This information will also be very helpful later when calculating sample weights if a sample survey was conducted.

**Tips for creating a tracking sheet**

- The first tab of the tracking sheet is most easily populated using the facility sample file.
  - Add two additional columns: “Completed” and “Comments”.
  - Name the first tab “Sample”.

- The second tab of the tracking sheet is most easily populated by downloading your final Combined Questionnaire data set, exporting to Excel using the CSPro Export tool (see Chapter 16), and copy/pasting the list of facility IDs (Q100) to column A.
  - Add a second column called “In sample”.
  - Name the second tab “Data_file”.

- Use VLOOKUP to populate the “Sample” column called “Completed”. This will check the list of facilities from the Data_file tab. If the facility ID is found, the Completed column will say “Yes”; if not, it will say “No”.
  - =IF(ISNA(VLOOKUP(A5,Data_file!A:A,1,FALSE)), “No”, “Yes”).
Use VLOOKUP to populate the “Data_file” column called “In sample”. This will check the list of facilities from the Sample tab. If the facility ID is found, the In sample column will say “Yes”; if not, it will say “No”. This tab is useful for identifying facilities that were not part of the original sample (i.e. replacements).

=IF(ISNA(VLOOKUP(A2,Sample!A:I,1,FALSE)), “No”, “Yes”).

Apply conditional formatting to the “Sample” column called “Completed” to easily identify missing facilities.

Select Column, then go to Home → Conditional formatting → Highlight cell rules → Text that contains… to apply conditional formatting colours.

15.2 Review data for completeness

Once data managers know which facilities are included in the sample, the next important step is to ascertain the completeness of the data for each facility in the final data set. The Data Manager menu includes several reporting functions to generate information on the completeness of facility records in the final combined data set. This includes the survey progress report, detailed incomplete sections report and facility validation report.

To generate the survey progress report, take the following steps:

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.
2. Click the Traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:
Select Option E: Survey progress report. The report will be saved as a .csv file in the HFA_WHO\ref\csv_files folder and is called Survey_Progress.csv. The report will list all the facilities in the facility sample file, the interview status, GPS collection status and information on the percentage of sections that have been completed.

5. Select Option Z to exit the Data Manager menu.

6. Go to the HFA_WHO\ref\csv_files folder open the file Survey_Progress.csv. The report will identify the facilities where data collection has not been started and facilities where assignments were made, but still have incomplete data.

<table>
<thead>
<tr>
<th>Facility Code</th>
<th>Facility Name</th>
<th>Region</th>
<th>District</th>
<th>Team Leader Code</th>
<th>Team Leader Name</th>
<th>Interview Status</th>
<th>GPS Status</th>
<th>% Completion</th>
</tr>
</thead>
<tbody>
<tr>
<td>100001</td>
<td>National Referral Hospital #1</td>
<td>Region 11</td>
<td>District 1/Region 11</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Interview incomplete</td>
<td>Not collected</td>
<td>11</td>
</tr>
<tr>
<td>100002</td>
<td>National Referral Hospital #2</td>
<td>Region 11</td>
<td>District 1/Region 11</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Interview incomplete</td>
<td>Not collected</td>
<td>11</td>
</tr>
<tr>
<td>100003</td>
<td>National Referral Hospital #3</td>
<td>Region 11</td>
<td>District 2/Region 11</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Data not collected</td>
<td>Not collected</td>
<td>0</td>
</tr>
<tr>
<td>100004</td>
<td>National Referral Hospital #4</td>
<td>Region 12</td>
<td>District 1/Region 12</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Interview incomplete</td>
<td>Not collected</td>
<td>5</td>
</tr>
<tr>
<td>100005</td>
<td>National Referral Hospital #5</td>
<td>Region 12</td>
<td>District 2/Region 12</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Data not collected</td>
<td>Not collected</td>
<td>0</td>
</tr>
<tr>
<td>200001</td>
<td>Regional (Provincial) Referral Hospital #1</td>
<td>Region 11</td>
<td>District 1/Region 11</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Data not collected</td>
<td>Not collected</td>
<td>0</td>
</tr>
<tr>
<td>200002</td>
<td>Regional (Provincial) Referral Hospital #2</td>
<td>Region 11</td>
<td>District 2/Region 11</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Data not collected</td>
<td>Not collected</td>
<td>0</td>
</tr>
<tr>
<td>200003</td>
<td>Regional (Provincial) Referral Hospital #3</td>
<td>Region 12</td>
<td>District 1/Region 12</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Data not collected</td>
<td>Not collected</td>
<td>0</td>
</tr>
<tr>
<td>200004</td>
<td>Regional (Provincial) Referral Hospital #4</td>
<td>Region 12</td>
<td>District 2/Region 12</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Data not collected</td>
<td>Not collected</td>
<td>0</td>
</tr>
<tr>
<td>200005</td>
<td>Regional (Provincial) Referral Hospital #5</td>
<td>Region 12</td>
<td>District 2/Region 12</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Data not collected</td>
<td>Not collected</td>
<td>0</td>
</tr>
<tr>
<td>700001</td>
<td>Health Centre #1</td>
<td>Region 11</td>
<td>District 1/Region 11</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Interview incomplete</td>
<td>Not collected</td>
<td>10</td>
</tr>
<tr>
<td>700002</td>
<td>Health Centre #2</td>
<td>Region 11</td>
<td>District 1/Region 11</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Interview incomplete</td>
<td>Not collected</td>
<td>10</td>
</tr>
<tr>
<td>700003</td>
<td>Health Centre #3</td>
<td>Region 12</td>
<td>District 1/Region 12</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Interview incomplete</td>
<td>Not collected</td>
<td>2</td>
</tr>
<tr>
<td>700004</td>
<td>Health Centre #4</td>
<td>Region 12</td>
<td>District 2/Region 12</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Interview incomplete</td>
<td>Not collected</td>
<td>2</td>
</tr>
<tr>
<td>700005</td>
<td>Health Centre #5</td>
<td>Region 12</td>
<td>District 2/Region 12</td>
<td>3100</td>
<td>Team Leader 1</td>
<td>Interview incomplete</td>
<td>Not collected</td>
<td>2</td>
</tr>
</tbody>
</table>

To generate the detailed incomplete sections report, take the following steps:

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.
2. Click the Traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:
Select Option F: Detailed incomplete sections report. The report will be saved as a .csv file in the HFA_WHO\ref\csv_files folder and is called Incomplete_Sections.csv. The report will list all the facilities in the combined data file for which there are incomplete sections.

5. Select Option Z to exit the Data Manager menu.

6. Go to the HFA_WHO\ref\csv_files folder open the file Incomplete_Sections.csv. The report will identify the facilities where assignments were made, but still have incomplete data. Each section that is incomplete will be listed in a separate row. The report will not say which specific questions have not been answered. For further details on unanswered questions, open the data set in the CSPro Data Viewer or Export the data set to .csv and open it in Excel. Follow-up with team leaders on any incomplete data. All efforts should be made to complete data collection before moving forward with data processing steps.

<table>
<thead>
<tr>
<th>Facility Name</th>
<th>Team Leader Code</th>
<th>Team Leader Name</th>
<th>Section ID</th>
<th>Section Title</th>
<th>Data Collector Code</th>
<th>Data Collector Name</th>
<th>Interview Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>3</td>
<td>Health workforce</td>
<td>2001</td>
<td>Team Leader 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>5</td>
<td>Governance and management</td>
<td>2001</td>
<td>Team Leader 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>6</td>
<td>Systems to support staff</td>
<td>2001</td>
<td>Team Leader 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>7</td>
<td>Systems for monitoring service quality</td>
<td>2001</td>
<td>Team Leader 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>9</td>
<td>Health financing and accounting</td>
<td>2001</td>
<td>Interviewer 1</td>
<td>Section started not completed</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>10</td>
<td>Data sources and systems</td>
<td>2001</td>
<td>Interviewer 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>12</td>
<td>Basic infrastructure and systems</td>
<td>2001</td>
<td>Interviewer 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>13</td>
<td>Outpatient service conditions</td>
<td>2001</td>
<td>Interviewer 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>14</td>
<td>Communicable disease services</td>
<td>2001</td>
<td>Interviewer 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>15</td>
<td>Non-communicable disease services</td>
<td>2001</td>
<td>Interviewer 3</td>
<td>Case not found</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>16</td>
<td>Services for mental health and neurological conditions</td>
<td>2001</td>
<td>Interviewer 3</td>
<td>Case not found</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>17</td>
<td>Services for special needs</td>
<td>2001</td>
<td>Interviewer 3</td>
<td>Case not found</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>18</td>
<td>Maternal and newborn health services (Outpatient)</td>
<td>2001</td>
<td>Interviewer 3</td>
<td>Case not found</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>19</td>
<td>Abortion care services</td>
<td>2001</td>
<td>Interviewer 2</td>
<td>Case not found</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>20</td>
<td>Services for children under 5 and adolescents</td>
<td>2001</td>
<td>Interviewer 3</td>
<td>Case not found</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>21</td>
<td>Immunization services</td>
<td>2001</td>
<td>Interviewer 2</td>
<td>Case not found</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>22</td>
<td>Delivery postnatal and newborn services (inpatient)</td>
<td>2001</td>
<td>Interviewer 2</td>
<td>Case not found</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>23</td>
<td>HIV services</td>
<td>2001</td>
<td>Interviewer 1</td>
<td>Section not started</td>
</tr>
<tr>
<td>Reg(80).National referral hospital</td>
<td>2000</td>
<td>Team Leader L</td>
<td>24</td>
<td>Tuberculosis (TB) services</td>
<td>2001</td>
<td>Interviewer 2</td>
<td>Case not found</td>
</tr>
</tbody>
</table>

To generate the facility validation report, take the following steps:

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.
2. Click the Traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:
Select Option G: Facility validation report. A report will open which lists all the facilities for which a supervisor validation visit has been conducted. It will also include key details about the validation visit including the name of the supervisor who conducted the validation, the interview status, GPS coordinate status, number of sections assigned for validation and number of sections completed for validation.

5. Click on “Close” to exit the report.
6. Select Option Z to exit the Data Manager menu.
15.3 Validate combined data set from individual questionnaire data

Data collectors sync their individual questionnaire sections as well as sending them to their team leader, who creates the combined data file and syncs the combined data file. In this way the data collectors’ individual sections serve as backup data. In some cases, there may be interest in creating a combined data set from the individual section data (i.e. the backup data) and comparing it with the combined data set synced by the team leader. An example of where this may be useful is if data collectors report having collected data for a facility, but it does not appear in the combined data set. To create a combined data set from the individual questionnaire section data, take the following steps:

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.
2. Click the Traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:

![Data Manager menu]

5. Select Option C: Download all data. The data will automatically be saved in the HFA_WHO\data folder and this will download the HFA_Data.csdb file, the HFA_COMB.csdb file and the HFA_Assignments.csdb file.

6. Select Option I: Create combined data. The combined data file will be generated from the individual data files and automatically saved as HFA_COMB_DM.csdb in the HFA_WHO\data folder. The Create combined data option checks for duplicate assignments before concatenating the data. If duplicate assignments are present, an error message will be displayed like the one below for each duplicate assignment.

![Error message]

Facility National Referral Hospital #1 has a duplicate assignment. Data concatenation will be skipped for this facility.

OK
When data concatenation is complete, the following message will be displayed:

![Image of message box: Data concatenation complete!](image)

7. Select Option Z to exit the Data Manager menu.

8. Open the HFA_COMB_DM.csdb file using the CSPro Data Viewer and compare it with the combined data set. Compare the total number of records in the HFA_COMB_DM.csdb data set to the total number of records in the HFA_Data.csdb data set.

   a. If there are more records in the HFA_COMB_DM.csdb data set than in the HFA_Data.csdb data set, this may indicate that team leaders did not sync all data.

   b. In this case, retrieve all tablets that were used by team leaders during field work. Log in and rerun the “Create complete record” function followed by the “Sync data” function on each tablet.

   c. Once this process has been completed on all tablets, download the HFA_Data.csdb data set and compare it again with the number of records in the HFA_COMB_DM.csdb data set. If there are still discrepancies, this may indicate that data collectors did not sync their data with team leaders.

      i. Retrieve all tablets that were used by data collectors during field work. Log in and run the “Sync data with team leader” function on all tablets.

      ii. Log in as the team leader for each data collector. Repeat the steps to “Create complete record” followed by “Sync data”.

      iii. Once this process has been completed on all tablets, download the HFA_Data.csdb data set and compare it again with the number of records in the HFA_COMB_DM.csdb data set. This should resolve any discrepancies between the data sets.

   

**Note:** The HFA_Data.csdb data set will always be used as the “final” data set. The HFA_COMB_DM.csdb data set is used only as a check on the completeness of the HFA_Data.csdb file and should not be used for data analysis.

### 15.4 Identify and resolve duplicates

Duplicate cases are cases with the same facility code/name. If two cases appear to be duplicates according to facility code/name, but do not contain the same data, a list of criteria must be used to determine if it is a true duplicate. The following data elements could be used as the criteria for determining duplicates:

- administrative area (i.e. region and district)
- facility code/name
- GPS coordinates (if collected)
- facility type
- managing authority
- interviewer’s code.
If all of these are the same, it is safe to consider the cases as duplicates. At this point, the most complete case should be kept in the data set. If both cases are complete, the case with latest time stamp should be kept.

Identify potential duplicates

To begin the process of identifying duplicates, first generate the duplicates report. To generate the duplicates report, take the following steps:

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.
2. Click the Traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:

   ![Data Manager Menu]

5. Select Option D: Duplicates report. A report will open which lists all the facilities for which a duplicate is found in the combined data set. It will also include key details about the duplicates including the assignment UUID, facility ID, facility name, team leader code and name, interview status, GPS and combined file UUID. Any duplicates located indicate that either two teams surveyed the same facility or a team used the wrong facility code. The data manager will need to further investigate the potential duplicates to determine the cause of the duplicate.
6. Reviewing and editing data

Click on “Close” to exit the report.

Select Option Z to exit the Data Manager menu.

You can also identify duplicates in the tracking sheet using the following steps:

a. Go to your tracking sheet and click on the second tab, “Data_file”, where you stored the facility IDs from your final combined data set.

b. Highlight the column which contains the facility IDs of your data set and apply conditional formatting to highlight all duplicate values. Sort the column by colour.

c. Identify any potential duplicates.

Explore data of potential duplicates

If potential duplicates have been identified, the data contained in each record must be examined to decide if these records are true duplicates. To do this, take the following steps:

1. View the data for the two records that are potential duplicates. This can be done in one of two ways:

   a. Using the CSPro Data Viewer tool: Double click on the .csdb file and it will open in the Data Viewer tool. Records can be opened one at a time to view the contents.

   b. Export the data to .csv and open with Excel (see Chapter 16 for directions on how to export data). The advantage of this approach is that you can see data for the same question from multiple facilities at the same time, which facilitates direct comparison.

2. Compare the responses to the key variables: administrative area (i.e. region, district), facility code/name, GPS coordinates, facility type, managing authority and interviewer’s code.

   a. If the responses to these key variables are all the same and the data for the entire record is largely the same, these are likely true duplicates and one of the records can be dropped.

   b. If the responses to these key variables are not all the same, investigate other reasons for the appearance of the duplicate facility code/name. For example, it is possible that one data collection team selected the wrong facility code/name so these are not duplicates but instead one record has an incorrect facility code/name.
3. Based on the examination of the data, determine if a record is a true duplicate that should be deleted or if a different edit is required to resolve the issue.

**Resolve potential duplicate records**

The final step is to resolve the potential duplicate record. This will require either deleting a true duplicate record or editing the data set to make a correction.

1. To delete a true duplicate, first select the record that should be deleted. The best practice is to keep the most complete case in the data set. If both cases are complete, the case with latest time stamp should be kept. Record the unique identifying information of the case to be deleted. We will remove the duplicate when we review and edit key variables in the last section of this chapter.

2. To make an edit to the data set, record the unique identifying information of the case to be edited and the required edits. We will make the edits when we review and edit key variables in the last section of this chapter.

**15.5 Compare supervisor validations**

The supervisor validation records should be split from the combined data set so they can be compared with the data collection records. The Compare Data tool is a CSPro tool that allows you to compare two data files and identify the differences. The data files must have the same structure, that is, they must be described by the same CSPro data dictionary. In addition, for comparisons to be made, the original case and the supervisor validation must have the same ID information and be located in different data sets. The process of comparing supervisor validations requires three steps:

1. Run the Supervisor split batch application to separate the original data collector cases from the supervisor validations.

2. Reformat the data sets to have the same ID items.

3. Use the CSPro Compare tool to compare the original data collector cases with the supervisor validations.

**Supervisor split batch**

There are two options to run the supervisor split batch: using the data manager interface and using the supervisor split batch application directly.

**Option 1: Data manager interface**

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.

2. Click the Traffic icon to run the application.

3. Click OK to proceed when the next window pops up asking to specify data files.

4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:
Select Option J: Split Validation/Data Collection. This will run a batch application to create two data sets:

- 2_HFA_COMB_FINALDATA.csdb which includes all the original data collector records; and
- 3_HFA_COMB_SUPERVISORDATA.csdb which contains only the supervisor validations.

When it has finished running, a report of the process will open. You can close this window when it is complete. Browse to HFA_WHO\data and check to see that the two files are present.

5. Click on “Close” to exit the report.
6. Select Option Z to exit the Data Manager menu.

Option 2: Supervisor split batch application

Take the following steps to use the Supervisor_split batch application to split the original data collector cases from the supervisor validations:

1. Browse to HFA_WHO\process\edit and click on the file Supervisor_split.pff. This will run a batch application to create two data sets:
   a. 2_HFA_COMB_FINALDATA.csdb which includes all the original data collector records; and
   b. 3_HFA_COMB_SUPERVISORDATA.csdb which contains only the supervisor validations.

2. When it has finished running, a report of the process will open. You can close this window when it is complete. Browse to HFA_WHO\data and check to see that the two files are present.

Reformat data sets

1. Browse to HFA_WHO\dicts and copy the HFA_COMB.dcf dictionary and paste the HFA_COMB.dcf dictionary. Change the name to HFA_COMB_validation.dcf.

2. Open the HFA_COMB_validation.dcf dictionary from the HFA_WHO\dicts folder. Click on the top level of the dictionary tree on the left. In the right window, change the dictionary name to HFA_COMB_VALIDATION.
3. In the tree on the left, click on the ID items record. In the window on the right, click on the item Supervisor validation/Q101, and cut the item from the record. In the tree on the left, click on the SECT01 items record. In the window on the right click on the item Facility Weight/WGT and paste the Supervisor validation/Q101 item to the record. Repeat this process for the variable Team Leader/ID_TEAML.

4. Go to File ➔ Save or Ctrl+S to save your work.

5. Press the Start button and navigate to the Programs ➔ CSPro7.7 ➔ Reformat data.

6. Make the following selections to populate the tool:
   a. Input dictionary: HFA_WHO\dicts\HFA_COMB.dcf
   b. Input data: HFA_WHO\data\2_HFA_COMB_FINALDATA.csdb
   c. Output dictionary: HFA_WHO\dicts\HFA_COMB_validation.dcf
   d. Output data: HFA_WHO\data\4_HFA_COMB_FINALDATA_EXTRACT.csdb

7. Select Reformat data. A CSPro text viewer window will open informing you of the changes to the data. You can close this window. You should now see the file 4_HFA_COMB_FINALDATA_EXTRACT.csdb in the HFA_WHO\data folder.

8. Return to the Reformat data folder tool and repopulate the tool with the following selections:
   a. Input dictionary: HFA_WHO\dicts\HFA_COMB.dcf
   b. Input data: HFA_WHO\data\3_HFA_COMB_SUPERVISORDATA.csdb
   c. Output dictionary: HFA_WHO\dicts\HFA_COMB_validation.dcf
   d. Output data: HFA_WHO\data\5_HFA_COMB_SUPERVISORDATA_EXTRACT.csdb.

9. Select Reformat data. A CSPro text viewer window will open, informing you of the changes to the data. You can close this window. You should now see the file 5_HFA_COMB_SUPERVISORDATA_EXTRACT.csdb in the HFA_WHO\data folder.

10. You can now close the reformat tool.

Compare tool

1. The data files are now ready to use the compare tool. Navigate to Programs ➔ CSPro7.7 ➔ Compare data.

2. The first screen in the CSPro Compare data application will ask you for the Data Dictionary File. Navigate to the HFA_WHO\dicts folder, select the HFA_COMB_validation.dcf file, and click Open.

3. The panel on the left should now display the data dictionary’s records and items in a selectable dictionary tree. Click on the top box next to the dictionary icon to select all the data. The screen should look like the following image.
**Note:** If you have systematically selected a subset of questions to validate, you can select those variables so that the comparison is limited to those questions. You can then store these selections for future use by going to File ➔ Save and saving the “Comparisons Specifications File”. You can then use the “Compare Specifications File” at a later date to compare the set of variables specified in this file.

4. To run the Compare function, press on the toolbar; press Ctrl+R; or from the File menu, select Run. For the input file, select the 4_HFA_COMB_FINALDATA_EXTRACT.csdb file from the HFA_WHO\data folder. For the reference file, select the 5_HFA_COMB_SUPERVISORDATA_EXTRACT.csdb from the HFA_WHO\data folder. For the comparison method, make sure that the “Compare Input to Reference and Reference to Input” box is selected. For the comparison order, make sure that the “Compare in Indexed Order” box is selected. The screen should appear as below:

5. Click OK to run the Compare tool. An output summarizing the results of the file comparison will be shown.

6. Examine the output. The input file and reference file are listed at the top. Each case in both files appears listed on the left, identified by the facility code. For each case, any difference between the input file and the reference file will be listed, with values for the input file under the column “Input File” and for the reference file under the column “Reference File” (on the far right). If the case exists in one file but not in the other, CSDiff will output “Case missing” in the relevant column.
7. Save the results from the comparison and share them with the survey coordinator, supervisors and team leaders, etc. so that feedback can be provided, data updated and data collection practices changed to improve the consistency of data collection. In addition, the results of the comparison may be reviewed, and decisions may be taken to reconcile discrepant results in the final data set. Any edits to the final combined data set will need to be made using the batch edit application described in the next section.

Note: The results of the comparison will only show differences between the two cases with the same facility ID. Not all differences are indicative of data quality problems. For example, the compare tool will note minor differences in the spelling of facility location, or other text only fields. In addition, differences in issues such as the availability of medicines may be true differences as medicine availability is subject to change. The comparison results must be interpreted with caution and with a view toward identifying differences that may be reasonable as well as differences that may be indicative of a problem with data quality.

15.6 Review key variables

The next step in the data management process is to undertake a review of key variables in the final combined data set. This section describes the key variables that should be reviewed. Any errors or inconsistencies should be corrected in the final combined data set that will be used for analysis. Detailed instructions on how to undertake this review are provided in the next section.

Download and export data

See the instructions in the beginning of Chapter 15 for downloading the data and in Chapter 16 for exporting the data to .csv and opening in Excel (or a software of your choice). Export the file 2_HFA_COMB_FINALDATA.csdb (without supervisor validations) as this file will be used to create the final analytical data set.

Variables to review

The following are the key variables that should be reviewed. For each set of variables, additional information is provided about why these are key variables for the HHFA.
The Consent and the Final result code variables will determine if a facility is included in the analysis.

- **Consent**: Check to see if there are any facilities where consent was not obtained. Verify the status of non-consenting facilities. (Check with the team leader to confirm that the facility declined to participate in the survey.) If consent was not obtained, ensure that there are no further data in the record beyond the consent question.

- **Final result code**: All facilities should have a final result code. Check for missing values. If the result code is recorded as "other", review the reason listed and recode where possible. Investigate facilities that were not accessible and confirm these facilities cannot be surveyed and will be excluded from the analysis.

Depending on the sampling strategy used, facility type, managing authority, urban/rural and administrative areas may all be used as a stratifiers for the HHFA analysis.

- **Facility type**: All facilities should have a facility type. Check for missing values. If the facility type is recorded as "other", review the “other – specify” response and recode where possible.

- **Managing authority**: All facilities should have a managing authority. Check for missing values. If the managing authority is recorded as "other", review the “other – specify” response and recode where possible.

- **Urban/rural**: All facilities should have an urban/rural designation. Check for missing values. If the urban/rural designation is recorded as "other", review the “other – specify” response and recode where possible.

- **Administrative areas**: All facilities should have administrative areas assigned. Check for missing values. Check that administrative areas are valid responses and that alignment of administrative areas (e.g. districts within regions) is correct.

GPS coordinates are important for identification of health facilities and for mapping. However, GPS coordinates commonly have errors as it can be easy to introduce an error in the GPS coordinates.

- **GPS coordinates**: All facilities should have GPS coordinates (latitude and longitude). Check for missing values. Check that GPS coordinates are within range for the country.

Facility names should be cross-checked with the facility names in the sample file/MFL to ensure facility codes and facility names are correctly aligned. Misalignment of facility codes and names may indicate a problem with data concatenation.

Some categorical questions in the HHFA allow for an “other” response category. If “other” is selected, the data collector must then record the respondent's answer using a text box. It is important to review these “other” responses to determine if they may in fact correspond to a pre-defined response category for the question and should instead be recoded.

- **“Other” response options**: A batch application has been written to identify instances where “other” has been selected and a report has been printed to show what “other” text was specified. These text responses should be compared with the pre-coded responses for each question to determine if any “other” responses in fact need to be recoded to pre-existing response options categories. Please see the separate report to review these. There are two options to run the “other” response options batch: using the data manager interface and using the “other” response options application directly.

Option 1: Data manager interface

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.
2. Click the Traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:

Select Option L: Review other responses. This will run a batch application to read through the 2_HFA_COMB_FINALDATA.csdb file and identify all instances where “other” was the reported response to a categorical question.

5. When it has finished running, a report of the process will open. You can close this window when it is complete. Browse to HFA_WHO\process\report_other edit and check that the file OtherSpecify.csv has been created.

6. Open the file OtherSpecify.csv using Excel. This file contains three columns: facility code, question and specified value (see the example image below). Review this report to determine the responses that may need to be recoded to pre-existing response categories.
7. Click on “Close” to exit the report.
8. Select Option Z to exit the Data Manager menu.

Option 2: “Other” response options batch application

Take the following steps to use the “other” response options batch application to read through the 2_HFA_COMB_FINALDATA.csdb file and identify all instances where “other” was the reported response to a categorical question:

1. Browse to HFA_WHO/process\report_other and click on the file Writing Other Specify.pff. This will run a batch application to read through the 2_HFA_COMB_FINALDATA.csdb file and identify all instances where “other” was the reported response to a categorical question.
2. When it is finished running, a report of the process will open. You can close this window when it is complete. Browse to HFA_WHO\process\report_other edit and check that the file OtherSpecify.csv has been created.
3. Open the file OtherSpecify.csv using Excel. This file contains three columns: facility code, question and specified value (see the example image below). Review this report to determine the responses that may need to be recoded to pre-existing response categories.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Facility Code</td>
<td>Question</td>
</tr>
<tr>
<td>2</td>
<td>1340080204 Q13101_4KT EMR</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>14106030302 Q13403XT laboratory confirmatory regist</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1122050101 Q13101_4KT pointing book</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1122050101 Q18106XT pointing book</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>115060302 Q13304XT HIV counselling and testing</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>115060302 Q13403XT Registre de movement</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>157060101 Q13301_4KT Registre d’Enregistrement</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>157060101 Q13304XT Registre d’Enregistrement</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>122170401 Q13401_4KT Register</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>111090030 Q13409XT file</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>142090102 Q13304XT VCT register</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>142090102 Q13403XT Laboratory HIV testing regist</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>1322020401 Q13902_4KT none</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>1322020401 Q13511XT none</td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>1122050101 Q13101_4KT pointing register</td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>1122050101 Q13301_4KT Finger print Register</td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>1322020401 Q13401_4KT Linkage and treatment register</td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>1322020401 Q13401_4KT Linkage to enrollment</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>1322020401 Q13502_4KT e TB</td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>1322020401 Q13511XT e TB</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>146010404 Q13001_4KT EMR &amp; ANC REG</td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>146010404 Q13010XT EmR &amp; HTN and uterus</td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>146010404 Q13101_4KT MONTHLY REPORT FROM DATA MANAG</td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>146010404 Q13401_4KT patient file</td>
<td></td>
</tr>
</tbody>
</table>

15.7 Calculate sample weights

If a sample (as opposed to a census) survey has been implemented, weights must be calculated so that they can be applied to the data set in the analysis phase. Refer to the HHFA Comprehensive guide for more information on how to calculate sample weights. It is important to calculate the weights at this stage in the HHFA as the weights will be incorporated into the final HHFA data set in the next step, Edit data.
15.8 Edit data and create final data set

Now that the data have been reviewed and all necessary edits have been identified, you are ready to edit the final combined data set (2_HFA_COMB_FINALDATA.csdb). To make edits to the final combined data set, you will need to use the HFA_Edit batch application. Take the following steps to use the HFA_Edit batch application to implement your edits:

1. Browse to the HFA_WHO\process\edit folder and double click on the file HFA_Edit.bch. This will open the HFA_edit batch application.

2. The HFA_edit batch application contains example code for editing each of the key variables reviewed above, including resolving duplicates as discussed in an earlier section. This code serves as an example only. It does not change anything in the data set. You will use this example to write similar logic to implement the changes you have identified that need to be made to your data set. While most of the logic examples should be self-explanatory, additional information about the logic for the weights is provided below:

   a. For this example, we assume that the sample was stratified by facility type and managing authority, giving the following weights:

      - Hospital – public: 1
      - Hospital – private: 1.5
      - Primary – public: 4.5
      - Primary – private: 2.5.

   b. Logic must be written to assign the weight to the corresponding facilities. Under the weights example, you will need to write logic to map the facility types and managing authorities to the weights. An example of the logic required to do this is below:

      ```
      if Q115 in 1,2 and Q116 = 1 then
        WGT = 1
      elseif Q115 in 1,2 and Q116 in 2,3,4,96 then
        WGT = 1.5
      elseif Q115 in 3,4,5,96 and Q116 = 1 then
        WGT = 4.5
      elseif Q115 in 3,4,5,96 and Q116 in 2,3,4,96 then
        WGT = 2.5
      endif;
      ```

   c. When you have finished writing the logic, click on the Compile button to ensure that your statement is valid.

3. Once you have added the logic to implement all your desired edits, compile the logic by clicking on the toolbar, or select File → Compile from the main menu (or press Ctrl+K).

4. The Compiler Output window under the logic will provide a message with the results: either “Compile Successful” or “Compile Failed”. If the compile is successful, you are now ready to run the HFA_edit batch edit application. If the compile fails, review the error messages to help you determine the errors, correct the errors and repeat the logic compilation process until you get a “Compile Successful” message.

5. There are two options to run the HFA_edit batch: using the data manager interface and using the HFA_edit batch application directly.

Option 1: Data manager interface
1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.
2. Click the Traffic icon to run the application.
3. Click OK to proceed when the next window pops up asking to specify data files.
4. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:

```
Select Option K: Run data cleaning tool. This will run a batch application to create the file 6_HFA_COMB_FINALDATA_EDITED.csdb in the HFA_WHO\data folder which should contain the final, clean data set that is ready for data archiving and data analysis.

When it has finished running, a report of the process will open. You can close this window when it is complete. Browse to HFA_WHO\data and check to see that the file is present.
```

5. Click on “Close” to exit the report.
6. Select Option Z to exit the Data Manager menu.

Option 2: HFA edit batch application

1. Browse to the HFA_WHO\process\edit folder and double click on the file HFA_Edit.bch. This will open the HFA_edit batch application.
2. Press 🎨 on the toolbar; press Ctrl+R; or from the File menu, select Run. For the input file, select the 2_HFA_COMB_FINALDATA.csdb file from the HFA_WHO\data folder. For the output file, select 6_HFA_COMB_FINALDATA_EDITED.csdb and save the output file in the HFA_WHO\data folder.
3. The file 6_HFA_COMB_FINALDATA_EDITED.csdb should now contain the final, clean data set that is ready for data archiving and data analysis.
16. Exporting data for analysis

CSPro has a built-in Export Data application that allows you to quickly and easily export data in a variety of formats. The exported data can then be imported into different software programs according to your needs.

In order to be able to use the HHFA data analysis platform, the data can be provided in several file formats (.csv, .xls, .dta). The analysis platform requires the data set to contain the question number as the variable name in the first row of the data set and all pre-coded responses must contain numeric values, not labels. The preferred data set format for the HHFA analysis platform is a .dta file which will allow you to see the variable names in the analysis platform. However, the analysis platform will also accept a .csv file if you are unable to create a .dta file. In addition, the analysis platform functions best when questions that were deactivated prior to data collection are excluded from the final data set.

16.1 Export data for the HHFA data analysis platform

In order to export data for the HHFA data analysis platform (with deactivated questions excluded from the final data set), take the following steps:

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.
2. Open the forms view and click on logic. Navigate to DATA_MANAGER_UTILITIES ➔ EXPORT_DATA and view the logic. This logic relates to exporting the data in STATA, SAS and SPSS formats.
3. Make the following changes:
   a. Any country-specific questions that you would like included in the data export should be included in line 54 and the logic for country-specific questions must be activated.
   b. In addition, the default behaviour is for the export application to utilize the 6_HFA_COMB_FINALDATA_EDITED.csdb datafile. You can change this to any other data file by changing the name of the data file in line 3. In addition, you must change this file name in the DATA_MANAGER_MENU variable logic (4 occurrences). The file is expected to be located in the data folder.
   c. If you would like to export value labels in a language other than English, activate the code in line 25 and change the two-letter language abbreviation to match your selected language.
4. Save your changes.
5. Click the Traffic icon to run the application.
6. Click OK to proceed when the next window pops up asking to specify data files.
7. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:
8. Select Option X: Export cleaned data (combined data). Select the export format, STATA/SAS/SPSS.

9. Several files will be created, and the following message will be displayed:

10. Select Option Z to exit the Data Manager menu.
11. Navigate into HFA_Folder/data/Export_Data/STATA_SAS_SPSS folder. The folder will contain the following files:
12. Use the appropriate Stata software to open the Export.do file. Run the corresponding syntax in Stata software and save the generated file e.g HHFA_CountryName_Year_Final.dta. This is the file that will be uploaded into the analysis platform.

   a. Open STATA, click on File → Do and navigate to the EXPORTED_DATA.do file created in the data export process. This will read in the .dat and .dct files to load the data and all the value set labels.
   
   b. Once this is complete, click on File → Save to save the dataset as a .dta file (STATA file format).

16.2 Export HHFA data to open with Excel

In addition to STATA file format, other file formats are also generated in the Export_Data folder. This includes a .txt file that can be opened with Excel which can be found in the Export_Data/txt folder. In order to export data for in .txt format to open with Excel, take the following steps:

1. Open the HFA_WHO folder and double click to open the HHFA_Menu.ent.

2. Open the forms view and click on logic. Navigate to DATA_MANAGER_UTILITIES → EXPORT_DATA and view the logic. This logic relates to exporting the data in STATA, SAS and SPSS formats.

3. Navigate to DATA_MANAGER_UTILITIES → EXPORT_DATA_CSV and view the logic. This logic relates to exporting the data in .txt format.

4. Make the following changes:

   a. Any country-specific questions that you would like included in the data export should be included in line 54 and the logic for country-specific questions must be activated.
   
   b. In addition, the default behaviour is for the export application to utilize the 6_HFA_COMB_FINALDATA_EDITED.csdb datafile. You can change this to any other data file by changing the name of the data file in line 3. In addition, you must change this file name in the DATA_MANAGER_MENU variable logic (4 occurrences). The file is expected to be located in the data folder.

5. Save your changes.

6. Click the Traffic icon to run the application.

7. Click OK to proceed when the next window pops up asking to specify data files.

8. You will be taken directly to the login screen where you will enter your data manager code to access the data manager functionalities. You should now see the Data Manager menu:

10. A .txt file will be created, and the following message will be displayed:

11. Select Option Z to exit the Data Manager menu.

12. Navigate into HFA_Folder/data/Export_Data/txt folder. The folder will contain the following files:

To open a .txt file in Excel, take the following steps:
13. Start Excel and using the menu bar, go to File ➔ Open and browse to the .txt file, select it, and click OK. Make sure “All Files” is selected so that you can see the .txt file.

14. The Text Import Wizard will open. The screens should look like the following as you work through the wizard:
15. Your file should now be open in Excel and you can view your data.

16.3 Export HHFA data to other file formats

In addition to STATA file format, other file formats are also generated in the Export_Data/STATA_SAS_SPSS folder. This includes SPSS and SAS.

1. Use the appropriate statistical software to open the corresponding file format, e.g. for SPSS open the Export.sps file, for SAS open Export.sas file.
2. Run the generated syntax in the statistical software of your choice.
3. Save the generated file for further statistical analyses.

16.4 Alternative approach to exporting data

CSPro has an Export Data application that can be used to export your data to multiple file formats. The CSPro export function supports export to the following file formats:

- Tab delimited (.txt)
- Comma delimited (.csv)
- Semicolon delimited (.csv)
- CSPro (.dat, .dcf)
- SPSS (.dat, .sps)
- SAS (.dat, .sas)
- STATA (.dat, .dct, .do)
- R (.dat, .R)
Using this Export Data application, you can manually select which questions to include in the data export. This is an alternative method of exporting data from CSPro. If you want to export the data to one of these formats, take the following steps:

1. On your desktop or laptop computer, press Start and navigate to the CSPro Export Data application. This will most likely be located in Programs → CSPro7.7 → Export data.

2. The first screen in the CSPro Data Export application will ask you for the Data Dictionary or Data File you want to export. Navigate to the HFA_WHO\data folder, select the 6_HFA_COMB_FINALDATA_EDITED.csdb file, and click Open.

3. The panel on the left should display the data dictionary’s records and items in a selectable dictionary tree. From this dictionary tree, you can select the data you want to export.

4. This screen will also display various export options, such as the export format, the number of files you want the application to create, and whether you want to include XML Metadata. We will keep the default options for everything except the following:

   - Export Format: select the export format you would like to use.
   - Export Items or Subitems: select Both Items and Subitems.

5. Select Run from the File menu.

6. CSPro will then ask you to specify the name of the exported file. Specify a file name of your choice and click Save. You have now successfully exported data from CSPro.
Annex: CSWeb synchronization: server and domain name configuration example

This example provides instructions for setting up a server and configuring a domain name using a specific cloud server platform, Amazon Lightsail. **Note:** The use of Amazon Lightsail for this example does not serve to promote a specific product. It is simply an illustrative example. This section explains how to set up an Amazon Lightsail server and configure the DNS zone on Amazon Lightsail. Technical instructions were informed by the Amazon Lightsail documentation center.¹

**Prerequisites**

In order to complete the server and domain name configuration you will need the following:

- Amazon Lightsail account;
- purchased/configured a domain of your choice;
- basic understanding of Linux terminal commands; and
- local PC running Ubuntu 18.04/20.04

Alternatively, if you are running a Windows PC, you can configure Ubuntu to run on Windows 10 (refer to [https://docs.microsoft.com/en-us/windows/wsl/install-win10](https://docs.microsoft.com/en-us/windows/wsl/install-win10)).

**Set up Amazon LightSail Instance**

**Step 1.1: Creating a Linux instance for Ubuntu 20.04 LTS**

- Log in to your Amazon Lightsail Instance.
- On the instances tab click create instance. You will be redirected to an instance creation window.

**Instance Location:** Choose your preferred instance location.

**Instance Image:** Select Linux/Unix.

**Instance Blueprint:** Choose OS only and select Ubuntu 20.04 LTS as the installation instance.

¹ Amazon Lightsail documentation center: [https://lightsail.aws.amazon.com/ls/docs/en_us/how-to](https://lightsail.aws.amazon.com/ls/docs/en_us/how-to)
You may choose to enable automated snapshots but that comes with additional costs.

An example of instance setup is shown below.

- **Instance Plan**: The minimum recommended instance is the one with the following bundles: 1 GB Memory, 1 CPU, 40 GB SSD Storage, 1 TB Data transfer.

- **Identify your instance**: Provide a unique name for your instance.

Finally, click create instance.

**Configure DNS zone on Lightsail**

By creating a DNS zone, you can use your registered domain with Lightsail and easily map it and its subdomains to your resources, such as an instance or load balancer.

**Step 2.1: Create static IP address**

- On the networking tab select create static IP address.
Select the instance you have created above.

Enter a unique name for your instance static IP address.

Click Create.

A static public IP address will be created that you can use to access the server remotely.

**Step 2.2: Create DNS Zone**

To configure DNS setup, you must have a domain name registered, using a domain services provider, e.g. namecheap.com. However, this comes with an added cost to maintain the domain name.

Below are the steps to configure DNS records on AWS.

- On the networking tab select Create DNS Zones.
- Enter the domain name you have registered, without www or http prefixes, e.g. example.com.
- After you choose Create DNS zone, you get a set of AWS name servers.
- You will need to configure your domain provider to use Lightsail name servers.

**Note:** In the following example, the subdomains and IP addresses are specific to the WHO headquarters testing platform (cspro-hhfa.com). When you create your DNS zones, these fields should be populated with your specific subdomains and associated IP addresses.
Select A record.
In the subdomain enter @ symbol.
In the “Resolves to” text box, click and select the static IP address created above.
Repeat the same process of adding another DNS record but in the subdomain enter www.
After the DNS zone has been created it will take about 24 hours to propagate the changes. Meanwhile proceed on with the subsequent steps.

Step 2.3: Configuring SSH access to Amazon Lightsail

Choose Account on the top navigation menu, then choose Account.

The Account management page appears, with various tab options to manage your account settings.
Choose the **SSH keys** tab.

Scroll down, and choose Download next to the default key of the AWS region of the instance that you want to connect to.

![Download SSH Key](image)

- Download the private key pem file to your local machine. It is recommended to store the key in a secure folder. e.g. `~/.ssh/`
- Move the private key to secure folder.
- Open a terminal window on your local machine.
- Navigate to the downloaded folder. Type the following:
  
  ```
  $ cd /path/to/downloaded_folder
  $ sudo mv private-key.pem ~/.ssh/
  ```

  **Note:** Sudo for Linux commands, means you are running the commands with root privileges, hence you will be prompted to enter your password.

- Change the permissions of your private key and connect to your instance using SSH:
  ```
  sudo chmod 600 ~/.ssh/private-key.pem
  ```

- Enter the following command to connect to your instance in Lightsail using SSH:
  ```
  ssh -i ~/.ssh/private-key.pem ubuntu@public-ip-address
  ```

  `public-ip-address` with the public IP address of your instance that you noted from the Lightsail console earlier in this example.

- You are successfully connected to your instance if you see the welcome message for your instance.
- You can set up the CSWeb server using the steps outlined in Chapter 5.
- Type exit to exit from the Lightsail instance connection.
- After the domain name has propagated, you can access your csweb instance on the browser by visiting the domain name, e.g. example.com/csweb